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About This Guide

This user guide is intended to supplement Find it EZ website resources (FAQ, Knowledge Base, Video Tutorials, and Corporate 
Documents) by providing step-by-step procedures to help you make the most of your Find it EZ product.

If we can improve this reference in any way, please feel free to send us your feedback and suggestions to support@finditez.com  

Visit https://www.finditez.com/support/#overview for Find it EZ website resources.

This guide uses the following document conventions:

Program windows or dialog box titles are shown in bold text like this: Bold Title

Program menus are shown like this:  File -> Open 

Program buttons are shown like this:  Cancel 

Keyboard keys are shown like this:  Enter 

Program labels, radial buttons and drop down list options are shown in mixed case bold mono-type text like this:  Labels 
This is a hyperlink: http://www.finditez.com/

Note: This is a note.

Tip: This is a tip.

Alert: This is an alert.

Example: This is an example.

See Also: 
 • This is a cross-reference

About Find it EZ
Find it EZ Software Corp. is a global leader in developing and delivering productivity improvement tools for software developers. Our 
award winning software developer tools provide instant, comprehensive and pin-point accurate where-used results all in one place. 
These productivity tools offer a new solution for crystal reports designers, database developers and software vendors to better man-
age release changes through every phase, from more accurate estimating, to optimal design selection, rapid development, 
improved code quality for smoother end-user roll out and expedited critical production support.

Tools developed by Find it EZ Software Corp. support all major programming languages, reports and databases across an entire n-
tier enterprise application with a single integrated package.

Productivity software tools with vendor certified support to search and document all major business intelligence reporting tools, under-
lying databases, programs, application logs, data files, office documents plus more for complete change impact analysis. Database 
developers can take advantage of a full software stack impact analysis tool that identifies all interrelated components whenever 
changes are planned or made in an underlying database.

By using our change impact analysis tools, software developers benefit from:

mailto:support@finditez.com?subject=Suggested change or error in user guide
https://www.finditez.com/support/#overview
http://www.finditez.com/
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 • Saving time and money by quickly searching all reports, application source code, and/or databases with just one integrated 
software tool.

 • More accurate and efficient source code change management.

 • Ability to determine the exact scope and impact of planned changes.

 • Easily estimate the time required to complete a change and ensure better quality code releases.

 • Effective Risk Management, Resource Management and Cost Management.
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Installation, Activation, and Updates
This section describes the steps required to download, register, install, configure, update, and manage your Find it EZ license and to 
understand the benefits and limitations of product trials.

Download Find it EZ
 1. Visit https://www.finditez.com/members/#downloads.
 2. If you have not done so already, register for a free Find it EZ account.

 3. Once logged in, click to view the Software Downloads tab.

 4. Refer to the following documents to select the product that best meets your needs:

 a. https://www.finditez.com/resellers/salesaids/FinditEZ_compare_editions.pdf

 b. https://www.finditez.com/resellers/salesaids/Product%20Selection.pdf
 5. Click on the (latest) Version hyperlink next to the Product you are interested in to begin downloading the corresponding 

product setup file.

 6. Once the setup file has been successfully downloaded, double click or open the file to run the installation process on the tar-
get workstation(s).

See Also:
 • "My Account" on page 283

Download Connectors
Source items that require a connector will appear with a small warning icon preceding the name. See example below:

Note: Some connectors are required (e.g. '.net') but others are optional (depending on whether or not you want to search a par-
ticular document type that then needs a corresponding vendor supplied connector). After product install on first run configuration 
wizard for setting up your environment, if you select one or more source items that require connectors, the wizard will prompt you 
to auto-download and install them. If you do not do so, or later add a source item, you will note that it has a yellow alert triangle icon 
next to it in the left (Source) panel.  If you attempt to include such a source item in a project, you will be prompted to auto download 
and install the required connector. 

https://www.finditez.com/members/#downloads
https://www.finditez.com/resellers/salesaids/FinditEZ_compare_editions.pdf
https://www.finditez.com/resellers/salesaids/Product Selection.pdf
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Click on the source item / warning to download the associated connector.

If you try to initiate a search that includes a selected source lacking a required connector, an error message will be generated. See 
example below:

From the Program:

Note: Downloading and installing a connector will require local administrative rights on your system.

 1. From the Find it EZ menu, select  Tools -> Connector Manager  .

 

A Connector Manager dialog will appear.
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 2. Optionally select one of the Show drop down options to filter the list. For example, selecting the option Missing will dis-
play a list of required connectors that have not yet been installed based on the source items you have configured using the 
Configuration Wizard.    

Note: Items with a check-mark icon next to them indicate you have the minimum or newer connector version detec-
ted as already installed on your system.

 3. Click on any one of the items with an install icon  then click the  Install / Update  button. The connector will begin down-
loading.

 a. Once downloaded, a Find it EZInstallShield Wizard will appear.

 b. Click on the  Next  button.

 c. Read and follow the instructions provided.

 d. When complete, click on the  Finish  button.

 4. OR, click on any one of the items with a download compatible version icon , then click the  Help me decide  button or 
hyperlink for that item. This will launch your browser and open a page on the Find it EZ Software Corp. website to help you 
select the correct version of the connector based on other related software installed on your workstation. For example, click-
ing on the "IBM Data Server Driver Package" for the required DB2 connector will take you to this page, see below:    
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 5. Follow the instructions on the website page to select, then download and chose to either save or run the corresponding 
setup package depending on your browser and network security permissions. 

Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.

Tip: The Open Downloads Folder button will contain all downloaded Find it EZ setup packages within this default path: 
C:\ProgramData\Bits n Bytes Software Inc\Installers . To keep all related downloads organized for re-use, it is recom-
mended that you save these "version compatible" connector setup packages to this specific folder location as well.

On the Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Software Downloads tab. A list of product releases and optional connectors will appear.

 3. Locate the product release for which you want to download a connector.

 4. In the Optional Connectors section of the table, click on the corresponding hyperlink in the desired connector column. For 
all hyperlinks that do not contain the text Help me decide, a Connector Details dialog box will appear. See 
example below:
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 5. To download the selected version from the Find it EZ server, click on the  Download Now  button. OR,

 6. Where applicable, to download the selected version directly from Microsoft (i.e. Access) or directly from SAP (i.e. Crystal 
Reports), click on the directly from Microsoft or directly from SAP link, respectively. See example above.

 7. The connector will begin downloading.

 a. Once downloaded, a Find it EZ InstallShield Wizard will appear.

 b. Click on the  Next  button.

 c. Read and follow the instructions provided.

 d. When complete, click on the  Finish  button.

 8. To close the Connector Details dialog box, click on the Close or  X  button.

 9. OR, in the Optional Connectors section of the table, if you chose any connector with the hyperlink text Help me 
decide, a website page will display with instructions to guide you through selecting a compatible version depending on 
related software that may be installed on your workstation or network environment. See example below:    

 10. Follow the instructions on the web page to filter the recommended compatible version of the connector to be installed.
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 11. Once the recommended connector download link is displayed, click to download and chose to either save or run the cor-
responding setup package depending on your browser and network security permissions. 

Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.

See Also: 
 • "Check for Updates" on page 26

 • "Download Release Version" on page 294

 • "Download .NET Framework" on page 300

View or Edit Proxy Settings
If your corporate network uses a proxy server firewall to manage all incoming and outgoing (Internet) traffic, you will need to con-
figure settings within a running Find it EZ program to enable automated “check for updates on start-up” as well as automated down-
load and install of optional connectors or upgrades.  

Note: The proxy server itself will also need to be configured to permit inbound / outbound traffic over secure port 443 to the fol-
lowing two Find it EZ Software Corp. website addresses:          

 • activation.finditez.net ( for update checks and automated product activation )

 • cdn.finditez.com ( for integrated product and connector setup file downloads )

Please contact your Network Administrator to ensure these website address' are white-listed in your proxy server.

There are three ways you can enter proxy settings.  In all cases, the settings are saved between sessions.  Note that saved pass-
words, if required for your proxy, are automatically encrypted for security.

From the Program Activation Dialog Window:

 1. Before clicking on the  Activate button, check your Proxy Settings.

 2. Click on the  Proxy Settings  button.  The Proxy Settings dialog box will appear.
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 3. Choose System Default and/or enter Custom Proxy Settings, as required for your network.

Note: If you don't know your proxy settings, please contact your Network Administrator.

 4. To save your changes and close the Proxy Settings dialog box, click on the  OK  button.

From the Program Main Menu:

 1. Select  Tools -> Proxy Settings .

The Proxy Settings dialog box will appear, as below:
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 2. Choose System Default and/or enter Custom Proxy Settings, as required for your network.

Note: If you don't know your proxy settings, please contact your Network Administrator.

 3. To save your changes and close the Proxy Settings dialog box, click on the  OK  button. 

From any Download Dialog Window:

 1. Before clicking on the  Download & Install  button, check your Proxy Settings.

 2. Click on the  Proxy Settings  button.  The Proxy Settings dialog box will appear.
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 3. Choose System Default and/or enter Custom Proxy Settings, as required for your network.

Note: If you don't know your proxy settings, please contact your Network Administrator.

 4. To save your changes and close the Proxy Settings dialog box, click on the  OK  button.

Installation and Configuration Wizard

Install Dev Surge 365 Enterprise
Once the setup file has been successfully downloaded:

 1. Locate and double-click on the *.exe file in the lower, left of your desktop or in your Downloads folder. The Preparing to 
Install... dialog will appear, as below:
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Once the preparation is complete, the following dialog will appear:

 2. Click on the  Next  button to continue. The License Agreement dialog will appear, as below:
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 3. Read and accept the license agreement as follows:

 a. Use the vertical scroll bar to read the license agreement carefully and thoroughly.

 b. To print the license agreement, click on the  Print  button. A Print dialog will appear. Configure print settings as 
desired and click on the  Print  button.

 c. To accept the license agreement, click to choose the I accept the terms in the license agreement option.

 4. Click on the  Next  button to continue. The Destination Folder dialog will appear, as below:
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 a. To change the destination folder, click on the  Change...  button. The following dialog will appear:
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 b. Make changes, as desired, and click on the  OK  button to close the dialog.

 5. Click on the  Next  button to continue. The Custom Setup dialog will appear, as below:

 a. To change how a feature is installed or to exclude a feature, click on the icon preceding the feature name and select 
the desired option from the context menu. For more information, click on the  Help  button. See below:
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 b. To close the Custom Setup Tips dialog, click on the  OK  button.

 c. To view available disk space, click on the  Space  button. The Disk Space Requirements dialog will appear, as 
below:

 d. To close the Disk Space Requirements dialog, click on the  OK  button.

 6. Click on the  Next  button to continue. The installation will begin and the following dialog will appear:
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 7. Once complete, click on the  Next  button to continue. The following dialog will appear:

To launch the program after installation, click to select Launch the program (selected by default).

 8. To complete the installation, click on the  Finish  button. If selected, the program will launch.
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Custom Configuration
After you download and install Find it EZ and run it for the first time, a Configuration Wizard opens to walk you through the initial 
setup and configuration process. This wizard can also be run at any time from the Tools -> Configuration Wizard menu, as below:

 1. Click on the  Next >>  button to continue through the steps (click on the  <<Previous  button to go back at any point during the 
wizard).

 2. Once complete, click on the  OK  button to save all changes and close the Configuration Wizard.

 3. To exit and discard all changes at any point during the wizard, click on the  Cancel  button. This will apply and use your exist-
ing configuration settings.
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See Also: 
 • "Download Find it EZ" on page 3

 • "Configuration Wizard" on page 60

 • "License Manager" below

License Manager
License manager is a product license authorization check on start-up (e.g. a trial  period  or SaaS annual renewal period check to see 
if it is valid before running the program).  The license manager has to be running (as a Windows Service). 

Note: The license manager runs within (behind) the firewall so is secure and US Health Insurance Portability & Accountability Act 
(HIPAA) compliant.

During install, a warning that it is going to be listening on a TCP/IP port may be issued by Windows during setup. 

If the service is not running or does not start automatically (by default), or the license manager can not be contacted due to firewall 
restrictions on your network, you will receive an "Unable to connect to the license manager..." dialog preventing the Find it EZ pro-
gram from running. 

If you receive this alert, try the following solutions to resolve this issue:

 1. Click on the  Yes  button on the message to try restarting the service.

 2. Use the Windows Task Manager to attempt to restart the Find it EZ license manager services.

 3. Download and/or re-install the software.

 4. If none of the above work, contact your local technical support or contact Find it EZ support and provide log files using the 
Help -> Send Logs to Support menu.

See Also: 
 • "Serial Numbers" on page 306

 • "Installation and Configuration Wizard" on page 11

Activate License
To activate your license:
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 1. Once the product is downloaded and installed, launch the program. The Activate dialog box will appear, as below:

 2. Enter your account Email Address, First/Last Name, and product Serial Number.

Note: If access to the Internet is protected by a proxy firewall within your network, click on the  Proxy Settings button and 
enter the required credentials before clicking the Activate button. For more information, see "View or Edit Proxy Settings" 
on page 8

Note: To find your serial number, click on the  Lookup Serial Number  button. The member website will open in a 
browser window. Log in and the Serial Numbers tab will open. Locate and copy the product serial number.

 3. Click on the  Activate  button. If successful (see message below), the program will be activated for use.

To close the message, click on the  OK  button.

Note: If you receive an error message (e.g. "Entered information is incorrect. Please check the serial number and try 
again"), try again. Ensure there are no extra characters or spaces in the serial number. If you feel you are receiving this 
message in error and continue to experience difficulty attempting to activate your product, please contact sup-
port@finditez.com .

See Also:
 • "Enter New Serial Number" on page 308

 • "View or Transfer Current License" on page 306

 • "Download Find it EZ" on page 3

 • "Download Release Version" on page 294

 • "Get a New Trial License" on page 309

 • "View or Edit Proxy Settings" on page 8

mailto:support@finditez.com?subject=Activation Error
mailto:support@finditez.com?subject=Activation Error
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Activate License Manually
 If you have a corporate security policy that does not allow the workstation on which you are installing Find it EZ to be connected dir-
ectly to the Internet, use manual activation.

This is quite common in large corporations where outbound internet connections are locked down (on certain ports) or not available 
to go to a given website domain, etc. Our automated activation system is a web service on domain activation.finditez.net, on SSL port 
443.   A corporate security policy may prevent an application from attempting to "call out," or may not allow a connection to this specific 
secure domain address.   However, they could often still use a web browser to go to our website on www.finditez.com as the most 
corporate internet use security policies typically allow normal internet access to trusted websites.

In cases where no Internet access is allowed even from a web browser, the end user would have to find a workstation (home com-
puter other office computer that is permitted web browsing) from where they can perform the manual activation by sending the files 
back and forth between a computer with Internet access and the computer upon which the Find it EZ application is installed.

Note: Pending receipt of payment, manually activated licenses will automatically expire within 30 days. Once expired, manual 
activation will be required upon receipt of payment.

Note: Upon receipt of payment, manually activated licenses will automatically expire at the end of each software subscription 
period. Once expired, manual activation will be required upon each renewal.

From the Program:

 1. Once the product is downloaded and installed, launch the program. The Activate dialog box will appear.

Note: You can also access the Activate dialog box from the menu; select  Tools -> License Management -> Enter New 
Serial Number .

 2. Enter your account Email Address, First/Last Name, and product Serial Number.

Note: To find your serial number, click on the  Lookup Serial Number  button. The member website will open in a 
browser window. Log in and the Serial Numbers tab will open. Locate and copy the product serial number.

 3. Click on the  Manual Activation  button. The Manual Activation dialog box will appear, as below:

http://www.finditez.com/
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 4. Follow the instructions in Step 1); to create an activation request file. Save it to a folder or location such as your desktop that 
you will be able to access for uploading this temporary file to our website.

 5. In Step 2), click on the  Open Website  button to launch your default browser with our website log in page.

 a. Log in to the Find it EZ member website.

 b. Click on the Serial Numbers tab.

 c. Click on the  Manual Activation  button. The Manual Activation dialog box will appear, as below:

 d. Click on the  Choose File  button to load the FinditEZ_request.dat file you saved it in step 4 above.
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 e. Click on the  Next  button. A response file will be generated. See example below:
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 f. Click on the  Download  button to download and save the finditez_response.dat file.

 g. Return to the Find it EZ program.
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 6. Click on the  Load Response File  button to locate and select ( click to highlight ) the saved response file.

 7. Click on the  Open button. The program will be activated for use.

Product Trials and Limits
Product trails are subject to the following limitations:

 • Time limited

 • Features (# of documents processed and contained in exported reports or conversion wizards) capped

 • Ability to create projects is restricted

 • Number of trial licenses issued per customer capped (by unique company email domain)

All above get auto-reset whenever we release a new minor or major build.   Release numbering is :  major.minor.build. Customers can 
request a new trial whenever we announce / post a new major or minor release after their past trial with an earlier version has 
expired.

While in trial mode, creating projects is restricted:

 • Code Search Pro (Desktop & Server):   you can only create one additional project; just the single "Default" project plus one 
custom user-defined project is allowed.

 • Dev Surge 365:  you can create only one additional (i.e. a maximum of 2) projects.   This is required to permit easier eval-
uation of the "Compare" wizard (i.e. compare the default project to a "new" second project).

 • The Default project can not be deleted. However, the one additional project permitted in a Dev Surge 365 trial could be 
deleted if desired to test this feature.
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 • Users also have full access to document filtering and managing their index so that they can bring in and check functionality 
against various subsets of documents.

Number of licenses per customer:

 • Equal to the number of registered login accounts linked to the customer account (+ 1 when the trial key is requested).

 • A customer (user) can request a trial for each product edition. They are separate, unique keys and trials.

 • We can, at our discretion, grant extensions or additional trial licenses upon request.

 • Feature limits are indicated in the table below.

Number of documents processed feature limits in trial mode:

  Report Wizards Output Change Report Con-
nections

Change BOE Schedules 
Authentication

Code Search Pro Desktop 50 50   

Code Search Pro Server 100 100   

Dev Surge 365 Enterprise 100 100 100

Note: Both in trial and fully unlocked mode, all products allow indexing, searching and comparing (Dev Surge 365 feature only), 
an unlimited number of database objects, reports, programming source code, data and log files or office documents.

The product trial time limits are:

 • Code Search Pro Desktop:  15 days

 • Code Search Pro Server:  30 days

 • Dev Surge 365 Enterprise:  30 days

Check for Updates
From the Program:

On start-up, an updates available check is performed provided:

 A. You are connected to the Internet, and your proxy or firewall is not preventing traffic to our web service on https://activ-
ation.finditez.net.

 B. Your account profile is not set to skip the updates available check.  Note, this setting may be used by and administrator to pre-
vent all end-users from receiving this message and attempting to upgrade independently rather then by a more controlled 
corporate roll-out.

Note:  If your system is connected to the Internet on start-up of Find it EZ, by default you will automatically receive this 
Update Available notice.  This on-start-up check can be disabled for all Find it EZ users in your company by logging into 
your online company profile and disabling this default setting at any time. This will affect all users linked to the company 
profile. See below:
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Alternatively, you may disable on start-up checks for your individual workstation by changing your custom profile using 
the  Tools -> Customize -> User Options  menu.

 1. From the Find it EZ menu, select  Help -> Check for Updates .

 2. If no updates are available, you will receive a message that reads "No updates available at this time." To close this message, 
click on the  OK  button.

 3. If updates are available, an Update Available dialog will appear as in the example below:

 4. Use the vertical scroll bar to view all release notes.
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 5. To download and install the update, click on the  Download & Install  button. A Download Update dialog will appear.

 a. To enter proxy settings, click on the  Proxy Settings  button.

 b. To download and install the update, click on the  Download & Install  button. The download will begin.

 i. Once completed, the InstallShield Wizard will appear to walk you through the installation process.

 ii. Follow the screen instructions and click on the  Next  button to proceed through the steps.

On the Website:

 1. Log in to your Find it EZ Member Account. Click on the Software Downloads tab.

 2. Launch Find it EZ; from the main menu, select  Help -> About .
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 3. Compare the latest posted release number under the Version column (on the website) corresponding to your product edi-
tion (on the About dialog).  If the version posted on the website is newer, an update is available.

Note:  Provided your software assurance plan is active, you may download and install the latest upgrade for free.

Via Email from Find it EZ Software Corp.:

All users on an active software assurance plan will receive email notification of new (optional / recommended / required) upgrades, 
releases, updates, patches, and offers.

Note:  You may disable automatic notifications by logging into your profile and changing your email notice preferences (as above), 
or by clicking on the “unsubscribe” hyperlink on any update notice received.

Note: If your support plan has lapsed or you have not yet decided, you may request a free trial key to see what's new.

Index Reset on Upgrades

After upgrading to a newer version of the application where there is an a index structure change or model change, you will see the fol-
lowing message:

In these circumstances,  the index needed to be cleared in order to make the new information available.

To clear this message, click on the  OK  button.
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See Also:
 • "Download Release Version" on page 294

 • "Download .NET Framework" on page 300

 • "Download Connectors" on page 301

 • "View or Edit Proxy Settings" on page 8
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Product Overview
This section provides an introduction to Find it EZ user interface layout, navigation methods, Tools menu customization options, 
 File and Document menu options.

User Interface Layout
Refer to the image and table below for a description of the key components of the Find it EZ user interface:

# Name Description

Menu Click on a menu item to view and navigate projects and settings, initiate a task, export or print results, access 
user options, reports, help, and more.

Search Quickly initiate a search.

Source This panel allows you to select and configure settings for the source files (File Locations, Databases, BI 
Reports, Programs, and Documents) within which you want to search. Show or hide the panel by using the 

 and  buttons. Expand or collapse a source category by using the  or  buttons (note that a cat-

egory cannot be collapsed if an item has been selected). In the desired category, click to check the desired 
source items. To select all items in a category, click to check the uppermost check-box located in the cat-
egory header.

Results Once a search is complete, results can be viewed or edited via this window. Select a tab to view Results, 
Statistics, and Errors.

Details When a result is selected in the Results window, details will appear in this window.
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See Also:
 • "Wizards Overview" on page 117

 • "Perform a Regular Search" on page 174

 • "Use the Expression Builder" on page 180

 • "Work With Search Results" on page 190

 • "View Search Result Details" on page 205

Navigation
Navigation in Find it EZ is accomplished in two main ways:

 1. By using the Wizards (for new users).

Note: Many of the items included in the Wizards can also be accessed directly via the main menu. Refer to the table 
below.

 2. By performing a Regular Search from the main screen (for intermediate or advanced users).

Navigation
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Wizard Option Menu Navigation Sample 
Documents

Search for a specific database object, code snippet, or a variable to find any references 
throughout all of my source code (including within reports and databases)

See links at end of 
topic.

List XLSX

List HTML

Detail 
XLSX

Detail 
HTML

Compare database schema, reports or files for differences between versions Compare -> Docu-
ments, Reports & Data-
bases

List XLSX

Detail 
HTML

Detail 
XLSX

Extract database objects (tables, stored procedures, views, etc.) used in my reports Document -> Business 
Intelligence -> Data-
base Cross-Reference

XLSX

Generate detailed content documentation for my reports  Document -> Busi-
ness Intelligence -> 
Report Definition 

HTML

TXT

Extract all SQL code used in my reports  Document -> Busi-
ness Intelligence -> 
Show SQL Queries 

HTML

TXT

Create a database column cross-reference for my reports  Document -> Busi-
ness Intelligence -> 
Column Cross-
Reference 

XLSX

Create a list of all my reports, including printer and update information  Document -> Busi-
ness Intelligence -> 
Report Listing 

XLSX

Create a list of my all my schedules inside a Business Intelligence server  Document -> BI plat-
form sub-menu -> 
Report Schedules 

SAP XLSX

SSRS XLSX

List the security access settings for my documents inside a Business Intelligence server  Document -> SAP 
BOE / Crystal Server -> 
Security Listing 

XLSX

List all users and their security groups inside a Business Intelligence server  Document -> SQL 
Reporting Services -> 
Report Schedules 

XLSX

Replace Crystal Report data source connections or qualified table names  Replace -> Crystal 
Reports -> Data source 
connections or qual-
ified table names 

https://www.finditez.com/solutions/report_examples/Search_Results_List.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_List.html
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.html
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.html
https://www.finditez.com/solutions/report_examples/Compare_List.xlsx
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.html
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.html
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.xlsx
https://www.finditez.com/solutions/report_examples/SQLCodeExtract.xlsx
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/databasecrossref.xlsx
https://www.finditez.com/solutions/report_examples/reportlisting.xlsx
https://www.finditez.com/solutions/report_examples/sapschedulereport.xlsx
https://www.finditez.com/solutions/report_examples/SSRSschedulereport.xlsx
https://www.finditez.com/solutions/report_examples/sapsecurityreport.xlsx
https://www.finditez.com/solutions/report_examples/sapsecurityuser.xlsx
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Wizard Option Menu Navigation Sample 
Documents

Replace the datasource login information for my Reports in a Business Intelligence 
server

Replace -> Crystal 
Reports -> BOE BI 
Database logon inform-
ation

Set my Crystal Reports to "No Printer" Replace -> Crystal 
Reports -> Set Reports 
to "No Printer"

Backup / download my documents and data dictionaries / catalogs from a Business Intel-
ligence server

 Backup -> SAP BOE / 
Crystal Reports Server 

See Also:
 • "Perform a Regular Search" on page 174

 • "Launch the Wizards" on page 117

 • "Use the Expression Builder" on page 180

Customize Find it EZ Program Settings

The view of the main Find it EZ screen can be customized as follows:

 • To show or hide the Source panel on the left, see "Product Overview" on page 31

 • To expand or collapse Source items, see "Product Overview" on page 31

 • To add or remove Source items, see "Configuration Wizard" on page 60 or "Show or Hide Source Items" on page 54

 • To show or hide Project Settings each time you select a  source item, see "File Locations and Source Settings" on page 74

 • To customize file type processing by extension or select a custom source item "opens with" viewer / editor, see "Viewer / 
Editor Settings" on page 57

 • To customize Results list columns, see "Show or Hide Result List Columns" on page 54

 • To show or hide the Wizards on start-up, see "Show Wizards on Start-up" on page 122
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File Menu Options
This section describes the various options available via the  File  menu. Follow the steps to save or open saved search results, save 
project settings, export or print search results, and to exit Find it EZ.

Save Search Results
 1. Perform a search.

 2. From the Find it EZ menu, select  File -> Save .

 3. A Save Search Results dialog box will appear, as below:

 4. In the Name text box, enter a descriptive name for the results.

 5. Click on the  Save  button.

Note: Once you save search results, every subsequent change to the search results elements are automatically re-
saved. Also, If any search results have annotations or have been marked complete and you attempt the exit/close the pro-
gram without first saving your results, you will be prompted to save your search results, continue without saving, or keep 
the program open.
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Open Saved Search Results
 1. From the Find it EZ menu, select  File -> Open . 

 2. An Open Search Results dialog box will appear.

 3. From the Search drop-down list, select the name of the saved search results.

Note: Once saved results are opened, all further changes to them are automatically saved (this is reset when you exit the 
program OR if you run another search to replace the "SAVED / re-Opened" search results that you had been working 
with. Also, when you open a previously saved search result, this also auto-switches to the saved Project settings. The 
saved results listed include the following identifiers: Date, Time, [File] Name, Project Name, Search Type, and Search 
text.

 4. Click on the  Open  button. The selected search results will appear in the Results window.

See Also: 
 • "Wizards Overview" on page 117

 • "Perform a Regular Search" on page 174

 • "Add or Edit Annotations" on page 213

 • "Mark Item(s) Complete or Incomplete" on page 209

Save Project Settings
If you have only one project (the Default project) and can have more than one project, you will be prompted to save your current set-
tings as a New Project upon closing the program. Click on the  OK  button to save your settings.

See Also:
 • "Product Trials and Limits" on page 25
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Export Search Results
Follow these instructions to export data following a search using the File -> Export menu:

 •  Search Results List

 • Search Results Detail

 • Search Results Line Matches

 • MS Project Tasks

 • Error List

When you generate any of these reports with the exception of the Error List, a Select the items to include dialog appears so that 
you can filter which search items are to be included in the file contents generated. For the Error List, all search errors are included. 
Select your content filter preference for any of the other reports and click the Next button, a Save As dialog appears.  Browse to the 
folder location where you would like to save the file, select the output file type, enter a File nameand click on the  Save  button. 
The report is created and a Save Complete alert dialog window appears. To view the saved report, click on the  View Now  button. 

Export Search Results List
An exported search results list will create a spreadsheet containing all or a subset of your search results.  This saved .xslx file can then 
be redistributed, changed, or printed using your default spreadsheet editor (e.g. Excel ).

 1. Open a previously saved search result using the  File -> Open  menu or perform a search.

 2. From the Find it EZ menu, select  File -> Export -> Search Results List . 
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 3. A Select the items to include dialog will appear.

 a. Click to choose one of the options; All results, Currently displayed results, or Checked results only.

 b. Chose a file type from the options available.

 c. Click on the  Next  button. A Save As dialog box will appear.

 i. Navigate to the destination folder.

 ii. Enter the desired File name.

 iii. Click on the  Save  button.
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 d. A Save Complete dialog will appear (see below).

 i. To view the saved file, click on the  View Now  button. The file will open in the selected viewer (see below).

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

 ii. To close the Save Complete dialog, click on the  Close  button.

 4. Exported search results will contain the following data columns:

 • Source Location
 • File Type
 • Host Name

 • File Path or Database
 • Document Name

 • Number of Matches
 • Annotations

Export Search Results Detail
An exported search results details will create a spreadsheet containing all or a subset of your search results.  This saved .xslx file can 
then be redistributed, changed, or printed using your default spreadsheet editor (e.g. Excel ).
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 1. Open a previously saved search result using the  File -> Open  menu or perform a search.

 2. To export selected details only:

 a. 

In the Results window, click on a result row. Details will appear in the Details window.

 Left click the check-box next to each item you wish to include from the results list. 

 b. OR, left-click on the check-box in the results title bar for a drop down list of actions available. 

You may use the menu of choices to select allor select none, etc.

 c. OR, right - click for a context menu to appear. You may use this context menu to select all or select 
none, etc.

 3. From the Find it EZ menu, select  File -> Export -> Search Results Detail . 
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 4. A Select the items to include dialog will appear.

 a. Click to choose one of the options, select Checked results only to export the subset of checked search result items 
if applicable per step 2 above.
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 b. Optionally check the Print check-box to bring up the print dialog.

 c. Click on the  Next  button. A Save As dialog box will appear.
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 i. Navigate to the destination folder.

 ii. Enter the desired File name.

 iii. Click on the  Save  button.

 d. A Save Complete dialog will appear.

 i. To view the saved file, click on the  View Now  button. The file will open in the selected viewer (see below).

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

 ii. To close the Save Complete dialog, click on the  Close  button.

 5. Exported search results detail will contain a copy of all highlighted search matches in full context. A single HTML file will be 
created, with each search result source item having a title and page break to separate documents included. It is essentially a 
copy of the search "Detail" panel contents for all selected search results items. 

Export Search Results Line Matches
An exported search results details will create a spreadsheet containing all or a subset of your search results.  This saved .xslx file can 
then be redistributed, changed, or printed using your default spreadsheet editor (e.g. Excel ).

 1. Open a previously saved search result using the  File -> Open  menu or perform a search.

 2. From the Find it EZ menu, select  File -> Export -> Search Results Line Matches . 

 3.  a. A Select the items to include dialog will appear.
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 i. Click to choose one of the options; All results, Currently displayed results, or Checked results only.

 ii. Click on the  Next  button. A Save As dialog box will appear.

 i. Navigate to the destination folder.

 ii. Enter the desired File name.

 iii. Click on the  Save  button.

 iii. A Save Complete dialog will appear (see below).

 i. To view the saved file, click on the  View Now  button. The file will open in the selected viewer (see 
below).

Tip: Click to check the Always view, do not show again check-box to always view the saved res-
ults file.

 ii. To close the Save Complete dialog, click on the  Close  button.

 4. Exported search results detail will contain the following data columns:

 • Source Location
 • File Type
 • Host Name

 • File Path or Database
 • Document Name

 • Section
 • Search Terms Matched
 • Matches Found
 • Original Line
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Export MS Project Tasks
An exported MS Project task list will create a spreadsheet containing all or a subset of your search results.  This saved .xslx file can 
then be imported directly into MS Project as a set of tasks to be assigned to resources.

 1. Open a previously saved search result using the  File -> Open  menu or perform a search.

 2. From the Find it EZ menu, select  File -> Export -> MS Project Tasks . 

 3. A Select the items to include dialog will appear.
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 a. Click to choose one of the options; All results, Currently displayed results, or Checked results only.

 b. Click on the  Next  button. A Save As dialog box will appear.

 i. Navigate to the destination folder.

 ii. Enter the desired File name.

 iii. Click on the  Save  button.

 c. A Save Complete dialog will appear.

 i. To view the saved file, click on the  View Now  button. The file will open in the selected viewer (see below).

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

 ii. To close the Save Complete dialog, click on the  Close  button.

 4. Exported search results will contain the following data columns:

 • Active - Yes or No

 • Task_Mode - Auto Scheduled or Manually Scheduled

 • Task_Name - Search Source and Path

 • Notes - Host and Path

Import Tasks to Microsoft Project
 1. Open Microsoft Project.

 2. From the  File  menu, select New.

 3. On the New page, click New from Excel workbook.

 4. In the Open box, click the arrow next to XML Format, and pick Excel Workbook.
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 5. Locate and select the workbook you want to import, and click Open.

 6. In the Import Wizard, click Next to get started, and follow the steps to complete the import.

Export Error List
An exported errors list will create spreadsheet containing all errors from your most recent search results.  If there are no errors to 
export, an alert will indicate there is nothing to save.  This saved .xslx file can then be sent to FinditEZ technical support or used to 
review individual files that may be corrupt for further investigation or required repair / removal from your system.

 1. Open a previously saved search result using the  File -> Open  menu or perform a search.

 2. If any errors are generated during the search, the Errors tab in the Results window will be selected automatically, the total 
number of errors will be shown on the tab label, and error details will be listed.

 3. From the Find it EZ menu, select  File -> Export -> Error List . 

 4. A Save As dialog box will appear.

 a. Navigate to the destination folder.

 b. Enter the desired File name.

 c. Click on the  Save  button.

 5. A Save Complete dialog will appear.

 a. To view the saved file, click on the  View Now  button. The file will open in the selected viewer (see below).

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

 b. To close the Save Complete dialog, click on the  Close  button.
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 6. The exported error list will contain the following data columns:

 • Location
 • Type
 • Host
 • File Path or Database
 • Document
 • Error
 • Details

See Also:
 • "File Menu Options" on page 35

 • "Wizards Overview" on page 117

 • "Perform a Regular Search" on page 174

 • "Work With Search Results" on page 190

 • "Viewer / Editor Settings" on page 57

Exit Find it EZ
 1. From the Find it EZ menu, select  File -> Exit .

OR

 2. Click on the  X  button located in the upper, right corner of the screen.

 3. The program will close.

 

Built-in Reports and Documentation
This section describes the steps required to access various Find it EZ reports included with the system.

For example, if you wanted to analyze a large number  of reports in preparation for a possible upgrade to discover which ones are not 
currently compliant with your corporate standards for recommended best practises involving table join syntax in the queries, you 
could chose any on of the following:

Many Find it EZ built-in documentation extracts will give you precisely what you are looking for.  One is the "Show SQL Queries" doc-
ument.   This report extracts any joins used by the visual linking expert within the CR designer and recreates the SQL code based on 
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the join property options used by the visual linking tool.   There is also the "Report Definition" and "Column Cross-Reference" which 
actually has a column or section showing the type of join used when applicable via the visual linking expert.   These reports are avail-
able under the Reports -> Business Intelligence menu. 

For more details on each document type available, please see below.

Note: Our trial mode has the number of documents searched and output limited.  However, a fully unlocked version is not limited.  
This may affect your evaluation results if the limits are reached. See below for more information.

Business Intelligence Reports
BI Reports can be generated and accessed as follows:

From the menu, select  Document -> Business Intelligence -> [desired report] . See report options below:

 • Database Cross-Reference - generates a single spreadsheet cross reference containing all database connections, tables, pro-
cedures, views, embedded SQL queries, database call statements, table joins, and optionally the underlying SQL code from 
the source database used in each selected report. This information is a high level summary of database tables used within a 
report and does not provide individual table column where-used detail ( see Column Cross-Reference ). Output spread-
sheet columns are customizable ( include / exclude as needed ). See a sample on our website: XSLX

 • Column Cross-Reference - generates a detailed where-used spreadsheet listing every location, formula, etc. that each and 
every source database table column is used. Provides report field name and full context statement referenced. Does not con-
tain high level database connection information ( see Database Cross-Reference ).  Output spreadsheet columns are cus-
tomizable ( include / exclude as needed ). See a sample on our website: XSLX

 • Show SQL Queries - extracts all embedded SQL queries, database call statements, and drag-n-drop tables and fields used 
in a report ( in the form of a simulated SELECT statement ).  Output can be to a single file for all selected reports, or individual 
files for each source file. Output file type options include text and HMTL. See a sample on our website: HTML or TXT

 • Reports Definition - generates a common formatting and labelled layout of report content, including data source connection 
information, SQL queries used within the report, database calls, report parameters, formulas, images, etc.. A formatted doc-
ument with relevant report design meta-data in a standard format re.g.ardless of source report type ( eg Crystal Reports, 
SSRS, Oracle Reports or any other report type supported ). Output can be to a single file for all selected reports, or indi-
vidual files for each source file. Output file type options include text, HMTL and XML. See a sample on our website: HTML , 
XML or TXT

 • Report Listing - generates a spreadsheet listing your complete report library, including file location, author, last updated, 
default printer, BI Login, last scheduled instance run datetime and report title / description. Output spreadsheet columns are 
customizable ( include / exclude as needed ). See a sample on our website: XSLX

SAP BOE Crystal Server
SAP BOE / Crystal Server reports can be generated and accessed as follows:

From the menu, select  Document -> SAP BOE / Crystal Server-> [desired report] . See report options below.

 • Report Schedules - generates a spreadsheet listing selected Crystal and/or Webi report schedules, filtered by frequency. 
Listing includes report name, destination, cycle frequency, next run date, last run status, parameters, triggering events, 
email notification contacts, datasource(s) , schedule description, title and owner. Output spreadsheet columns are cus-
tomizable ( include / exclude as needed ). See sample files on our website: HTML or TXT. See a sample on our website: 
XSLX

 • Security Listing - generates a spreadsheet listing all selected document ( file ) types supported by BOE. Listing includes 
folder, document ( report ) name, group or user, access level ( granted to group / user ), and base report location. Output 
spreadsheet columns are customizable ( include / exclude as needed ). See a sample on our website: XSLX

 • User Security Group Listing - generates a spreadsheet listing all users and access granted to each user. Listing includes 
username, full name and email address along with security access granted.  Output spreadsheet columns are customizable ( 
include / exclude as needed ). See a sample on our website: XSLX

https://www.finditez.com/solutions/report_examples/databasecrossref.xlsx
https://www.finditez.com/solutions/report_examples/reportcolumncrossref.xlsx
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.xml
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/reportlisting.xlsx
https://www.finditez.com/solutions/report_examples/sapschedulereport.xlsx
https://www.finditez.com/solutions/report_examples/sapsecurityreport.xlsx
https://www.finditez.com/solutions/report_examples/sapsecurityuser.xlsx


SQL Reporting Services

50 © 1998 - 2019 Find it EZ Software Corp.

SQL Reporting Services
Microsoft SQL Reporting Services reports can be generated and accessed as follows:

From the menu, select  Document -> SQL Reporting Services-> [desired report] . See report options below:

 • Report Schedules- generates a spreadsheet listing selected SSRS report schedules. Listing includes report name, des-
tination, cycle frequency, next run date, parameters, datasource(s) , schedule description, title and owner. Output spread-
sheet columns are customizable ( include / exclude as needed ). See a sample on our website: XSLX

rePORTAL
rePORTAL scheduling server reports can be generated and accessed as follows:

From the menu, select  Document -> rePORTAL-> [desired report] . See report options below:

 • Report Schedules- generates a spreadsheet listing selected Crystal, SSRS report and all other distributed document type 
schedules supported by rePORTAL. Listing includes report name, destination, cycle frequency, next run date, last run 
status, parameters, triggering events, email notification contacts, datasource(s) , archive, burst, schedule description, title 
and owner. Output spreadsheet columns are customizable ( include / exclude as needed ). See a sample on our website: 
XSLX

 • Package Schedules - generates a spreadsheet listing selected Crystal, SSRS report and all other distributed document type 
schedules supported by rePORTAL at a package level. This includes all details from individual report schedules contained in 
a package, plus package description, title and owner. Output spreadsheet columns are customizable ( include / exclude as 
needed ). See a sample on our website: XSLX

See Also:
 • "Document Wizards" on page 148

 • "Export Search Results" on page 37

 • "Reporting Tools" on page 251

 • "Product Trials and Limits" on page 25

 

https://www.finditez.com/solutions/report_examples/SSRSScheduleReport.xlsx
https://www.finditez.com/solutions/report_examples/rePortalScheduleReport.xlsx
https://www.finditez.com/solutions/report_examples/rePortalSchedulePackages.xlsx
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User Settings and Customization
This section describes the steps required to set user options, preferences, and settings for Find it EZ.  These configuration settings 
are permanently saved for each session, allowing each end-user to customize the software to their specific environment (source 
items) and preferences.

Set User Options
 1. From the Find it EZ menu, select  Tools -> Customize -> User Options .

 2. The User Options dialog box will appear, as below:
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 3. Choose, select, or enter settings as desired. Refer to the table below for details:

User Option Description

Use application 
default search set-
tings (Boolean, Entire 
Document)

Choose this option to apply the Find it EZ default search settings (i.e. Search Type = Boolean 
Search, OR see next option...

Use last search set-
tings

Choose this option to apply the last-used search settings for the next search.

Show Wizards Click to check this item if you want to launch the Search Wizard each time you start up Find it 
EZ.

Show me when 
updates are available

Click to check this item to receive a notification message when you start up Find it EZ when any 
new updates are available for download.
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User Option Description

Run in reduced per-
formance mode 
(Used for 
troubleshooting)

This option can be used if / when you have limited memory (RAM) on your computer and Find it 
EZ is freezing, crashing, logging .net memory issues, or taking a VERY long time to complete a 
search.  The Find it EZ program will process the maximum number of documents simultaneously 
using threads.  By dropping this to reduced performance mode, only a single document is pro-
cessed at a time, reducing stress on a system with a limited amount of RAM. Default = Off ( for 
optimal performance ).

Enable Crystal 
Report locked file 
pre-checks (Local or 
network files only)

Allows the Crystal Reports scanner to detect locked files during indexing and, if a file is currently 
open or locked, to make a temporary copy of the file before allowing Crystal Reports to open it. 
Note that this feature is disabled by default as it can affect performance.

Warn me if files are 
larger than: ___ MB

When processing many documents in a folder & sub-folders (especially "text" type documents), 
this option will allow you to skip individual large documents during the search process that are 
found in a source folder; like error logs, etc. that may be in a file directory but do not need to be 
searched (as they will either return too many false positives OR will slow down processing unne-
cessarily).  This  gives you an opportunity at search run time to skip certain very large files you 
may not have wanted to be scanned but were in the folder and had a file type you do want to 
search other (smaller) documents for matches.   You can change this setting to customize for 
your environment. Default = 4 MB.

Automatically expand 
details

Click to check this item to expand selected result details in the Details window when a result is 
selected in the Results window. If unchecked, details will appear collapsed. Click on the "+" to 
expand.

Always view my expor-
ted report after sav-
ing

Click to check this item if you want exported reports to open immediately after saving.

Limit the number of 
matches per object 
to: ___

Use this limit when too many matches are being returned in each individual document and you 
really only care if one or more "hits" are discovered. This will improve Find it EZ performance; 
once the limit of matches per document is reached, the search engine moves on to the next doc-
ument and logs a "maximum hits reached" warning in the error log.   Default = 1000.

Show project settings 
whenever I select a 
source item

Click to check this item to launch the Project Settings dialog box each time you select (check) 
an item in the Source panel. These settings allow you to include / exclude the selected item, con-
figure and test connection settings and select folders (where applicable), apply filters, select the 
viewer / editor with which to open results, set options, and add or remove file extensions.

Show an alert when I 
try to remove one or 
more search results

Click to check this item if you want a confirmation message to appear (i.e. "Are you sure you 
want to remove this item from the search results?" Yes / No) each time you right-click on a result 
in the Results window and select Remove.
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User Option Description

Show an alert before 
I attempt to search 
database data

Every time you are about to run a search that includes database table data, when this option is 
checked, an alert is displayed. This warns you that the search time may be long, depending on 
the size of the table. Find it EZ searches for matches in every column (field) of every row in the 
table. For a table with a significant number of text columns and  rows, this can really affect the 
search performance and run time. Find it EZ allows for searching database table data, but this is 
intended for small "system" tables that are used in a dynamic table-driven software system.  
Such tables contain references to screen names, report labels, or even code to perform actions.  
This is also why we have the user explicitly choose a small subset of tables and do not offer a 
"search all tables" option.   Basically, this reminds the user they are about to search data and 
gives them the option to cancel the search / disable data searching before proceeding.  At a min-
imum, it lets them know why the search is taking awhile. Default = On (to warn the user every 
time they are about to search table data). Note also that database table data searching is "dis-
abled" by default.

Enable detailed error 
logging

This option is used to help identify the file on which a search may be getting stuck.   It is best if used 
in combination with "reduced performance mode" enabled and will allow the system to log 
search steps in the "session log" in greater detail.  This is often requested by tech support for 
sending in logs and helps expedite problem resolution. Default = Off. 

 4. Click on the  OK  button to save your settings. The User Options dialog box will close.

 5. To discard any changes, click on the  Cancel  button.

Show or Hide Result List Columns
Note: There must be results listed in the Results window in order for the following menu option to be enabled for use. Column 
names shown in grey cannot be hidden.

 1. From the Find it EZ menu, select  Tools -> Customize -> Result List Columns . 

 2. A list of column names will appear on the right (as above).

 3. Click to show or hide columns, as desired. See note above.

Show or Hide Source Items
This section describes how you can add ( show ) source items to correspond to technologies, programming languages, databases 
and reporting tools used in your work environment. Source items can be added in one of two ways.

 1. While configuring project or wizard settings for source locations.

 2. Using the Configuration Wizard.
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You can add ( show ) source file types while updating the advanced configuration settings on any of the file source location panels. 
For example, right-click on the Local or Network Folders item in the main Find it EZ window Source panel 
to launch the advanced configuration settings:

Click on the See more hyperlink to view all supported document types for this location. The list will be expanded to allow you to 
select additional source items currently hidden.
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If you check any source item that was previously hidden, this new setting will automatically be saved so that the selected document 
type will now be visible in all configuration panels or wizards. The checked source setting(s) will be enabled under the Configuration 
Wizard individual components tab and will automatically update and be saved to your custom program settings.

 

Source items visibility can also be set via the Configuration Wizard. Source items selected will be reflected in both the main applic-
ation (Source panel) and all Find it EZ wizards. In addtion to "showing" new source items, the Configuration Wizard allows 
you to hide items that are not required. This allows you to customize and clean your Find it EZ workspace and minimize unnecessary 
items from being displayed on the main Source panel or within any of the wizards.

To access the Configuration Wizard, from the Find it EZ menu, select  Tools -> Customize -> Source . 

The Source Items dialog box will appear, as below:
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Refer to the Configuration Wizard section of this user guide for more information.

See Also:
 • "Configuration Wizard" on page 60

 • "Viewer / Editor Settings" below

Viewer / Editor Settings
The File Association dialog settings allow you to select the viewer / editor used to open a search result list item, as well as to add or 
remove custom file extensions to be processed by available "search syntax" within the Find it EZ indexing engine. This ability to cus-
tomize how various file types are handled by the Find it EZ application is useful in situations where corporate naming standards 
require use of a unique file extension such as ".common" for shared JAVA program modules. The ".common" extension is not recog-
nized as a universal standard JAVA type file, but using this custom file type association within Find it EZ, you can configure the product 
to treat all files with the ".common" extension as containing JAVA code and to include and process them the same as any other stand-
ard JAVA programming language file for example.

Note: The Windows Default Editor (referenced below) is set at the Windows operating system level by the end user when you 
install a new program. Or, you can change the default editor settings in Windows 7 via Start -> Default Programs or in Windows 
10 via Start -> Settings -> System -> Default Apps.
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 1. From the Find it EZ menu, select  Tools -> Customize -> Associate File Types.

 2. The Associate File Types dialog box will appear, as below:
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 3. To add a new file type, click the Add button, the Associate File Type - Add / Edit dialog will appear as below:

Note: The Default Windows Application radial button option will automatically reflect "known" 
extensions on your system. For example, typing in the Extension "TXT" will show (NotePad) by default unless you 
have selected some other editor to open .TXT files.

 a. Enter the custom file type you would like to add for processing by Find it EZ in the Extension field.

 b. Select one of the available Find it EZ Search Syntax modules from the drop down list. This will direct the 
way in which the contents of the files with this extension are to be parsed by our search engine.

Note:  The list of search syntax options are limited based on the current set of document source types enabled 
within the Customization Wizard. To add more search syntax options, you must first add one or more file types 
associated with that syntax.

 c. Choose one of the following viewer / editor Open With options:

 • Find it EZ Viewer
 • Default Windows Application
 • Custom Application

 d. IF Custom Application is chosen:

 i. Click on the corresponding folder icon to the right of the Custom Application text box. An Open 
dialog box will appear.
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 ii. Navigate to the program application you want to use to open this type of file.

 iii. Click on the  Open  button.

 4. To save any changes and close the Associate File Types - Add / Edit dialog box, click on the  OK  button.

 5. To discard changes, click on the  Cancel  button.

To change the Open With program for an existing file type listed:

 1. Click to select ( highlight ) a file type in the list.
 2. Click the Change Settings button.

 3. The Associate File Types Add / Edit dialog will appear. 
 4. Change the Open With settings as desired. See above for Custom Application settings instructions.

 5. Click on the OK button to save and close.

Note:  You can not change the Search Syntax setting for any file types.  To change this setting, simply add an additional 
entry for the same extension using a different Search Syntax.  For custom file types, delete any unwanted Search 
Syntax listings.

To remove a custom file type:

 1. Click to select ( highlight ) any custom file type. You can not delete any built-in file types identified by a locked image 

 2. Click on the Remove button.

 3. Click on the OK button to save and close.

Alert:  You can add duplicate file type extension entries, but each must be unique by Search Syntax. Duplicate entries 
will process files with that extension using each unique Search Syntax selected. This may produce duplicate search res-
ults for the same file and is not recommended.

Configuration Wizard
The Configuration Wizard walks you through the steps required to set up your Find it EZ program so that it is customized to your envir-
onment.  It is recommended that you only select and display reports, databases, repositories, programs, version control systems and 
other files in use within your organization.   The configuration wizard is automatically launched after each install, including product 
upgrades. These settings can also be changed at any time as your company adds or removes support for individual file types or tech-
nologies in use.

Note:  With each new technology supported by a Find it EZ release update, any new databases, programs, reports, or other 
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source items will appear in the left hand panel to bring these new features to your attention. It is recommended that you use the 
configuration wizard to disable any such source items that are not in use within your organization in order to remove clutter from 
the Find it EZ interface.

 1. From the Find it EZ menu, select  Tools ->Customize->Source . 

 2. The Configuration Wizard will appear, as below:

 3. Click all boxes that apply to the technologies and vendor software that your shop uses or supports. This will in turn enable 
(select) all individual source databases, programming languages and reporting tools bundled / provided in that vendors 
product / portfolio that Find it EZ supports.

 a. If you use one or more of the supported Version Control Systems or BI report 
scheduling services, click to check all that apply to your work environment.

 b. If you use a SAP BOE or Crystal Server for scheduling report delivery, select a version from the Business 
Objects Server Version drop-down list on the panel to the right, just above the Apply and Cancel 
buttons. 
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Note:  Changing this selection will require a program restart after clicking on the Apply button. Changes may also 
require downloading and installing a compatible vendor connector.

 4. Click on the Individual Components tab and scroll through to see all checked items or expand all of the 
Summary categories on the right to display the complete list of items selected.

 5. From the Individual Components tab, click to select any additional database types, programming lan-
guages, documents and report utilities used by your organization. Selecting a subset of these available technologies sup-
ported by Find it EZ allows you to fully customize the source panel on the main application window and wizards  project 
configuration panels to only display the items applicable to your work space. 

 a. To save your custom settings, click on the Apply button.

 b. To discard any changes, click on the  Cancel  button.

Note: If one or more items selected is greyed out, this means it is included in a vendor bundle from the Software 
Platforms Used tab. You must deselect the corresponding bundle(s) to deselect the item(s) in the Indi-
vidual Components tab. An individual item may be included in more then one software platform set .. 
expand the Summary items to view all items included within each software platform bundle.

Alert: Changing these selections may require Find it EZ to prompt for required vendor connectors upon first use and/or may 
restart the program to apply new settings.
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See Also:
 • "Download Connectors" on page 301

 • "Show or Hide Source Items" on page 54

 • "Viewer / Editor Settings" on page 57

Clear Expressions History
Each time you perform a search, the search expression is added to a the top of a history list that can be accessed by using the (drop-
down arrow ) to the right of the Find text box within the search bar.  A maximum of the most recent 25 expressions are saved, with 
the oldest simply dropping off the bottom of this history list as new searches are performed.  To access find expressions history for re-
running a previous search expression, simply click on the Find box drop down arrow.

To clear the search expressions history:

 • From the Find it EZ menu, select  Tools -> Clear Expression History . 

 • All previous search expressions will be deleted (except for the current search expression).
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Index & Search Management
This section provides instructions to clear your current documents index or search history in order to recover disk space.  You may 
also create an index summary report to review the contents of your current or search history indexes.

Find it EZ stores an optimized, tokenized version of your documents, along with meta-data and a keyword dictionary in the following 
default location:

 • C:\ProgramData\Bits n Bytes Software Inc\Find it EZ - Enterprise\Data\username\Index2\DataStore\

Saved search results meta-data and pointers default location is here:

 • C:\ProgramData\Bits n Bytes Software Inc\Find it EZ - Enterprise\Data\username\Index2\SearchResults\

A proprietary set of NoSQL key-value hash indexes are used to store information about all source documents, projects and search 
results.  These sets of index files are loaded into RAM while the program is running and updated as part of each index refresh.  Per-
sistent copies of these index files are located in these default locations:

 • C:\ProgramData\Bits n Bytes Software Inc\Find it EZ – Enterprise\Data\username\Index2\DOCUMENTS.*

 • C:\ProgramData\Bits n Bytes Software Inc\Find it EZ – Enterprise\Data\username\Index2\PRJDOCUMENTS.*

 • C:\ProgramData\Bits n Bytes Software Inc\Find it EZ – Enterprise\Data\username\Index2\SEARCH.*

Alert:  You should never add, remove or change files directly that are stored in the index folder as this will corrupt your index.  
However, you can view and monitor the amount of physical disk space used by your Find it EZ indices within this folder.

In addition, Find it EZ uses a SQLite database to store your project configuration settings.   This database is located here:

 • C:\ProgramData\Bits n Bytes Software Inc\Find it EZ – Enterprise\Data\username\Index\config.db

You can open this database using a SQLite query tool at your discretion.  However, it is recommended that you use the packaged 
Find it EZ utilities to Repair or Reset this database.

Alert:  Manipulating data in this database directly will corrupt your Find it EZ project settings.  You will lose your project settings and 
be forced to Reset to factory defaults with our repair utility ( see below ).

Change Index Storage Location
 1. From the Find it EZ menu, select  Tools -> Index & Search Management .

 2. The Index & Search Management dialog box will appear, as in the example below:
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Note:  You can move your Find it EZ index storage location to an alternate drive for additional space or improved per-
formance on a faster ( e.g. SSD ) drive.

 3. Select the Storage Location tab.   Click on the folder browser button . Select the new desired index storage location 
using the Windows file browser.

 4. After changing the current storage location path, you will see an  Apply  button appear at the bottom of the Storage Loca-
tion tab, to the left of the Close button. Click the Apply button. You will be prompted to move (keep) the existing indexed 
documents or clear your index.

 5. Click the Clear button to create a new, empty index or click the Move button to copy your current indexed documents to the 
new location.  Click the Cancel button to abort.

Note:  When you choose to clear or move your index, your old index folder is automatically deleted to release previously 
used disk space.

Clear Index or Subset
Alert: When clearing the index or a subset from the Current Documents tab, any indexed documents that are contained in 
saved search results are not deleted. To remove documents contained in saved search results, use the Saved Search Results 
tab.  Multiple copies of documents are stored in your index whenever an updated version of the same file are detected if they have 
been saved within any search results.  This preserves the state of the file contents at the time the search results were saved, while 
also maintaining a “current” copy for subsequent search, compare, and documentation use.
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 1. From the Find it EZ menu, select  Tools -> Index & Search Management .

 2. The Index & Search Management dialog box will appear, as in the example below:

Note:  The current size of your indexes are shown at the bottom of each Index & Search Management tab dialog box 
(see above example).  If you feel this is too large (e.g. you are running out of hard drive space), you can shrink the data-
base to try and reclaim some of  that space. The benefits can be significant as the underlying database is a "grow only" 
type system. If, for example, you had 15,000  documents at one point and only have 200 now, you could reclaim a lot of 
space.

 3. Select the Current Documents or Search Results tab.   Current documents are the latest versions of all files contained  in 
your index.  Search results contain a list of all documents linked to any active session search results or previously saved 
search  results history.

 4. To clear the entire index:
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 a. Click to choose the Clear the entire index option.

 b. Click on the  Apply  button.

OR

 5. To clear a subset(s) of the index:

 a. Click to choose the Clear the following subset option. A check-box will appear before each project and subset.

 b. Click to check the project(s) or subset(s) you want to clear.

 c. Click on the  Apply  button. The selected project(s) and or subset(s) will be cleared from the index.

View Index Summary Report
 1. From the Find it EZ menu, select  Tools -> Index & Search Management . 

 2. The Index & Search Maintenance dialog box will appear.
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 3. At the bottom of the dialog box, click on the View Index Summary Report link. The Index Summary report will open in the 
selected viewer.

 4. The report will include the following data; one row per unique document:

 • Location – original physical location of the source document

 • Type – the type of document (e.g. Java, HTML, Crystal Report, Stored Procedure, etc. )

 • Host – original local or network host name of the source document

 • File Path or Database – original folder path or Database name of the source document

 • Document – document name

 • Last Updated – source document last updated timestamp (when available from the host system)

 • Last Indexed – document last indexed timestamp

 • Size (KiB) – indexed document size in kilobytes

Repair Index or Reset to Factory Defaults
In rare cases, if your index and/or project configuration files become corrupt and prevent Find it EZ from starting or the program per-
formance degrades to an extremely slow condition, you will need to use the Index repair utility.   The repair utility is a separate pro-
gram, automatically installed along with the main Find it EZ application and uninstall utility.

 1. To start the repair tool, use the Windows Start menu to navigate to executables installed within the Find it EZ programs 
folder.

 2. Run the Index Repair Tool.

 3. The utility dialogue window will prompt for one of two options:

 a. The Repair Index option will clear your entire index and attempt to repair your project configuration settings database.  
This will resolve most issues while preserving your saved project settings, and is the recommended first repair 
attempt.
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 b. The Factory reset option will clear your entire index AND all of your project settings will be lost. This is recommended 
as a last resort, but may be necessary if your project settings database becomes corrupt and can not be recovered or 
repaired.

 4. Click the  Next >>  button to run the selected repair option.  A  Repair dialogue will appear indicating progress.

 5. If the Repair Index option does not work, try a Factory Reset.  If this still does not resolve the issue, contact Find it EZ tech-
nical support.
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Projects
This section provides step-by-step procedures to add, edit, switch, clone, rename, set active, delete, or save a project and its set-
tings.

Projects are used to configure and store paths and connection information for a collection of source code files.  These settings are 
retained for re-use between sessions, and can also be used to filter a small subset of items to be included in a project, compare or doc-
umentation run.  Each project or collection is generally configured in relation to how your development process flows.   For example, in 
a waterfall development process, you would typically have planned releases, each with a corresponding set of individual unit and an 
integration test environment.   There is often also a staging environment for a frozen set of releases where final user acceptance test-
ing is performed, followed by a production environment.  Each environment will have unique underlying database host, reports, pro-
gramming language files and so-on.

One common way to use Find it EZ projects is to set up a distinct collection of settings for each such environment or release.  You can 
then quickly switch between or compare files within these unique projects as you move through the design, development, migration, 
and production support processes.

Projects are a key feature for organizing your work within Find it EZ, and the ability to configure each once, and then re-use settings 
between indexing and search passes, is a huge time saving benefit.

From the Find it EZ menu, select  Projects -> Manage Projects . The Manage Projects dialog box will appear, as below:



Add a New Project

© 2010 - 2019 Find it EZ Software Corp. 71

Add a New Project
 1. From the Manage Projects dialog box, click on the  Add  button. A dialog will appear.

 2. Enter the name of the new project.

 3. Click on the  OK  button. The new project will be added to the list.

 4. To close the Manage Projects dialog box, click on the  Close  button.

Edit a Project
You may change the configuration settings to add a new file path, add a new database schema or owner to include that set of objects, 
add file or database object filters and so on.

 1. From the Manage Projects dialog box, in the projects list, click to highlight the project you want to edit.

 2. Click on the  Edit  button. The Project Settings dialog box will appear. See example below:
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Switch Between Projects
 1. The name of the currently viewed project is shown in the top, left corner of the main screen Title Bar. See below:

 2. To switch to another project:

 • From the Find it EZ menu, select  Projects -> [Project Name] . 

 • The selected project settings will be loaded for use.

Another way to select a saved project settings for use is to use the Project Management dialog box:

 1. From the Manage Projects dialog box, click to select the name of the project you want to set as the active project.

 2. Click on the  Set Active  button. The  project will appear in the list followed by the word "(active)."
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 3. To close the Manage Projects dialog box, click on the  Close  button.

Clone a Project
A quick way to set up a new project is to clone ( copy ) an existing one, then update individual source configuration settings as needed.

 1. From the Manage Projects dialog box, click to select the project you want to clone (i.e. copy all settings).

 2. Click on the  Clone  button. A dialog will appear.

 3. Enter a different name for the new, cloned project.

 4. Click on the  OK  button. The cloned project will be added to the list.

 5. To close the Manage Projects dialog box, click on the  Close  button.

Rename a Project
 1. From the Manage Projects dialog box, click to select the project of which you want to change the name.

 2. Click on the  Rename  button. A dialog will appear.
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 3. Change the name, as desired.

 4. Click on the  OK  button. The renamed project will appear in the list.

 5. To close the Manage Projects dialog box, click on the  Close  button.

Delete a Project
 1. From the Manage Projects dialog box, click to select the name of the project you want to delete.

Note: The active project cannot be deleted.

 2. Click on the  Delete  button. The selected project will be immediately removed from the list.

 3. To close the Manage Projects dialog box, click on the  Close  button.

File Locations and Source Settings
This section provides detailed instructions to configure project settings for Source Location (local or network folders, repositories, 
databases) and File Type (Programs, Documents, BI Reports), including instructions on how to customize Find it EZ project set-
tings.

Note:  Some project configuration settings are used in combination with each-other.   For example, in order to include any Pro-
gramming Language files, Reports or Other Documents, you must select and configure the physical “Location” of those files.   This 
could include a local or network folder, a version control system, or a report scheduling repository.

There are three ways to access the Project Settings dialog box:

 1. From the Find it EZ menu, select  Projects -> Settings  to access the active project settings. See below:

 2. Within the main program window, right-click on any location or source item within the expanded Source panel.  The 
advanced settings for the active project source item will appear (see sample below).
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 3. From the Manage Projects dialog box, click to highlight a project from the list, then click on the  Edit  button to access the 
selected project's settings.
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View or Hide Project Settings

At the bottom, left of the Project Settings dialog box, you can click to check the Do not show this window each time I select a 
source item check-box. 

Apply Project Settings

When you are done making changes to one or more a source items, click on the  Close  button to apply the changes.

Note:  Changes are also automatically applied and saved as you navigate between source items within the Project Settings dia-
log box.

See Also: "Set User Options" on page 51 (in the Tips and Hints section, there is a Show project settings whenever I 
select a source item check-box). Click to check or un-check as desired.

Location
This section provides detailed steps required to configure project settings for local or network folders, repositories, and databases. 
These are the physical locations of the source files, documents, and data included within a project.

Local or Network Folders
This section describes the procedures required to include the set of selected programming files, reports, and other documents from 
local or network folders, add or edit search path(s), include / exclude archive files, exclude files or folders, and to apply file filters to 
restrict processing to only a subset of selected files.

To access the active project settings for local or network (source) folders:
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 1. In the frame on the left, in the  Folders and Version Control category, click to select Local or Net-
work Folders. See below:

OR

 2. From the menu, select  Projects -> Settings . See below:

 3. The following dialog box will appear:
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Include Source

When a source item is selected from the frame on the left, the Include [Source Name] check-box at the top of the dialog box is 
checked by default. To exclude the source from your search, click to un-check the check-box.

Note: If a source item is excluded, any existing settings for the source are retained.

Add or Edit Search Path(s)

To add a search path to the Local and Network Folders search:

 1. From the Options tab, click on the  Add  button.

 2. In the Search Path(s) section, click on the  Add  button. A Search Path dialog will appear, as below:



Add or Edit Search Path(s)

© 2010 - 2019 Find it EZ Software Corp. 79

 3. Click on the folder icon  button to the right of the Directory field. A Select Folder dialog will appear. See example 
below:

 a. Navigate to and select the folder you want to add as a search path.

 b. Click on the  Select Folder  button. The folder path will appear in the Directory field.

Tip: You can also copy and paste or type in a fully-qualified path into the Directory text box.

 4. Note that the Include Sub Directories check-box is checked by default. To exclude sub directories for the selected folder, 
click to un-check this check-box.

 5. Click on the  OK  button. The new search path will be added to the Search Path(s) list. See example below:
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Note: If sub directories have been included for a given search path, a green check mark appears in the corresponding 
Include Sub Directories? column.

Alert:  You will be prevented from entering duplicate paths or overlapping sub-folders for a project.

 6. Repeat steps 2 through 5 to add multiple paths.

To edit a search path:
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 1. In the Search Path(s) list, click to highlight the search path you want to edit. See example below:

 2. Click on the  Edit  button.

 3. Repeat steps 3-5 above.

To remove a search path:

 1. In the Search Path(s) list, click to highlight the search path you want to remove.

 2. Click on the  Remove  button. The selected search path will be removed from the list.

Click on the  Close  button to apply your changes.

Include Archive Files

Whether or not a file is considered an Archive is determined by the file extension.  If it is any of the following support Archive types, it 
will be opened as an archive and Find it EZ will search the contents:

"ARJ", "LZH", "LZMA", "RAR", "RPM", "7Z", "XZ", "BZ2", "BZ", "GZIP", "GZ", "TAR", "ZIP"

To include archive files in your Local or Network Folders search, locate and click the Yes option to Search within 
archive files.

Exclude Files or Folders

There are three ways to add one or more specific files or folders to be excluded from the selected directories (in the Search Path(s) 
list) in your Local or Network Folders search:
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 1. Right-click a search results item in the Errors tab, chose  Add File to Project Exclusion List  from the context menu. See 
below:

 2. To import a list of files to exclude:

 a. In the Exclude files, folders and archives ... section of the Mask Fil-
ters tab, click on the  Import  button. An Open dialog will appear.

 b. Navigate to and select the desired *.txt file.

 c. Click on the  Open  button. The contents of the selected file will be added to the in the Exclude files, 
folders and archives ... list.

 d. Click on the  Close  button to apply your exclusions.

AND / OR
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 3. To enter the path, file name, or wildcard to exclude:

 a. Click inside the Exclude files, folders and archives ... text box and enter the 
desired text to exclude.

Note: Enter each item on a separate line. Use * for wildcards. For example, enter the path to exclude a sub-dir-
ectory, exclude a specific type of files (e.g. *.cs), etc.

 b. Click on the  Apply  button to apply your exclusions.

To clear the Exclude File(s) / Folder(s) list:

 • Click on the  Clear  button. All items in the list will be removed.

Include File Filters

You may use both the Mask Filters and/or the File Filter tabs to include only a subset of specific files within the 
configured path(s).  You must first add the desired source path folders.   This filter is often used to minimize false positives or expedite 
indexing and searching by limiting the number of file contents included in a project.  This setting can be quickly changed to include all or 
a subset of files as needed.

To include one or more files and/or folders based on a wildcard or pattern that matches part of a file or path name:

 1. Open the Local or Network Folders project settings dialog box, click to open the Mask Fil-
ters tab, see below:

 2. By default, all paths and filenames within the Options tab Search Path(s) are included using the wildcard 
pattern *.* . 

 3. To only include the subset of files containing the text "order" in either the folder path or filename itself, replace the default 
*.* pattern with the text order, or *order* , as below:    
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 4. To also include any files in a subset of paths such as order history sales report stored by date as follows "..\orderhistory\yyyy-
mm\gross-sales.rpt", enter the pattern *\orderhistory\*\gross-sales.* , as below:    

 5. Repeat adding additional patterns on separate lines as needed, or use the Import button below to import a list of  patterns.

Note: The list of "included" patterns is cumulative. In other words, each pattern on a line is "OR"-ed together with all 
other patterns. As such, leaving the default "*.*" pattern in this box would supersede all individual pattern lines that may 
be added.

 6. To clear the list, use the Reset button to restore the default *.* pattern ( ie, include all ).

To include one or more specific fully qualified files by name:

 1. Open the Local or Network Folders project settings dialog box, click to open the File Filter 
tab, see below:



Include File Filters

© 2010 - 2019 Find it EZ Software Corp. 85

 2. To include all files, click to choose the Include all Files option. This is the default selection.

OR

 3. To include only a subset of files, click to choose the Only include this subset of Files option.

 4. To add a subset:

 a. Click on the  Add  button. An Add Filter dialog will appear.

The Available Files list will be populated with a list of files included in the folders selected previously on 
the Options tab, and filtered to include / exclude specific subsets of files based on any entries on the Mask 
Filters tab.

 b. Click to select the desired file(s).
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Note: Select multiple items by holding down the  Ctrl  key. Or, click on the  Select All  button or the  Select None  
button, or the  Refresh  button as desired.

 c. To filter by file name, use the Filename Filter:

 i. Click inside the Filename Filter text box.

 ii. Enter the desired file name filter, using wildcards as desired (e.g. *.cs, *.js, *user*, etc.).

Note:  This filter applies to the filename itself, and does not apply to the drive letter, folders or path names.

 d. Select one or more items from the list.

Tip:  Use the Select All button or hold the CTRL key then click to select multiple items.

 e. Once complete, click on the  Add  button. The selected files will be added to the Only include this subset of Files 
list.

 f. Repeat steps 5a through 5e to add additional files as desired.

AND / OR

 5. To paste a subset from the clipboard:

 a. Click on the  Paste  button. The clipboard contents will be added directly to the Only include this subset of Files 
list.

 b. Optionally repeat Copy then Paste additional fully qualified filenames until completed.
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Alert:  The clipboard may contain a single file or list of filenames, but each line must be formatted with a fully qual-
ified path.

 6. To remove file(s):

 a. To remove all files from the list, click on the  Remove All  button.

 b. To remove only selected file(s) from the list, click to select the files you want to remove, then click on the  Remove  but-
ton.

 7. Click on the  Close  button to apply your changes.

Repositories
This section describes the procedures required to include files stored in various version control systems or report scheduling repos-
itories,  enter repository connection information, test a repository connection, select repository folders, and apply a file or report filter.

To access project settings for repositories:

 1. Edit the active project using the  Projects -> Settings  menu.

 2. In the frame on the left, in the Location category, locate the Repositories sub category.

Note:   You may access the same dialog box with a simple right-click on the desired repository in the expanded Source 
panel on the left of the main application screen.
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 3. 

 4. Click on the desired repository name. In the first example below, we have selected the BusinessObjects BI platform 4.1 
repository:

In the second example below, we have selected the Git / GitHub repository:
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Connection Information - Repositories

 1. For the selected repository, select and/or enter the required connection information. Depending upon the repository selec-
ted, these settings could include:

 • Authorization Name

 • Hostname

 • Port

 • Username

 • Password

 • Search File Type(s)

 • Git Repository

 • Branch / Module or Branch

 • Server URL or Server

 • Collection / Project or Project

 2. To have Find it EZ remember your password between sessions, click to check the Remember check-box. The default set-
ting is enabled (i.e. checked).

Note:  If not saved, each time you start the Find it EZ program, you would be required to re-enter active project repos-
itory passwords.   Otherwise, the attempt to authenticate your secure connections would fail for any index, search, com-
pare, replace or document process.

 3. Click on the  Close  button to apply your changes.
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Test Repository Connection

To test your connection, click on the  Test Connection  button. A progress dialog will appear with the following message: "Please wait, 
contacting the server."

 1. If the test is unsuccessful, you will receive an "Unable to connect. Please check your settings and try again." message, along 
with a Provider Message giving more details.

Note: The error handling system will provide up to two messages / alerts:

 • Find it EZ will indicate, in general, what happened (e.g. "Unable to connect.").

 • The called program may, at times, return a more detailed message that is proprietary to that target system and 
often provides you with more details to help you resolve the "why" we were unable to connect. We are not in con-
trol of the content of that message or when / if it comes back, but we will always display and log the extra details 
whenever possible.

 2. If the test is successful, you will receive a "Connection made successfully!" message.
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Select Repository Folders

To select folders, click on the  Select Folders  button. A progress dialog will appear: "Please wait, contacting the server."

 1. Once connected, a Select Folder dialog will appear, showing a list of all folders included in the selected repository.

 2. To show empty folders, click to check the Show empty folders check-box.

 3. Select the desired folder(s) or sub-folder(s) by clicking to check the check-box preceding the desired folder(s).

Tip:  Clicking to check a parent folder will auto select / deselect all sub-folders.

 4. Once selections have been made, click on the  OK  button. The selected folder(s) will appear in the folders list.

Apply Report Filter

To apply a report or file filter on a set of Repository documents to be included:
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 1. Open the desired Repository dialog box.

 2. Click to select the Report Filter tab.
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 3. To include all reports, click to choose the Include all Reports option. This is the default selection.

OR

 4. To include only a subset of reports, click to choose the Only include this subset of Reports option.

 5. To add a subset:

 a. Click on the  Add  button. An Add Filter dialog will appear. The Available Reports list will be populated with a list of 
reports included in the previously selected folder(s) (on the Options tab).

 b. Click to select the desired report(s).

Note: Select multiple items by holding down the  Ctrl  key. Or, click on the Select All or  Select None  button, or 
the  Refresh  button as desired.

OR

 c. To filter by name, use the Filename Filter. 

 i. Click inside the Filename Filter text box.

 ii. Enter the desired file name filter, using wildcards as desired (e.g. *.cs, *.js, *user", etc.).
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Note: This filter applies to the file name itself, and does not apply to the drive letter, folders, or path names.

 d. Select one or more files from the list.

Tip: use the Select All button or hold down the  Ctrl  key then click to select multiple items.

 e. Once complete, click on the  Add  button. The selected reports will be added to the Only include this subset of 
Reports list.

 f. Repeat steps 5a through 5e to add additional files as desired.

AND / OR

 6. To paste a subset from the clipboard:

 a. Click on the  Paste  button. The clipboard contents will be added directly to the Only include this subset of 
Reports list.

 b. Optionally repeat Copy then Paste additional fully qualified filenames until completed.

Alert: The clipboard may contain a single file list of filenames, but each line must be formatted with a fully qualified 
path.

 7. To remove report(s):

 a. To remove all reports from the list, click on the  Remove All  button.

 b. To remove selected report(s) from the list, click to highlight the reports you want to remove, then click on the  Remove  
button.

 8. Click on the  Close  button to apply your changes.

See Also: 
 • "Local or Network Folders" on page 76

Databases
This section describes the procedures required to include the databases source in a project, enter database connection information, 
test a database connection, reset search defaults, open results with the desired viewer / editor, and apply various database search fil-
ters.

To access project settings for databases:
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 1. Edit the active project using the  Projects -> Settings  menu.

 2. In the frame on the left, in the Location category, locate the Databases sub category.

Note:   You may access the same dialog box with a simple right-click on the desired database in the expanded Source 
panel on the left of the main application screen.

 3. Click on the desired database name. In the first example below, we have selected the Oracle database:



Databases

96 © 1998 - 2019 Find it EZ Software Corp.

In the second example below, we have selected the SQL Server database:
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Connection Information - Databases

 1. For the selected database, select and/or enter the required connection information. Depending upon the database selec-
ted, these settings could include:

 • File Extensions Searched

 • Password

 • Search [Options]

 • Hostname or IP

 • Port Number

 • Username

 • Database

 • Authorization Type

 • SID or Service

 • Schema

 • Owner

 • Classes

 • DSN

 • Instance Number

 2. To have Find it EZ remember your password between sessions, click to check the Remember check-box. The default set-
tings is enabled (i.e. checked).

Note:  If not saved, each time you start the Find it EZ program, you would be required to re-enter active project database 
connection passwords.   Otherwise, the attempt to authenticate your secure connections would fail for any index, search, 
compare, replace or document process.

Alert:  Passwords are not saved in plain-text; however, if you chose to save passwords, it is recommended that you make 
an effort to secure access to the configuration database.

 3. Click on the  Close  button to apply your changes.

Test Database Connection

To test your connection, click on the  Test Connection  button.

 1. If the test is unsuccessful, you will receive an "Connection failed!" message, along with a Reason. Check your settings and 
try again.

Note: The error handling system will provide up to two messages / alerts:
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 • Find it EZ will indicate, in general, what happened (e.g. "Unable to connect.").

 • The called program may, at times, return a more detailed message that is proprietary to that target system and 
often provides you with more details to help you resolve the "why" we were unable to connect. We are not in con-
trol of the content of that message or when / if it comes back, but we will always display and log the extra details 
whenever possible.

 2. If the test is successful, you will receive a "A connection was made successfully!" message.

Reset Search Defaults

On the database Connection tab or BI Reports Options tab (see links below), the Search section contains a number of items for 
which you can search. To include a set of database objects, select an item and click to check the preceding check-box.

For each database type, there is a set of default database objects normally used for code change impact analysis.  To restore the 
selections to the default settings that came with your Find it EZ install, click on the  Reset search defaults  button.   This will also reset all 
individual database object filters to “include all items”.

Note:  If any one of the default items are not selected, or if a subset of objects are filtered, the corresponding Source item in the 
main application left panel will indicate this by including a Filter next to the Source item.  This allows you to quickly identify when 
the source database objects are filtered and may not include all documents as configured.

Open Results With

To specify the viewer / editor with which you want to open search results for the selected database, locate the Open Results With 
field and click on the corresponding  Select Viewer / Editor  button.
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Apply Database Item Filters

Depending upon the database selected, you may be presented with a number of filter options from which to choose, including:

 • Data

 • Tables

 • Stored Procedures

 • Triggers

 • User Defined Functions

 • Views

 • Java Procedures

 • Functions

 • Packages

 • Events

Each of these tabs allow you to select between including all corresponding database object items, or only specific subset of items.  
This allows you to expedite the subsequent (re)indexing process as well as reduce false-positive matches in your search results.

Click on the desired filter tab (see examples below).

You may use the File Filter tab to include only a subset of specific files within the configured path(s).  You must first add the desired 
source path folders.   This filter is often used to minimize false positives or expedite indexing and searching by limiting the number of file 
contents included in a project.  This setting can be quickly changed to include all or a subset of files as needed.

To apply a Data filter:

 1. Open the desired Database dialog box.
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 2. Click to select the desired Data tab.

 3. To add a subset:

 a. Click on the  Add  button. An Add Filter dialog will appear.

The Available Tables list will be populated with a list of tables included in the folders selected previously on the 
Options tab.

 b. Click to select the desired table(s).

Note: Select multiple items by holding down the  Ctrl  key. Or, click on the  Select All  button or the  Select None  
button, or the  Refresh  button as desired.
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 c. To filter by table name, use the Filename Filter:

 i. Click inside the Filename Filter text box.

 ii. Enter the desired file name filter, using wildcards as desired (e.g. *.cs, *.js, *user*, etc.).

Note:  This filter applies to the table name itself, and does not apply to the drive letter, folders or path names.

 d. Select one or more items from the list.

Tip:  Use the  Select All  button or hold the  Ctrl  key then click to select multiple items.

 e. Once complete, click on the  Add  button. The selected tables will be added to the Only include this subset of 
Tables list.

 f. Repeat steps 3a through 3e to add additional tables as desired.

AND / OR

 4. To paste a subset from the clipboard:

 a. Click on the  Paste  button. The clipboard contents will be added directly to the Only include this subset of Tables 
list.

 b. Optionally repeat Copy then Paste additional fully qualified filenames until completed.

Alert:  The clipboard may contain a single file or list of filenames, but each line must be formatted with a fully qual-
ified path.

 5. To remove file(s):

 a. To remove all files from the list, click on the  Remove All  button.

 b. To remove only selected table(s) from the list, click to select the table(s) you want to remove, then click on the  Remove 
 button.

 6. Click on the  Close  button to apply your changes.

Note:  Normally, including database table data is disabled by default.  However, in some systems it may be necessary to include 
searching the contents of some system tables that either contain dynamic programming logic / code, or that may contain type 
codes or other application related content you wish to include in your change impact analysis.  Because this can drastically affect 
indexing size and search performance, you must select the subset of specific system tables.  Searching all database tables is not 
recommended.

To apply a Stored Procedures filter:
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 1. Open the desired Database dialog box.

 2. Click to select the Stored Procedures tab.
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 3. To include all stored procedures, click to choose the Include all Stored Procedures option. This is the default selection.

OR

 4. To include only a subset of files, click to choose the Only include this subset of Stored Procedures option.

 5. To add a subset:

 a. Click on the  Add  button. An Add Filter dialog will appear.

The Available Stored Procedures list will be populated with a list of stored procedures included in the folders selec-
ted previously on the Options tab.

 b. Click to select the desired stored procedure(s).

Note: Select multiple items by holding down the  Ctrl  key. Or, click on the  Select All  button or the  Select None  
button, or the  Refresh  button as desired.

 c. To filter by file name, use the Filename Filter:

 i. Click inside the Filename Filter text box.

 ii. Enter the desired file name filter, using wildcards as desired (e.g. *.cs, *.js, *user*, etc.).

Note:  This filter applies to the stored procedure name itself, and does not apply to the drive letter, folders or 
path names.

 d. Select one or more items from the list.

Tip:  Use the  Select All  button or hold the  Ctrl  key then click to select multiple items.

 e. Once complete, click on the  Add  button. The selected stored procedures will be added to the Only include this 
subset of Stored Procedures list.

 f. Repeat steps 5a through 5e to add additional stored procedures as desired.

AND / OR

 6. To paste a subset from the clipboard:

 a. Click on the  Paste  button. The clipboard contents will be added directly to the Only include this subset of Stored 
Procedures list.

 b. Optionally repeat Copy then Paste additional fully qualified filenames until completed.
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Alert:  The clipboard may contain a single file or list of filenames, but each line must be formatted with a fully qual-
ified path.

 7. To remove file(s):

 a. To remove all files from the list, click on the  Remove All  button.

 b. To remove only selected stored procedure(s) from the list, click to select the stored procedures you want to remove, 
then click on the  Remove  button.

 8. Click on the  Close  button to apply your changes.

Tip:  Each of the database item filters, other than “table data”, work in the same way as a file filter.  However, when using wildcards 
to select database objects some include the object schema or owner in the format:  owner.objectname .   You may filter the selec-
tion list to include all objects belonging to a specific owner as follows:   owner.*

See Also: 
 • "Local or Network Folders" on page 76

 • "Viewer / Editor Settings" on page 57

 • "BI Reports" below

 • "Search an Oracle Database" on page 243

 • "Search a SQL Server Database" on page 247

File Type
This section provides detailed steps required to configure project settings for Programs, Documents, and BI Reports.

BI Reports
This section describes the procedures required to include the BI Reports source files, reset defaults, download optional connectors, 
and open search results with the desired viewer / editor.

Report files can be physically stored in one of three Locations:

 • Local or network folders.

 • Report Scheduling database repositories, such as SAP BusinessObjects Enterprise Server or a SQL Server Reporting Ser-
vices database.

 • Version control system repositories, such as git, TFS, etc.

To include selected report type files in a Project, you must also select and configure one or more of the possible locations these cor-
responding files can be stored within.

To access project settings for BI Reports:
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 1. Edit the active project using the  Projects -> Settings  menu.

 2. In the frame on the left, in the File Type category, locate the BI Reports sub category.

Note:   You may access the same dialog box with a simple right-click on the desired report utility in the expanded Source 
panel on the left of the main application screen.

 3. Click on the desired report utility. In the example below, we have selected the Crystal Reports report utility:
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Note: The  Use default settings  button resets the sections and search items to the most common used program settings.

The steps required to configure individual settings for each report utility are similar to other file type source items. Each report utility 
uses a unique document model to organize and manage code and content design.  For BI report designers familiar with each tool, 
these report sections and page layout areas will be familiar.  You may include all or a subset of these items to limit the scope of doc-
ument contents indexed and/or searched.

Note: The  Use default settings  button resets the sections and search items to the most common used program settings.

To specify the viewer / editor with which you want to open search results for the selected report utility, locate the Open Results With 
field and click on the corresponding  Select Viewer / Editor  button.
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See Also:
 • "Viewer / Editor Settings" on page 57

 • "File Locations and Source Settings" on page 74

 • "Download Connectors" on page 301

 • "Reporting Tools" on page 251

 • "Create a Database Cross-Reference List" on page 251

 • "Identify reports using a specified connection" on page 275

 • "Find text in a text box in a Crystal Report" on page 279

Programs
This section describes the procedures required to include various programming language source code files in a project, add or 
remove file extensions searched, and open results with the desired viewer / editor.

Programming language source code files can be physically stored in one of two Locations:

 • Local or network folders.

 • Version control system repositories, such as git, TFS, etc.

To include selected programming language source code files in a Project, you must select and configure one or more of the possible 
locations these corresponding files can be stored  within. You must also include the programming languages in the Customization 
Wizard.
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To include the programming languages used in your development environment: 

 1. Select ( enable ) the applicable vendor technology stacks, web & bundled software apps on the Software Plat-
forms Used tab via the main menu Tools -> Customize -> Source :

Note:   You may access the same dialog box with a simple right-click on the desired programming language in the expan-
ded Source panel on the left of the main application screen.

 2. Or click on the Individual Components tab, locate the Programming Languages sub category.
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 3. Click on the desired programming language(s), then click on the Apply button to show / hide these available source doc-
ument types within the Include sections of the corresponding source location Options tabs in the Project Settings 
configuration dialog. See below for example:

Note:  The See more link located at the end of the Include lists, when clicked, auto refreshes the list of available 
items to include the "hidden" but available source items. When a "hidden" item is checked, it will become visible going for-
ward on the Source panel on the main screen and automatically be included in your custom program settings.

 4. Refer to See Also links below for more info on managing project settings.

Add or Remove File Extensions Searched

Within many organizations, corporate file-naming standards are often used for common programming language functions.   You may 
apply the same syntax-aware parsing of content for a given programming language by adding these file extensions to the cor-
responding source item.
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 1. To add a new custom file type, from the main menu Tools -> Customize -> Association File Types

 a. Click on the  Add New  button. A dialog will appear (as below).       

 b. Enter the name of the new file extension (without the leading ".").

 c. Select the desired programming language Search Syntax to be applied to contents of documents using 
this file type extension.

Alert:  You may only associate (add) unique custom filename extensions to one or more programming language.  
So, for example, if you wanted to associate the file extensions “sam” to be parsed as a Java file, and / or a C# file, 
you can add the same file type "sam" selecting each search syntax you would like it parsed with. However, this may 
produce duplicate search results for each search syntax with the same file and is not recommended.

 d. Chose an Opens With viewer / editor.

 e. Click on the  OK  button. The new file extension will be added to the File Type Extension list.

 2. To remove a file extension:

 a. In the File Type Extension list, click to select the file extension you want to remove.

 b. Click on the  Remove  button. The selected file extension will be removed from the list.
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Alert:  You will not be able to remove any of the standard default file extensions associated with each Programming Lan-
guage.

 3. To apply your changes, click on the  OK  button.

See Also:
 • "Search Wizard" on page 122

 • "Projects" on page 70

 • "Viewer / Editor Settings" on page 57

 • "File Locations and Source Settings" on page 74

Documents
This section describes the procedures required to include the documents source in a project, add or remove file extensions 
searched, open results with the desired viewer / editor, and select Microsoft Excel search scope options (where applicable).

Application logs, data files and office documents can be physically stored in one of two Locations:

 • Local or network folders.

 • Version control system repositories, such as git, TFS, etc.

To include selected documents in a Project, you must also select and configure one or more of the possible locations within which 
these corresponding files can be stored.

To access project settings for documents:

 1. Edit the active project using the  Projects -> Settings  menu.

 2. A Project Settings dialog window will appear as below. 
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Note:   You may access the same dialog box with a simple right-click on the desired document type in the expanded 
Source panel on the left of the main application screen.

 4. In the tree list on the left, locate the Advanced Search Filters sub category.

 3. Click on the desired document type. In the example below, we have selected the Microsoft Excel document type:



Microsoft Excel Search Options

114 © 1998 - 2019 Find it EZ Software Corp.

Microsoft Excel Search Options

Note that when the Microsoft Excel source is selected, you are able to select from the following Search options to optimize search 
performance and reduce false-positive matches:

 • Formulas - include cell formula content

 • Data - include visible cell data content

 • Connection Properties - include Excel workbook datasource connection information

To include content from these items, click to check the preceding check-box (un-check to exclude).

Add or Remove File Extensions Searched

You may add custom file type extensions to be searched using the Tools -> Customize -> Associate File Types menu, which will 
launch the Associate File Types dialog as below:
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 1. To add a file extension (where applicable):    

 a. Click on the  Add New button. A dialog will appear (see below).

 b. Enter the name of the new file extension (without the leading ".").
 c. Select the Search Syntax applicable to the contents of files saved with this extension.

 d. Chose an Open With option to associate your preferred file viewer / editor with this new extension. The default 
is the built-in Find it EZ Code Viewer.

 e. Click on the  OK  button. The new file extension will be added to the Associate File Types list.

 2. To remove a file extension:

 a. In the Associate File Types list, click to select the custom file extension you want to remove.

 b. Click on the  Remove  button. The selected file extension will be removed from the list.

Alert:  You will not be able to remove any of the standard default file extensions associated with each Document type. 

These built-in file types are indicated with a lock  icon.
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 3. To apply your changes, click on the  OK button.

See Also:
 • "Viewer / Editor Settings" on page 57

 • "File Locations and Source Settings" on page 74
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Get Started with Wizards
This section provides step-by-step procedures required to use the various Find it EZ 'wizards' to walk you through common tasks, to 
perform a regular search, to use the expression builder, and to understand the features of the Searching status window (including 
multitasking while searching, errors, and stopping a search).

A 'wizard' is a sequence of dialog boxes that lead you through a series of well-defined steps. This section will introduce you to the fol-
lowing four basic types of Find it EZ wizards:

 • Search Wizard

 • Compare Wizard

 • Document Wizards

 • Replace Wizards

 • Backup Wizard

Wizards Overview
This section describes how to launch the various available Wizards, understand the purpose of each unique option, and to set the 
main Wizards dialog to show (or not) on application start-up.

Launch the Wizards
The Wizards walk you through the steps required to set up and run a search, generate documentation, and perform other common 
tasks. If the Show on Start-up option is selected, the Wizards dialog will open automatically when you start up Find it EZ.

Note: The Show on Start-up option is selected by default when Find it EZ is run for the first time.

If the Wizards dialog does not open automatically, follow these steps:
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 1. Click on the  Wizards  button. The Wizards dialog box will appear.

 a. Click to choose the desired search option.

 b. Click on the  Next  button to continue.

 2. Create or select a new project:

 a. Click to choose the Use an existing project option, then select the desired project from the drop-down list,

OR

 b. Click to choose the Create a new project option and enter the desired project name into the corresponding text box.

 c. Click on the  Next  button to continue.

 3. Select the file types to include in your search:

 a. Click to check each item you want to include.

 b. Click on the  Next  button to continue.

 4. Select the desired file locations:

 a. Click to check any File Locations you want to search.

 b. Click to check any Databases you want to search.

 c. Click on the  Next  button to continue.

 5. Enter connection information for each repository or database.

Note: If more than one source location is selected, connection information will be requested for each source.
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 a. Click on the  Test Connection  button to verify your connection.

 b. Click on the  Next  button to continue.

 6. Enter your search criteria:

 a. Enter a search term into the Find text box.

 b. Click on the  Start Search  button. A search dialog box will appear showing the status of the search.

 7. Once the search is complete, results will appear in the Results window.

Wizards Options
Refer to the image and table below for a description of each option:
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# Wizard Menu 
Shortcut Use Case / Document Produced Sample 

Documents

Search for a specific 
database object, 
code snippet, or a 
variable to find any 
references through-
out all of my source 
code (including 
within reports and 
databases)

See links at 
end of topic.

Use Boolean or Wildcard search expressions to find all references to 
any text throughout your entire code stack, data files or office doc-
uments.  Search results are displayed in the main application window 
with highlighted match details for each document containing a "hit." 
Interactive to-do list results can then be used to launch an editor of 
your choice to work with the original source document, or lists can be 
updated, saved, printed or exported to various file formats such as 
HTML, text, CSV or Excel spreadsheets as needed.

List XLSX

List HTML

Detail 
XLSX

Detail 
HTML

Compare database 
schema, reports, or 
files for differences 
between versions

 Compare -
>  Docu-
ments, 
Reports & 
Databases 

Mass compare release branches for differences in versions of your 
code files, reports or database schema and SQL code objects (pro-
cedures, triggers, views, functions).  Drill down with detailed "diff" tool 
to view highlighted side-by-side target and source file differences pin-
pointing exactly what has changed.   Export results to Excel lists or scrol-
lable, highlighted HTML.

List XLSX

Detail 
HTML

Detail 
XLSX

https://www.finditez.com/solutions/report_examples/Search_Results_List.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_List.html
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.html
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.html
https://www.finditez.com/solutions/report_examples/Compare_List.xlsx
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.html
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.html
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Compare_Diff_Detail.xlsx
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# Wizard Menu 
Shortcut Use Case / Document Produced Sample 

Documents

Extract database 
objects (tables, 
stored procedures, 
views, etc.) used in 
my reports

Document -
> Business 
Intelligence 
-> Database 
Cross-Refer-
ence

Create a list of data source connections, server host names, data-
base names, tables, procedures, views, table links (joins), call state-
ments, parameters and includes both embedded SQL SELECT 
statements from within your reports or the underlying database SQL 
code content.  Results are exported to Excel with customizable column 
selections.

XLSX

Generate detailed 
content doc-
umentation for my 
reports

 Document -
> Business 
Intelligence 
-> Report 
Definition 

Automatically generate detailed report documentation for your entire 
report library in a consistent layout and format.  Complete report spe-
cifications in a standard format are exported in your choice of HTML 
or TXT format.   Create a single file for each report processed, or 
export all results into file with page-breaks for each report.

HTML

TXT

Extract all SQL code 
used in my reports

 Document -
> Business 
Intelligence 
-> Show 
SQL 
Queries 

Extract all SQL statements embedded within your reports, including 
run-time derived SQL commands and table joins from a visual drag-
and-drop designer.   Export documentation to your choice of HTML or 
TXT format.   Create a single file for each report processed, or export 
all results into file with page-breaks for each report.

HTML

TXT

Create a database 
cross-reference for 
my reports

 Document -
> Business 
Intelligence 
-> Column 
Cross-
Reference 

Create a complete database cross-reference for all of your reports.  
List tables and database fields used within your reports by location 
(where used / referenced).  Results are exported to Excel with cus-
tomizable column selections.

XLSX

List all my reports, 
including printer 
and update inform-
ation

 Document -
> Business 
Intelligence 
-> Report 
Listing 

Create a real-time list of all of your reports, including author inform-
ation, last updated, where located, etc.  Results are exported to Excel 
with customizable column selections.

XLSX

List the schedule for 
my reports inside an 
SAP BOE or Crystal 
Server Repository

 Document -
> SAP BOE 
/ Crystal 
Server -> 
Report 
Schedules 

Create a real-time list of all Crystal Report schedules within your SAP 
BOE or Crystal Server repository, including deliver to, output format, 
schedule frequency, data or event triggers, report parameters and 
more.  Results are exported to Excel with customizable column selec-
tions.

XLSX

  

List the security for 
my reports inside an 
SAP BOE or Crystal 
Server Repository

 Document -
> SAP BOE 
/ Crystal 
Server -> 
Security 
Listing 

Create a real-time list of Crystal Report security access for all sched-
ules and reports located within your SAP BOE or Crystal Server.  Res-
ults are exported to Excel with customizable column selections.

XLSX

List the schedule for 
my reports inside a 
SQL Server Report-
ing Services 
(SSRS) database

 Document -
> SQL 
Reporting 
Services -> 
Report 
Schedules 

Create a real-time list of all Crystal Report schedules    within your SQL 
Server Reporting Services database,    including deliver to, output 
format, schedule frequency,    data or event triggers, report para-
meters and more. Results    are exported to Excel with customizable 
column selections.

XLSX

https://www.finditez.com/solutions/report_examples/SQLCodeExtract.xlsx
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/DatabaseCrossRef.xlsx
https://www.finditez.com/solutions/report_examples/ReportListing.xlsx
https://www.finditez.com/solutions/report_examples/SAPScheduleReport.xlsx
https://www.finditez.com/solutions/report_examples/SAPSecurityReport.xlsx
https://www.finditez.com/solutions/report_examples/SSRSScheduleReport.xlsx


Show Wizards on Start-up

122 © 1998 - 2019 Find it EZ Software Corp.

# Wizard Menu 
Shortcut Use Case / Document Produced Sample 

Documents

Replace Crystal 
Report data source 
connections or qual-
ified table names

Replace -> 
Crystal 
Reports -> 
Data source 
connections 
or qualified 
table names

Mass change the data source connections for a set of Crystal 
Reports.  This is useful whenever you are migrating reports between 
development->test->production host environments, a database is 
moved to a new server, a database name has changed, the database 
type has changed or you want to change the data source connection 
type (for example you want to switch from ODBC to OLE DB con-
nection or vice-versa).  Output can over-write the original source files 
or be written to a new target folder (recommended).

  

Replace the user-
name, password, 
server or database 
of my Reports in an 
SAP BOE or Crystal 
Server repository

Replace -> 
Crystal 
Reports -> 
BOE BI Data-
base logon 
information

Mass change Crystal Report database login (authorization) inform-
ation on a set of schedules within an SAP BOE or Crystal Server.  Use-
ful to change a large set of schedules rather then having to change 
each report schedule individually through the Crystal Management 
Console.  Output can over-write the original source files or be written 
to a new target folder within the repository (recommended).

  

Show Wizards on Start-up
At the bottom, left corner of the Wizards dialog box there is a Show on Startup check-box. Click to un-check this item to prevent the 
Search Wizard from launching automatically each time you start the program.

See Also: 
 • "Perform a Regular Search" on page 174                

 • "Local or Network Folders" on page 76

 • "Use the Expression Builder" on page 180

 • "Work With Search Results" on page 190

 • "Search Within Result Documents" on page 200

 • "Projects" on page 70

Search Wizard
This section takes you through each step required to use the Search Wizard: launch the wizard (two ways), create or select a pro-
ject, select file types to include, select file location(s), enter connection information, enter search criteria and start the search, and 
enter connection information and update reports.
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Launch the Search Wizard

The Search Wizard is launched only via the  Wizards  button (i.e. this wizard cannot be accessed via the menu), as follows:

Click to choose the Search Wizard option:

 • Option 1: Search for a specific database object, code snippet, or variable to find any reference throughout all 
of my source code (including within reports and databases)

Click on the  Next >>  button to continue.

The Search Wizard will open.
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Create or Select a Project
Projects are used to group and save search settings, filters, and directories between sessions.

 1. After you "Launch the Search Wizard" on the previous page., the following dialog will appear:

 2. To use an existing project for your search:

 a. Click to choose the Use an existing Project option (selected by default).

 b. From the project drop-down list, click to select the name of the existing project (i.e. settings) you would like to use for 
your search.

 3. To create a new project for your search:

 a. Click to choose the Create a new Project option.

 b. In the project text box, enter the name of the new project.

 4. To use pre-indexed documents for this search, click to check the Use pre-indexed documents check-box.

Tip: Whenever possible, using pre-indexed documents will drastically improve search performance.

 5. Click on the  Next >>  button to continue.

Select File Location(s)
A number of Search Wizard options include this dialog box. See example below:
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Note: The Show More link located to the right of the lists below, when clicked, reveals the complete list of available locations 
of that type supported by Find it EZ. When a previously hidden item is checked, it will become visible on the Source panel on the 
main screen and will be automatically available for use in all of your projects going forward.

 1. In the Folders & Version Control   lists, click to select the storage areas within which you want to 
search.

 2. In the Databases list, click to select the source database(s) within which you want to search.

 3. Click on the  Next >>  button to continue.

Note: To go back to the previous step, click on the  << Previous  button.

Enter Connection Information
The following example is for SQL Server Reporting Services (SSRS) connection information.
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The following examples are for SQL Server database connections and local or network folders:
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 1. On the Options tab (selected by default), enter the connection information for the selected source.

 2. To test the connection, click on the  Test Connection  button where applicable.
 3. In the Include section, select all document types you wish to search.

Alert: You must select at least one document type to be included from each source location.

Note: The See More link located to the bottom-right of the Include lists, when clicked, reveals the complete 
list of available file or object types supported by Find it EZ stored within that location. When a previously hidden item is 
checked, it will become visible on the Source panel on the main screen and will be automatically available for use in all of 
your projects going forward.

 4. To optionally apply a filters in order to limit the subset of documents to be included, click on any of the object Filter tabs to 
right of the Options tab and see links below for more detail.

 5. To continue, click on the  Next >>  button. Repeat for each selected configuration panel as necessary.

Enter Search Criteria and Start Search
This dialog is the final step in the  Search Wizard. See below:
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 1. From the Search Type drop-down list, click to select one of the following options:

 • Boolean (can include wildcards)

 2. In the Find text box, enter the desired search expression.

Tip: Click on the More Information link for search expression hints, or click on the Expression Builder button for assist-
ance building complex boolean queries. 

 • To view or select from a list of recent search expressions, click on the field to view a drop-down list and click to select 
the desired search expression.

 • To perform a search using the Boolean Search Builder, click on the  Expression Builder  button. Refer to the 
See Also links below.

 3. In the Content Filters section, click to select the desired filters:

 • Exact Match - exact word match for Boolean search.  When enabled, matching will be attempted within each indi-
vidual word, not across words, and is case-insensitive.  If disabled (default), for Boolean, this would essentially 
behave like a wildcard (partial word) match.

 • Case Sensitive - match case of expression.

 • Include Comments - default is disabled to reduce false-positive matches.  When enabled, comments are 
searched.
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 • Comments Only - – default is disabled.  When enabled, “include comments” is automatically enabled and ONLY 
comments are searched.

 4. To launch the search, click on the  Start Search  button. A Searching ... dialog will appear. See example below:

 5. To stop the search, click on the  Stop  button.

 6. Once the search is complete, any results matching your search criteria will appear in the Results window.

 

See Also:
 • "Show or Hide Source Items" on page 54

 • "Perform a Regular Search" on page 174

 • "Use the Expression Builder" on page 180

 • "Local or Network Folders" on page 76

 • "Repositories" on page 87

 • "Databases" on page 94

 • "Local or Network Folders" on page 76

 • "Apply Report Filter" on page 91

 • "Projects" on page 70

 • "Use Pre-Indexed Documents" on page 177

Compare Wizard
This section takes you through each step required to use the Compare Wizard: including how to launch the wizard (two ways), how 
to choose compare source and target, how to configure and refresh or use pre-indexed documents for the compare process and 
how to map documents to compare.



Launch the Compare Wizard

© 2010 - 2019 Find it EZ Software Corp. 131

Launch the Compare Wizard
The Compare Wizard can be launched via the Wizards dialog or via the main menu. See below:

 1. Launch the Compare Wizard via the main Wizards dialog:

 a. Click on the  Wizards  button on the search bar.

 b. Click to choose the following  COMPAREoption:

 • Option 2: Compare database schema, reports or files for dif-
ferences between versions

OR
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 2. Launch the Compare Wizard via the main menu:

 • From the Find it EZ menu, select  Compare -> Documents, Reports & Databases 

 3. The Compare Wizard will open.

Choose Compare Source and Target

Note: Microsoft Excel spreadsheets and database table data are not supported by this tool.

 1. To compare files or database objects within a project:

 a. In the Source or Target section, choose the Project option.

Tip:  You may compare different files within a Project by selecting the same Source and Target along with 
a Custom    Compare By option.

 b. From the project drop-down list, click to select the name of the project you want to compare.

 c. To change settings for the selected project, click on the corresponding gears icon to the right.

 d. If desired, click to check the Use pre-indexed documents check-box.
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Note: Use of pre-indexed documents will improve performance.  However, the documents compared may not be 
the latest content as the index will not be refreshed to check for any updates prior to executing the comparison of 
project files previously indexed.

 2. To compare search results:
 a. In the Source or Target section, choose the Search Results option.

 b. From the search results drop-down list, click to select the desired search results. Note the date and time.
 3. In the Compare By section, click to choose one of the following three methods of comparison:

 • Fully Qualified Name - automatically matches documents by name within identical Source 
and Target, qualified by identical sub-folder path or database name.

 • Document Name - automatically matches documents by name within identical Source and Target. 
The files do not have to reside in the same source and target paths or databases as is the case for Fully 
Qualified Name option above. 

Note:Use this option when the database name or folders where documents you would like to compare are dif-
ferent, but the document names themselves are identical between source and target projects / search results 
being compared.

 • Custom - allows full end-user control of Source and Target document pairs to compare. 

Note: Use this option to compare the contents of files with different filenames or contents of completely different 
file types (e.g. a database procedure to a SQL script file, for example).

 4. To continue, click on the  Next >>  button.

Update Index for Compare
Once you choose the compare source and target and click on the  Next >>  button, the index begins updating. See example below:



Update Index for Compare

134 © 1998 - 2019 Find it EZ Software Corp.

The next example contains some errors:
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Use the horizontal scroll bar to view details of any errors, then correct and re-run the wizard or ignore any issues if they are not rel-
evant to the documents you intend to compare.

Once the index update is complete, click on the  Next >>  button to continue.

Select Documents to Compare
After selecting the source and target and then allowing the index to update, you will be prompted to select the types of documents to 
be compared.  You may optionally select a specific subset of individual documents by name.  See example below:
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Note:  If subset, but not all items are selected in a branch, a solid box will display:

Click to check a category to 'select all' for a category. Or, click on the '+' to expand a document type and click to check the desired doc-
uments for comparison.

If you selected the Compare By Custom file mapping option on the main Compare Wizard dialog, you will be prompted 
to map each desired source and target document pairing to compare.

There are three custom mapping options:

First, you can “auto map” by fully qualified path & name by clicking on the  Map all by fully qualified name  button. See example result 
below:
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Note that all Source and Target documents with identical names that are also located in the same project "relative" paths or 
the same database type & name have been moved to the Mapped Items list. This can be considered a "top down" auto-map-
ping of documents, including the relative path names to find matches between source and target project settings.

Tip:  This option is the same automatic mapping as Compare By: Fully Qualified Name on the main 
Compare Wizard dialog window. However, by choosing the Custom mapping selection on the first step allows you to also 
add or remove individual "mapped items" if desired to further refine your Source and Target documents on this 
Custom Mapping dialog.

Second, you can “auto map” by document name by clicking on the  Map all by Document name  button. 

Note that all Source and Target documents with identical names ( including document type / extension ) have been moved 
to the Mapped Items list. The order in which source and target documents are selected is based on the order in which 
source and target items were indexed. This can be considered a "bottom up" auto-mapping of documents, using the document 
names themselves as the primary key to locate matches between source and target project items.

Tip:  This option is the same automatic mapping as Compare By: Document Name on the main Compare Wiz-
ard dialog window.  However, by choosing the Custom mapping selection on the first step allows you to also add or remove 
individual "mapped items" if desired to further refine your source and target documents on this Custom Map-
ping dialog.

Note:  Document mapping by name will allow you to quickly auto-map files or database objects with the same name, but stored in 
different database types, database names or paths in the case of files. However, you must restrict your Source and Tar-
get configuration settings ( file paths and databases, etc. ) to optimize this auto-matching process by minimizing the possibility of 
duplicate documents in either Source or Target projects or search results being compared. 

Third, you can select an individual source and target file to “map” for comparison of contents, as follows:

Note: This allows you to compare two files in different source & target paths or two files of different type or name, etc.  

 1. Click to select and highlight the desired item in the Source list.
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Tip:  When mapping individual documents, you can enter text in the Source Filter box to restrict to a subset of source doc-
uments.   See example below:

 2. Click to select and highlight the desired item in the Target list. This will enable the  Map selection button below the 
Source and Target list boxes.

Tip:  When mapping individual documents, you can check the Filter by selected source to return a subset of likely target 
documents to compare based on a “fuzzy match” algorithm.  This reduces the amount of target documents to scan 
through. See example below:

 3. Click on the  Map selection button. See example below:



Select Documents to Compare

© 2010 - 2019 Find it EZ Software Corp. 139

 4. As each document from the Source and Target lists are included in a mapping pair for comparison, they are removed from 
the top two respective lists, and added to the Mapped Items list at the bottom. See example below:

Note: Once one or more documents are “mapped” to be compared, there is a context menu on the left that allows you to 
select and remove one or more mapped documents. Click on the down arrow to view. See example below:
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 5. After mapping all document pairs to be compare, click on the  Next >>  button to continue. This takes you to the Compare 
Wizard summary dialog.

View Compare Results Summary
Once the compare is complete, the following summary will appear. See example below:

To close the Compare Wizard and view the results in the Results window, click on the  Finish  button.

See Also:
 • "File Locations and Source Settings" on page 74

 • "Use Pre-Indexed Documents" on page 177

 • "View Compare Results Detail" on the facing page

Compare Files, Reports, and Databases
This section provides step-by-step instructions required to start a new or modify a comparison process, how to show differences, fil-
ter / search / export compare results, drill down to view highlighted document differences, expand / collapse compare results, search 
for text in source or target documents and copy or print comparison result details.

Comparing database schema, report files, programming language code files, or documents is an effective way to quickly pinpoint dif-
ferences / changes between environments or releases.   This is particularly effective when assessing the impact of changes to a 
vendor supplied new release by simply comparing your current production environment to the new release deployed to a staging 
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environment, for example.  Compare identifies all files or database objects with differences and includes the ability to drill down and 
view these differences with side-by-side colour highlighting of line-by-line contents.

View Compare Results Detail
After completing a comparison using the Compare Wizard and viewing the results summary, click on the  Finish  button to view the 
Comparison Results window. See example below:

Start New Compare

Alert: The following procedures will remove all compare results.  Export or save any details you wish to keep before starting a new 
compare.

To start a new comparison, you may either use the  Compare  menu or click on the  button located in the upper, left corner of 
the Comparison Results window.

You will be returned to the beginning of the Compare Wizard to start a new comparison.
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Modify Current Compare
If you wish to simply change the set of files that were included in your latest set of comparison results, you can quickly do so by restart-
ing mid-way through the Compare Wizard .  To do so, in the upper, left corner of the Comparison Results window, click on the 

 button.

You will be returned to the Compare Wizard document selection dialog window to allow you to change the set of documents you 
want to compare.

Filter Compare Results List
At the top of the Comparison Results window, there are a number of Show Differences view filters available. See 
below:

Once a compare wizard has been completed, a list of results are presented on the Comparison Results dialog with the screen split 
into a summarized list view on top, and a detail view displayed on the bottom whenever a list item is selected.  The results are grouped 
by document and document type within the list view. To expand or collapse a result group, click on the '+' or '-' button, respectively.

Click on any item in the list to drill down and view content of the item in the “diff viewer” below.  You may locate an item within the list by 
using two available list filter options:

Click to check the desired check-box to view that selection. The first three filters are checked by default. Click to un-check any as 
desired:

 1. Click to check the desired check-box to view that list of corresponding documents following the Source vs Target 
comparison.  The first three filters are checked by default. Click to un-check or check any as desired:

 • Only in Source -   No corresponding file or database object exists in the  Target project, indicating 
an item has only been added in the Source project or has been removed / is missing from the Target pro-
ject.

 • Only in Target - No corresponding file or database object exists in the Source project, indicating 
an item has been removed or is missing from the Source project ... or has only been added to the Target 
project.

 • Different - list of files or database objects that contain differences within their content.  Indicates that this set 
of files have  changed when comparing Source to Target project copies.

 • Identical - list of files or database objects that contain NO differences within their content.  Indicates that this 
set of files have NOT  changed when comparing Source to Target project copies.

 2. As you type text into the Filter  text box, the displayed list items are automatically restricted to show documents that 
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contain the text within the file or database object name.  For example, you may type the text “Customer” to only list a subset 
of items containing the word “Customer” within the file or database object name.

Tip: Use of these filters is also applied to restrict the items included in an export list.

Export Compare Results List
 1. Use the list check boxes to filter the list of documents you would like to export.  Only selected (checked) items will be included.

 2. At the top of the Comparison Results window, locate and click on the    Export List  button. A Save As dialog will appear.

 3. Enter a File name.

 4. Click on the  Save  button.

Note: The list will be saved in *.xlsx file format.

 5. The saved list will open automatically with the selected viewer / editor.

 6. The following data will be included in the exported file:

 • Source, Target, and Date Compared - a summary of when and what set of documents were compared.

 • Comparison Results - for each document included in the exported set, this will indicate one of four possible res-
ults: the file was found in the source set only, target set only, found in both and had differences, or contents were 
identical.

 • Source Document Type
 • Source Host
 • Source File Path or Database
 • Source Document
 • Target Document Type
 • Target Host
 • Target File Path or Database
 • Target Document

 7. Save the file as desired.
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Work with Compare Wizard Details
When a list item containing differences is selected from the list above, the actual lines and type of differences that exist between the 
source and target content are highlighted using the appropriate colour.  The side-by-side differences viewer will auto-scroll both 
source and target contents to show changes between the two documents in full context.

To eliminate the need to scroll through the entire content of documents and show lines with differences only, simply click to check the 
Show differences only check-box.

Tip:  Use of the Show difference only filter is also applied to restrict the items included when exporting details to 
an XSLS or HTML document.

  

At the bottom of the Comparison Results window, there is a result status colour key. See below:

Differences between the source and target content are highlighted in the above colours.

To show differences only, click to check the Show differences only check-box.

To search for specific text within either the source or target viewer:

 1. At the top of the Source or Target window, locate the   Find text box.

 2. Enter the desired filter / search text into the text box.

 3. Click on the right arrow button to find next or the left arrow button to find previous. Content matching your search criteria will 
be highlighted in purple.

 4. Repeat to view all instances matching your search criteria.

Export Compare Details
You may export the color highlighted contents of the side-by-side differences viewer to ether an HTML or XLSX file format.
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At the bottom right of the Comparison Results window, locate and click on either the HTML or  Excel  button. Highlighted Source 
and Target side-by-side details will open in the selected Windows default editor. Save as desired.

Copy, Save or Print Compare Result Details

Select All Source or Target Compare Results
 1. In the compare results list at the top, click to highlight the document for which you want to view details. Details will appear in 

the Source and Target boxes at the bottom.

 2. Left-click anywhere within the Source or Target box and press the  Ctrl  +  A keys on your keyboard, or right-click on the 
either Source or Target compare result details and a context menu will appear.
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 3. From the context menu, choose  Select All . All details in the current box will be highlighted.

 4. Press the  Ctrl  +  C keys on your keyboard or right click again anywhere on the highlighted text and from the context menu, 
select Copy . All selected Source or Target text will be copied to the clipboard.

 Copy Source or Target Compare Results
 1. In the compare results list at the top, click to highlight the document for which you want to view details. Details will appear in 

the Source and Target boxes at the bottom.
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 2. In the Source or Target box, select the text you want to copy.

 3. Press the  Ctrl  +  C keys on your keyboard or right-click anywhere on the highlighted text. A context menu will appear.

 4. From the context menu, select Copy . All highlighted text will be copied to the clipboard.

Save or Print Source or Target Compare Results
 1. In the compare results list at the top, click to highlight the document for which you want to view details. Details will appear in 

the Source and Target boxes at the bottom.

 2. In the Source or Target box, right-click on the compare result details. A context menu will appear.



Document Wizards

148 © 1998 - 2019 Find it EZ Software Corp.

 3. From the context menu, select Save Source or Save Target. A Save As dialog will appear.

 4. Enter a File name and click on the  Save  button to save the document with color-coded differences by line. The document 
will open in a new browser tab.

 5. To print the color highlighted document contents; press the  Ctrl  +  P  keys on your keyboard or use the Print menu or icon 
within your default browser.

Document Wizards
This section takes you through each step required to use the Document Wizards: launch the wizards (two ways), create or select a 
project, select file types to include, select file location(s), enter connection information, select recurrence and what to include, and 
choose report options and export report.

Launch a Document Wizard
The DOCUMENT Wizards can be launched via the  Wizards  button or via the main menu. See below:
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 1. Launch a DOCUMENT wizard via the  Wizards  button:

 a. Click on the  Wizards  button in the search bar. See below:

 b. Click to choose one of the following DOCUMENT Wizard options:

 • Extract database objects (tables, stored procedures, views, etc.) used in my reports

 • Generate detailed content documentation for my reports

 • Extract all SQL code used in my reports

 • Create a database cross-reference for my reports

 • Create a list of all my reports, including printer and update information

 • Create a list of all my schedules inside Business Intelligence server

 • List the security for my documents inside a Business Intelligence server

 • List all users and their security groups inside a Business Intelligence server

OR

 2. Launch a DOCUMENT Wizard via the Find it EZ menu:

 • Select Reports -> Business Intelligence -> [Any Option]
 • Select  Document -> SAP BOE / Crystal Server -> [Any Option] 

 • Select  Document -> SQL Reporting Services -> [Any Option] 

 • Select  Document -> rePORTAL -> [Any Option] 

 3. Click on the  Next >>  button to continue.

 4. The selected DOCUMENT Wizard will open.
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Note:  The following example is the DOCUMENT Wizard for an SAP BI Platform schedule listing, which is only available 
in our Dev Surge 365 product edition.   However, most of the steps and dialog boxes presented in this example are vir-
tually identical for the other Document Wizard options.

Select Recurrence and What to Include
Note: The recurrence dialog is only selected for the SAP BI Platforms schedule listing option of the DOCUMENT Wizards; ( 
which can also be accessed from the menu via  Document -> SAP BOE / Crystal Server -> Report Schedules ).
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 1. Click on the Recurrence drop-down. A list of options will appear, as below:

These are items that match up to selections in the SAP BI Platform repository schedule frequency options.

 2. Click to select the desired recurrence.

 3. If you want to show the default settings, click to check the Base Reports only check-box. 

Note: Crystal reports has "Default Settings" and "Per Instance Settings." Default settings belong to the report itself (the 
base report) and then each time you schedule a report you can give the report its own schedule / settings.  This allows you 
to just return the defaults as you may have a large number of one-time scheduled reports that will never be run again.

 4. To continue, click on the  Next >>  button.

Choose Report Options and Export Report
The following dialog is used with the Export Wizard. See example below:
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 1. In the Columns section, choose to Include all columns or to Select from the following.

 2. IF the second option is chosen:

 a. In the Available list, click to select the report column you want to include, then click on the  ->  button to move the selec-
ted column to the Included list.

 b. To move all columns from the Available list to the Included list, click on the  ->->  button.

 c. To remove all columns from the Included list, click on the  <<  button.

 d. To remove a single column from the Included list, click to select the report column you want to remove, then click on 
the  <  button.

 3. Once complete, click on the  Export  button to generate and save your report. The Searching dialog will appear.

See Also:
 • "Reporting Tools" on page 251

 • "Create a Database Cross-Reference List" on page 251

Epic Compass Comparison Wizard
This section outlines the procedures required to create the Epic Hyperspace compass compare tab delimited file used as input to the 
Find it EZ Epic compass comparison wizard, followed by the steps to initiate a change impact analysis search, and export the results 
produced. The output is a spreadsheet workbook containing all of the matching input rows from the Epic compass compare file along 
with each document within which matches were located in your local source files, reports and database objects.  This output can then 
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be used to assess the overall impact or redistributed to team members responsible for maintaining portions of your application code 
to prepare for implementing an Epic release update.

Create Epic Hyperspace compass compare ( input ) text 
file.

 1. Launch Epic Hyperspace. From the main menu, select Epic  in the upper left.

 2. From the Epic sub-menu, select  Report Management ->Upgrade->Compass Upgrade. A Compass Upgrade dialog will 
appear.

 3. Select database and application objects to include, then click on the Browse button to select or create a target folder to store 
the compass compare results. Click on the Analyze and Upgrade button to generate the Epic compass compare change 
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manifest list based on your selections.

 4. Open the target output folder. The compasscompare.txt ( tab delimited text ) file is the valid input file and content format 
expected by the Find it EZ Epic compass comparison wizard. See example below:

Note: The tab delimited text file must contain the following columns (from left to right ): TYPE, OBJECT 
NAME, COLUMN NAME, CUSTOMER VALUE, EPIC VALUE, APPLICATIONS. 
This is the default Epic compass compare format produced by the steps above. Only the first 5 columns of this file are 
used in the Find it EZ Epic compass comparison Wizard, and as such, additional manually produced change manifest 
columns may exist to the right of the EPIC VALUE column, they will simply be ignored.

Launch the Epic Compass Comparison Wizard
The Epic compass comparison DOCUMENT Wizard can be launched via the  Wizards  button or via the main menu. See below:
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 1. Launch the Epic compass comparison DOCUMENT wizard via the  Wizards  button:

 a. Click on the  Wizards  button in the search bar. See below:

 b. Click to choose the following DOCUMENT Wizard option:

 • Search for all impacted source based on an Epic compass comparison change list 

 c. Click on the  Next >>  button to continue.
 d. The selectedDOCUMENT Wizard will open.

OR

 2. Launch the Epic compass comparison DOCUMENT Wizard via the Find it EZ menu:
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 • Select  Document -> Epic-> Compass Comparison

The Epic Compass Comparison Wizard will open.

Create or Select a Project
Projects are used to group and save search settings, filters, and directories between sessions.

 1. After you "Launch the Epic Compass Comparison Wizard" on page 154, the following dialog will appear:
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 2. To use an existing project for your search:

 a. Click to choose the Use an existing Project option (selected by default).

 b. From the project drop-down list, click to select the name of the existing project (i.e. settings) you would like to use for 
your search.

 3. To create a new project for your search:

 a. Click to choose the Create a new Project option.

 b. In the project text box, enter the name of the new project.

 4. To use pre-indexed documents for this search, click to check the Use pre-indexed documents check-box.

Tip: Whenever possible, using pre-indexed documents will drastically improve search performance. However, for the 
first run of the wizard it is recommended you do not enable this feature in order to ensure the latest version of each target 
document and/or database object is guaranteed to be refreshed within the index for the first pass of each new Epic com-
pass compare text input file or anytime a new source location / document type is planned to be searched for the first time.

 5. Click on the  Next >>  button to continue.

Select File, BI Platform and Database Location(s) to 
Search

Note: The Show More link located to the right of the lists below, when clicked, reveals the complete list of available locations 
of that type supported by Find it EZ. When a previously hidden item is checked, it will become visible on the Source panel on the 
main screen and will be automatically available for use in all of your projects going forward.
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 1. In the Folders & Version Control and/or Business Intelligence lists, click to select the storage areas within which you 
want to search.

 2. In the Databases list, click to select the source database(s) within which you want to search.

 3. Click on the  Next >>  button to continue.

Note: To go back to the previous step, click on the  << Previous  button.

Enter Connection Information
The following example is for Microsoft Reporting Services (SSRS) connection information.
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The following examples are for local or network folders and SQL Server databases:
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 1. On the Options tab (selected by default), enter the connection information for the selected source.

 2. To test the connection, click on the  Test Connection  button where applicable.
 3. In the Include section, select all document types you wish to search. 

Alert: You must select at least one document type to be included from each source location.

Note: The See More link located to the bottom-right of the Include lists, when clicked, reveals the complete 
list of available file or object types supported by Find it EZ stored within that location. When a previously hidden item is 
checked, it will become visible on the Source panel on the main screen and will be automatically available for use in all of 
your projects going forward.

 4. To optionally apply a filters in order to limit the subset of documents to be included, click on any of the object Filter tabs to 
right of the Options tab and see links below for more detail.

 5. To continue, click on the  Next >>  button. Repeat for each selected configuration panel as necessary.

Select Epic Compass Compare File and Change Types
The following dialog steps prompt for selection of the Epic compass compare tab delimited text file and change types included with 
the file for the search criteria input to the Epic Compass Comparison Wizard. See below:
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 1. Click the  Select File button. The windows file browser dialog will open. See example below:

 2. Browse to the folder that contains the compasscompare.txt tab delimited text file created in the Create Epic Hyperspace 
compass compare ( input ) text file steps described above.
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 3. Select ( highlight ) the desired input file and click the Open button. The change type selection dialog will appear containing all 
of the selected input file Epic change types available. Several change types will be automatically enabled by default if they are 
contained within the file: Deprecated Table, Deprecated Column, Data Type 
Change, Data Type Extension and/or New Column in Existing Table.

 

 4. To chose a different Epic compass compare file, click on the  Select File button, and proceed to step 2 above. The change list 
will be refreshed based on the content of the selected file.

 5. Select and/or deselect change types desired, then click the   Next button.

Select Export Results Options
The last dialog steps prompt for selection of the contents and format of the worksheets produced by the change impact analysis 
search results based on the selected Epic compass compare input file. See below:
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 1. Select Include all columns or click the Select from the following radial button to 
chose a subset of columns to include in the change manifest search results spreadsheet(s) produced.

 2. Select Single worksheet to export all search results to a single spreadsheet, or use the default Separate 
worksheet for each change type to produce separate spreadsheet tabs within the workbook for 
each Epic change type selected for processing.

Tip: The results are sorted and exported in groups based on the Epic compass compare input file lines where one or 
more matches are found in the source documents being searched. You may sort the results as desired within your 
spreadsheet editor program. If a large number of matches are found, you may need to choose smaller subsets of Epic 
change types for each wizard pass, or save the results to separate worksheets for each change type to avoid issues 
when working with the results within your spreadsheet program ( eg: Microsoft Excel ).

 3. Click the  Export button. The windows file browser dialog will open. See example below:
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 4. Chose a destination folder and enter a target workbook ( .xlsx ) filename and click the Save button to store and view your res-
ults. 

 

See Also:
 • "Show or Hide Source Items" on page 54

 • "Local or Network Folders" on page 76

 • "Repositories" on page 87

 • "Databases" on page 94

 • "Local or Network Folders" on page 76

 • "Apply Report Filter" on page 91

 • "Projects" on page 70

 • "Use Pre-Indexed Documents" on page 177

Replace Wizards
This section takes you through each step required to use the REPLACE Wizards: launch the wizard (two ways), select where to look 
for reports, enter connection information, select report destination folder, select report tables to change, choose new connection 
type, and confirm information and convert.

Launch the Replace Wizards
The REPLACE Wizards can be launched via the  Wizards  button or via the menu. See below:
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 1. Launch a REPLACE Wizard via the  Wizards  button:

 a. Click on the  Wizards  button in the main application window.

 b. Click to choose the following REPLACE wizard option:    

OR

 2. Launch a REPLACE wizard via the Find it EZ Replace menu:

 3. The selected REPLACE Wizard will open.

Select Where to Look for Reports
Below is an example of the "change Crystal Reports Datasource connections" replace wizard.
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 1. Select where you want to look for reports:

 a. Choose Local File System.

OR

 b. Choose BusinessObjects BI Platform 41 Repository.

 2. Click on the corresponding project drop-down list and select the desired project.

 3. If you have one or more search results selected, click to choose the Use selected documents option. This is a way of run-
ning the report with only a subset of items based on your last search.

 4. To continue, click on the  Next >>  button.
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Select Report Destination Folder

 1. To place the updated reports in a new folder, click to choose the New Folder option.

 a. Click on the folder icon to the right of the text field. A Select Folder dialog will appear.

 b. Create or navigate to and select the desired folder.

 c. Click on the  Select Folder  button. The selected folder path will now appear in the text field.
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OR

 2. To overwrite the original files, click to choose the Overwrite original files option.

Alert: All converted files are written to a single pre-existing target folder.   The sub-folder structure from the selected 
source documents are not created in the target destination output path selected.  If duplicate filenames exist in sub-
folders, the files will be over-written with the last copy converted.   This is a known limitation with an enhancement planned 
to auto re-create the source folder paths.  As a temporary work-around, it is recommended that you convert only a single 
folder of documents at a time.

 3. To continue, click on the  Next >>  button.

Select Report Tables to Change
FinditEZ allows replacement of multiple or a subset of database connections that may exist within each report file.  You may choose to 
replace only a subset of database connections, or all of them at once.

 1. A list of report tables from the selected location will load. See example above:

 2. To stop Find it EZ from loading report tables, click on the  Stop  button.

 3. For each report table to want to change, click to check the preceding check-box. Note that all report tables in the selected loc-
ation are selected by default.

 a. To deselect all available report tables, click on the  Select None  button, then click to check only those you wish to 
include.

 b. To select all available report tables, click on the  Select All  button, then click to uncheck only those you wish to exclude.

 4. To continue, click on the  Next >>  button.
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Choose New Connection Type

 1. Select the new connection type:

 a. Click on the Type field to view a list of connection types.

 b. Click to select the desired connection type.

 2. Enter and/or select connection parameters:

 a. For Access / Excel (DAO) and xBase, click on the folder icon and navigate to and open the desired folder.

 b. For ODBC, select the ODBC DSN and enter the Username and Password.

 c. For OLEDB, Configure OLE (via Data Link Properties) and enter the Username and Password.

 i. Click on the  Configure OLE  button. The Data Link Properties dialog will appear. This dialog is opened by 
default.
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 ii. Select the Provider and click on the  Next  button.

 iii. Enter Connection parameters and click on the  Test Connection  button.

 iv. Enter any further required details (depending upon the selected Provider).
 v. Click on the  OK  button.

 d. For Oracle Server, enter the Service, Username, and Password.

 3. Tell Find it EZ what you want to do:

 a. In the I want to section, click to choose the desired option.

 4. To continue, click on the  Next >>  button.
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Confirm Information and Replace

 1. Review the following information:

 • Save Reports To
 • New Connection Type
 • Connection Parameters

 2. If changes are required, click on the  << Previous  button. Click the button again to return to previous steps.

 3. If the information is correct, click on the  Convert  button. A Conversion Status notification will appear. See example below:

 4. To stop the conversion, click on the  Stop  button.

 5. Once the conversion is complete, Microsoft Excel will launch and open a Conversion Results spreadsheet containing a 
detailed Conversion Log.
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Enter New Connection Information and Update Reports
This dialog appears only when option 10 is selected from the Wizards. See example below:

 1. In the I want to change section, click to choose the desired option.

 2. In the Update the following section:

 a. Click to select (i.e. check) each item that you want to update.

 b. For each selected item, enter the new connection information in the corresponding text box.

Note: Only checked items will be updated.

 3. In the Additional Options section:

 a. Click on the down arrow to view the drop-down list.

 b. Select the desired option from the list.

 4. To start the update, click on the  Update Reports  button.
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Perform a Regular Search
A regular search is performed without the use of the Search Wizard. Search settings are applied 'manually' and the search is ini-
tiated from the Search Bar.

In addition to using the Search Wizard, you can run a regular search as follows:

Select a Project
 1. From the Find it EZ menu, select  Projects . The currently active project appears preceded by a check mark, as in the 

example below:

 2. Select the name of the project for which you want to perform a search. The selected project name will appear in the Find it 
EZ window title bar (as above).
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Configure Source Location(s)
 1. From the Source panel on the left, select the source locations containing documents you want to search:

 a. Click on a source item. A [Project Name] Project Settings dialog will appear, showing advanced configuration set-
tings for the selected source location. See example to follow.

 b. Configure settings, as required.

 2. Example - search Local or Network Folders:
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Set Search Options
Click the Options  button on the search bar,  select the desired Content Filters to minimize false-positive search results.

Note: Default search Options are: Use Pre-Indexed documents = off / unchecked, Content Filters = 
None. Your preferred search and indexing options can be changed 'on program start-up' or during 'new wizard  tasks' to use this 
default or to remember your last used settings.

 Tip: For better search performance, click to check the Use pre-indexed documents. This will use the last indexed document con-
tent and therefore will not refresh content with latest updates.   Use this filter if it is known that the source documents are changed 
infrequently or have not changed since the last Find it EZ project indexing.

Boolean with Wildcards Search Expressions
Search expressions syntax is boolean with wildcards. This allows you to search for field {A} OR {B}  , {{A} AND {B}} OR {C}, etc. Note 
that curly brackets are delimiters for words and strings between boolean operators. The wildcard character is an asterisk ( * ). For 
example, if you search for "User*," the system will only find matches on items that start with the text "User."

Because of the way the search expression engine is setup, there are a few limitations:

 • Wildcard is "stopped" on a white space boundary (i.e. If the text in the document is "UserName likes seafood"  and you use 
the search expression string "User*food"  it will not find a match on this set of words separated by spaces. However search-
ing for "{User*} AND {*food}" will match on the first word and third word on in the same document. If it was "User-
Name.likes_seafood" then "User*food" will match on the single concatenated word ( individual terms joined by special 
characters to form a single word ).

Exact Match Filter
When the Exact Match setting is turned on in Content Filters, the result must be found between a white space boundary (these 
include spaces, tabs, periods, special characters and line feeds for strings). This is normally used to find a single, exact word match. 

Note: Exact match is case insensitive.
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Use Pre-Indexed Documents
This filter is located on the Options  buton menu; in the Boost Performance section. Click to check the check-box to apply 
this filter.

For better search performance, this filter will use the last indexed document content and therefore will not refresh content with latest 
updates.   This is not an issue if it is known that the source documents are changed infrequently or have not changed since the last 
Find it EZ project indexing.

Enter Target Keyword(s)
On the search bar (see image below), enter the desired search text into the Find text box.

Example:

Start Your Search
 1. To initiate the search, click on the  Search  button. A Searching window will appear, showing the status of the search.

 2. Once complete, the Search Complete dialog box will appear, as in the example below:

 3. Click on the  Show Results  button. A list of results matching your search criteria will appear in the Results frame.
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Note: After performing a search, settings can be saved to a Project for later use again.

View Search History
Search history can be viewed from the search bar. To view search history:

 1. Click on the down arrow button located on the right of the Find field. A drop-down list of previous search expressions will 
appear.

Note: This history is limited to 26 items and is preserved between program sessions. New search terms are added 'top 
down.' When the list exceeds 26 items, the bottom item drops off.

 2. Click to select the desired search expression.

See Also: 
 • "Local or Network Folders" on page 76

 • "Repositories" on page 87

 • "Databases" on page 94

 • "Programs" on page 108
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 • "Documents" on page 112

 • "BI Reports" on page 105

 • "Wizards Overview" on page 117

 • "Projects" on page 70

 • "Set User Options" on page 51

 • "Use the Expression Builder" on the next page

 • "Work With Search Results" on page 190

 • "Clear Expressions History" on page 63

 • "View Search Result History" on page 190
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Use the Expression Builder
This section provides instructions to perform a search using the Boolean Search Builder, building a search query, reviewing 
example Boolean expressions, and creating a valid Boolean expression using Find it EZ custom Boolean syntax.

Open Boolean Search Builder
To launch the Boolean Search Builder, click on the  Expression Builder  button located on the right side of the search bar. See 
below:

Build Search Query
 1. Click on the  Expression Builder  button to launch the Boolean Search Builder. A blank search query item is added.

 2. To apply NOT to the current search query, click to check the corresponding NOT check-box.

 3. Select the required number of curly brackets from the left curly bracket drop-down list.

 4. Enter the desired search text into the Search Text text box.

 5. Select the required number of curly brackets from the right curly bracket drop-down list.

 6. Select the desired Boolean operator (AND or OR) from the Operator drop-down list.

Find it EZ Custom Boolean Syntax
Find it EZ uses custom syntax so that items are recognized as Boolean operators rather than search text.

For example, to have the Boolean operator "AND" be recognized, you must enclose the search terms in curly brackets, e.g. {this} 
AND {that}. The use of curly brackets is special syntax to our software.  The Boolean Search Builder wizard helps with this for build-
ing / managing complex expressions, especially for first time users.
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Example Boolean Expressions
For Search Syntax Examples including Boolean and Wildcard, visit: https://www.finditez.com/support/#syntax.

Add New Search Query Item
To add a new search query item, click on the  Add Item  button. A new, blank search query item line will be added.

Remove Search Query Item
 1. To remove a search query item, click on the right arrow button preceding the row to select the item.

Note: You must click on the right arrow, and delete individual rows, one at a time.

https://www.finditez.com/support/#syntax
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 2. Click on the  Remove Item  button. The selected item will be removed from the search query.

Paste Search Query Item From Clipboard
To copy a search query item to the clipboard:

 1. Locate the desired search h query item text within any file or window on your system.

 2. Highlight the desired text.

 3. Press the  Ctrl  +  C  keys on your keyboard. The selected text will be copied to the clipboard.

To paste the copied search query item into a search query:

 1. Click on the  Paste from clipboard  button. A search query item line will be created for each instance of search text and the 
correct curly brackets and operators will be applied. See example below:

Example:
Copied search query item: {insert} and {{into} AND {{Order} OR {Customer}}}
Resulting search query in Boolean Search Builder:
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Import Search Query Values From File
 1. Click on the  Import list from file  button. An Open dialog box will appear.

 2. Navigate to and select the file containing the list of line separated values to use in the query.

Note: Accepted file types include *.txt and *.csv.

 3. Click on the  Open  button. A search query item line will be created for each instance of search text.

 4. Apply NOT, curly brackets to control order of expression evaluation, and operators (AND / OR) as required.
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View Search Query Details
As you are building your search query using the Boolean Search Builder, note that the entire search expression is shown in the 
Search Query box at the bottom of the dialog box.

Apply Boolean Expression to Search
 1. To apply the Boolean expression to your search, click on the  OK  button. The search query will be entered into the Find text 

box located on the search bar.

 2. To launch the search, click on the  Search  button.
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Searching Window
During a search, the Searching ... status dialog appears. See example below:

Refer to the table below for a description of each data element:

Searching 
Data Ele-
ment

Description

Search 
Terms

This is the search expression entered into the Find text box located on the Search Bar.

Search 
Options

This is a summary of the current Search Type and Content Filters settings on the Options panel.

Indexed This shows a visual progress display and current count of the total number of documents indexed vs the total num-
ber of documents available in the selected sources on the Source panel.

Scanned This shows a visual progress display and current count of the total number of indexed documents (above) that 
have been scanned for the current search criteria (i.e. Search Terms).

Matches This is the total number of instances where the current search expression has been found in the source doc-
uments.

Errors / 
Warnings

This is the total number of errors or warnings that have been generated while connecting and/or scanning the 
source documents for search criteria matches. Once the search is complete, these can be viewed in the Results 
window by clicking on the Errors tab (click on an error row to view details).

Duration This is the elapsed time used to index and scan the selected source documents 

Status 
Table

This is the current Source, (Document) Type or Processing Status, and Document (Name) being scanned 
for matches.
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Multitask While Searching
Once a search is launched, you can continue working on other programs while Find it EZ runs unattended in the back-ground.   While 
a search is running, you can not minimize the Find it EZ program or use any other window in Find it EZ as the search dialog box keeps 
focus until completed or cancelled.  However, Find it EZ will go to the background on your desktop if you launch another program 
(e.g. Word, a browser, Visual Studio, etc.).

Hide or Show Searching Details
While a search is taking place, you can view or hide search details. See examples below:

Click on the + Show Details link to expand the table showing Source, (Document) Type or Processing Status, and Document 
(Name). See example below:

To hide details, click on the - Hide Details link.

Show Search Results
Once a search is complete, the progress bars will stop advancing and a "Search Complete" notification will appear (see example 
below).

To view results, click on the  Show Results  button.
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The results will appear listed in the Results window. See example below:

Stop Searching
To cancel a search in progress, click on the  Stop  button. A notification will appear at the bottom of the dialog. See example below:
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View Search Errors
If a search is complete and the error count is > 0, you can view error details as follows:

 1. Note the error count on the Search Completed with Errors dialog. See example below:

 2. Click on the  Show Results  button.

 3. In the Results window, click on the Errors tab.

 4. Locate the error for which you want to view details and double-click on the row. Or, right-click and select  View Error  from 
the context menu. An error details dialog will appear. See example below:
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 5. Review details of the error.

 6. To check your project settings, click on the  Check Settings  button.

 7. To report a bug, click on the  Report A Bug  button.

 8. To close the error details dialog, click on the  Close  button.

See Also:
 • "Work With Search Results" on the next page

 • "File Locations and Source Settings" on page 74

 • "Find it EZ Support" on page 340
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Work With Search Results
This section describes the procedures required to view search results, statistics, and errors; to search within documents, to view 
search result details; and to save, open, copy, modify, export, and print search results.

View Search Results
 1. Perform a search.

 2. Results matching your search criteria will be shown in the Results window. Use the horizontal scroll bar located below the 
window to view all result data columns.

See Also:
 •  "Wizards Overview" on page 117

 • "Perform a Regular Search" on page 174

 

 

 

View Search Result History
After running several consecutive searches, to view previous (unsaved) search results prior to closing the program:
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Note: In order for the Search Result History field to appear, you must have completed more than one search since the last 
time you opened the Find it EZ program. This list of historical results is unlimited, but is automatically cleared when you exit the pro-
gram.

 1. At the top of the Results window, click on the Search Result History field. A drop-down list will appear, showing a list of 
unsaved search result records tagged by date and time.

 2. Locate and click on the desired search result record. The corresponding search results will appear in the Results window 
and will include any annotations or items marked complete.

View Result Source

Open Result
 1. To open the details of a matching search result with either the built-in code viewer or selected default file type editor:

 a. In the Results window, locate and double-click on the result for which you want to open the source.
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OR

 b. Right-click on the result and select  Open Result  from the context menu.

 2. The result will open in the preselected viewer / editor depending upon the file type.

See Also: 
 • "Viewer / Editor Settings" on page 57

Find it EZ Result Viewer
The Find it EZ Result Viewer allows you to view the source code for a search result document. This section describes the steps 
required to open the viewer, change a location or group, navigate search results, find a file, and view or edit the source code in 
another program.

Open Find it EZ Result Viewer

If " Find it EZ Viewer" is selected for the Opens withprogram in "Viewer / Editor Settings" on page 57, then when you "View 
Result Source" on the previous page, it will appear in the built-in Find it EZ Viewer (see examples to follow). Text matching your 
search criteria (i.e. matches) is highlighted in yellow within the Find it EZ viewers.

Note:  The built-in  Find it EZviewer is the default "Opens with" app for all file types.  Contents in the viewer are searchable and 
match the Details panel contents in the main Find it EZ dialog. There are three different built-in viewers:

 1. Text viewer - for all source code files, displays highlighted matches content.

 2. Data viewer - for database table data, displays a grid with data in cells ( columns and rows ). Column headings are the 
database table fieldnames.
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 3. Spreadsheet viewer - for Excel documents, displays a grid with cell data, and includes display of cell formula contents. 
Column headings and row numbers are like Excel ( A, B, C ... ) and ( 1, 2, 3 ... ) respectively.

Navigate Search Results

To navigate through the matches found in your document, click on the First, Next, Previous, or  Last  buttons located at the top left 
of the viewer. Note that a counter to the right of the buttons keeps track of which match you are viewing; e.g. "Match 7 of 9."
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Find in File

To search within the result document:

 1. Enter the desired search text into the Find in File text box.

 2. Click on the left arrow (find previous) or right arrow (find next) button. OR, press the  Enter  key on your keyboard to 'find 
next.'

 3. Items matching your search criteria will be highlighted in blue. Click on the right arrow button or press Enter to navigate 
through the matches found.

Documents with Multiple Tabs

The Find it EZResult Viewer for some documents will contain multiple tabs.  For an Excel workbook, there is one tab per worksheet 
(e.g. Sheet 1) plus a tab for workbook details (Workbook Info; including database connections, etc.).   For other documents, you 
normally only have a single tab with highlighted code.   For SAP Dashboards, this will contain a minimum of 3 tabs:   Code viewer (Dash-
board code definition) + Excel worksheet + Excel workbook info (connection / author). See example below.

Search, Results, and Details panel:
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To open the Find it EZResult Viewer, right-click on the workbook in the Details panel and select  Open  from the context menu. Or, 
double-click on the workbook.

Result Viewer Tabs:

Workbook Info tab:
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See Also:
 • "Viewer / Editor Settings" on page 57

 • "View Search Result Details" on page 205

Select All Results or None
 1. In the header of the check-box column, click on the down arrow button. A context menu will appear. See below:
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 2. To select all results:

 • From the menu, choose  Select -> All . All results will be selected (checked).

 3. To deselect all results:

 • From the menu, choose  Select -> None . All check-boxes will be cleared.
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Search for All Selected Objects
 1. In the check-box column, click to select (check) the result objects for which you want to search your project for references.

 2. In the header of the check-box column, click on the down arrow button. A context menu will appear.
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 3. From the menu, select  Search for all selected Documents . A Continue notification message will appear.

 4. To launch the search, click on the  OK  button. The search will proceed, and any results will appear in the Results window.

OR

 5. To cancel, click on the  Cancel  button.

Open Viewer and Editor Settings
To access project settings from the Results window:
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 1. In the Results window, right-click on any result. A context menu will appear.

 2. From the menu, click to select  Settings . The Associate File Types dialog will appear.

 

See Also:
 • "Viewer / Editor Settings" on page 57

Search Within Result Documents
There are times when an initial search expression will yield results with false-positive matches; or, within which a secondary search 
for additional terms will pinpoint what you are looking for.  To search within only a subset of search result documents:



Search Within Result Documents

© 2010 - 2019 Find it EZ Software Corp. 201

 1. At the top of the Results window, click to check the Search within Documents check-box.

 2. On the search bar, enter the desired search text into the Find text box.

 3. Click on the  Search  button to initiate the search. A Searching dialog box will appear, showing the status of the search.

 4. Once complete, the Search Complete dialog box will appear.
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 5. Click on the  Show Results  button. A list of results matching your search criteria will appear in the Results frame.

View Result Statistics
In the Results window, click on the Statistics tab. Use the horizontal scroll bar located at the bottom of the window to view all data 
columns; Location, Type, Documents, Matches.

View Result Errors
In the Results window, click on the Errors tab. Use the horizontal scroll bar located at the bottom of the window to view all data 
columns; Location, Type, Host, File Path or Database, Document.

Click on an individual error item for more details.  These errors and warnings often provide instructions to resolve the issues logged.

Add an Errant File to the Project Exclusion List
Note: This option is available only for results sourced from Local or Network Folders.
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Purpose: If one or more files come up in the Results window Errors tab list, and (for example) the file is corrupt, can't be opened, or 
is on the Results list and you know you don't want to include this particular file in future search passes for this project's Local or Net-
work Folders files, you can use this option to add it to the project file exclusion list quickly and easily, as follows:

 1. On the Errors tab list, locate the file that you want to add to the current project's search exclusion list.

 2. Right-click on the file. A context menu will appear.

 3. From the menu, select  Add File to Project Exclusion List . The selected file will be added to the Exclude File(s) / Folder
(s) list in Project Settings Mask Filters tab for Local or Network Folders.
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 4. Any subsequent search or documentation process will exclude this errand / corrupt file.    

See Also:
 • "Add File(s) to Project Search Exclusion List" on page 227
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View Search Result Details
 1. In the Results window, click on the result for which you want to view details. See example below:

 • Details will appear in the Details window located below the Results window (as above).

 • Matches are highlighted in each line where they appear, and lines are numbered.

 • To view only those lines with a match, click to check the Show matches only check-box. See below. 

Note that the line numbers are hidden when this option is checked.

 • To search Details, enter your search text into the text box and click on the First, Next, Previous, Last, or arrow buttons.

 • To open the Find it EZ Result Viewer, right-click inside the Details panel and select  Open  from the context menu. You can 
also  Select All  and  Copy  using the same method.
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 • The Show matches only option is auto-synchronized to the Automatically expand details user option (see link below). 
When turned on, you will see the full context of the searched document with line numbers. When turned off, only lines with 
matches will appear (without line numbers).

Note:  The Show matches only option is auto-synchronized to the automatically expand details user option (see link 
below). When turned on, you will see the full context of the searched document with line numbers. When turned off, only 
lines with matches will appear (without line numbers).

Copy Detail Item to Clipboard
 1. Locate  the matching instance line that you want to copy to the clipboard.

 2. Right-click on the selected line. A context menu will appear.

 3. From the menu, select  Copy . The selected line will be copied to the clipboard.

 4. Paste the copied text to the desired target location which can be another program or external editor.
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Copy Search Results Document Names
This section describes the steps required to copy a search results match document name to the clipboard, add an document name to 
the Boolean search term, or replace the Boolean search term with a selected result document name.

Copy Document Name to Clipboard
 1. In the Results list, locate the file (line match) you want to copy the corresponding document name from.

 2. Right-click on the file (line match). A context menu will appear.

 3. From the menu, select Copy Object Name. The name of the selected file (line match) will be added to the clipboard. 

Add Object Name to Boolean Search Term
 1. In the Results list, locate the file (line match) you want to add the corresponding document name as an additional search 

term in your existing Find expression.

 2. Right-click on the file. A context menu will appear.
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 3. From the menu, select  Add to Boolean Term (OR)  OR  Add to Boolean Term (AND) , as desired. The name of the selected 
file object will be appended to any existing search term in the Find text box (on the search bar) with the selected boolean 
expression AND / OR operand. See example below:

Replace Boolean Search Term
 1. In the Results list, locate the file (line match) with the corresponding document name you want to use as the next Boolean 

search term. For example, if you now want to search for all references to the selected document name in your next search.

 2. Right-click on the file. A context menu will appear.
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 3. From the menu, select  Replace Search Term  .The name of the selected line match document name will replace any existing 
search term in the Find text box (on the search bar). See example below:

 4. Click the Search button on the search bar to find all references to that document name within your active project.

Modify Search Results
This section provides step-by-step instructions to mark search result items complete or incomplete, add or edit result annotations, 
remove an item(s) from search results, and to add a file to a project's search exclusion list. You may want to break up a list into smaller 
sub-lists for redistribution, or remove false-positive matches, etc.

Mark Item(s) Complete or Incomplete
 1. In the Results window, locate the result you want to mark complete or incomplete.

 2. Right-click on the result row. A context menu will appear.
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 3. Click to select Mark Completed or Mark Incomplete, as desired.

 • If marked complete, a green check-mark will appear preceding the result. 

 • If a completed result is then marked incomplete, the green check-mark will be removed.
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Mark All  Complete or Incomplete
 1. In the check-box column, click to select the results you want to mark complete or incomplete.

 2. In the header of the check-box column, click on the down arrow button. A context menu will appear.

 3. To mark the selected results complete, select Mark all checked as completed from the menu. A green check mark will 
appear preceding each selected result.

OR

 4. To mark the selected results incomplete, select Mark all checked as incomplete from the menu. Green check marks will 
be removed preceding each selected result.

Note: If any search results have been marked complete and you attempt the exit/close the program without first saving 
your results, you will be prompted to save your search results, continue without saving, or keep the program open.
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Select All Items Marked Completed
To locate and select all results that have been marked completed:

 1. In the header of the check-box column, click on the down arrow button. A context menu will appear.

 2. From the menu, choose  Select -> items marked completed . All results previously marked completed will be selected 
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(checked).

See Also: 
 • "Select All Results or None" on page 196

Add or Edit Annotations
This section outlines the procedures required to add, view, edit, or delete an annotation or to locate and select all items with annota-
tions. Annotations are task assignment or instructions to others or reminders to self for action required on a given search result item.  
These annotations can then be exported directly to MS Project or distributed via search result lists as a column of information that is 
included.

Add Annotation
 1. In the Results window, locate the result to which you want to add an annotation.

 2. Right-click on the result row. A context menu will appear.
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 3. From the menu, select  Annotations . An Add/Edit Annotations dialog will appear.
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 4. Click on the  Add New  button. A new entry will be added, including the current date, time (in the Date field), and username 
(in the Entered by field).
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 5. In the Comments text box, enter the desired annotation.

 6. Click on the  Save  button to save your note and close the Add/Edit Annotations dialog. A clipboard icon will appear in the 
Results window preceding each result with an annotation. See example below:

Note: If any search results have annotations and you attempt the exit/close the program without first saving your results, 
you will be prompted to save your search results, continue without saving, or keep the program open.

 7. To discard any changes, click on the  Cancel  button.
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View Annotations
 1. In the Results window, locate the result for which you want to view annotations.

Note: Results with annotations are preceded by a clipboard icon.

 2. Right-click on the result row. A context menu will appear.

 3. From the menu, select  Annotations . An Add/Edit Annotations dialog will appear. Details for the most recent annotation 
will be shown by default in the lower section of the dialog. To view another annotation, click to select the desired row (e.g. by 
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Date or Entered by) from the list in the upper section. See example below:
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Edit Annotation
 1. For the selected annotation, make the desired changes in the Comments text box.

 2. Click on the  Save  button to save. A new, dated entry will be generated to include the changes. See example below:
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 3. To discard your changes, click on the  Cancel  button.
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Delete Annotation
 1. In the list of annotations, click to select the entry you want to delete.

 2. Click on the  Delete  button. The selected annotation will be removed from the list. See below:
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 3. To close the Add/Edit Annotations dialog, click on the  X  button.
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Select All Items with Annotations
 1. In the header of the check-box column, click on the down arrow button. A context menu will appear.

 2. From the menu, choose  Select -> items with annotations . All results with annotations will be selected (checked).

Remove Item from Search Results
 1. In the Results window, locate the result you want to remove from the list.

 2. Right-click on the result row. A context menu will appear.



Remove Item from Search Results

224 © 1998 - 2019 Find it EZ Software Corp.

 3. From the menu, select  Remove . An Are you sure? confirmation message will appear.

Tip: To prevent this dialog from appearing the next time you remove a result, click to check the Do not ask again 
check-box.

 4. To remove the selected item from the search results, click on the  Yes  button. See example below:



Remove All Checked Results

© 2010 - 2019 Find it EZ Software Corp. 225

OR

 5. To cancel, click on the  No  button.

Alert: If you inadvertently delete an item, you can recover by using the “search results history” drop down box to return to 
the full search list.  However, this will reset and roll back all changes since the search was run/loaded.

Remove All Checked Results
 1. In the check-box column, click to select (check) the results you want to remove.

 2. In the header of the check-box column, click on the down arrow button. A context menu will appear.
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 3. From the menu, select  Remove all checked . An Are you sure? confirmation message will appear.

Tip: To prevent this dialog from appearing the next time you remove a result, click to check the Do not ask again 
check-box.

 4. To remove the selected items from the search results, click on the  Yes  button. See example below:

OR

 5. To cancel, click on the  No  button.
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Alert:  If you inadvertently delete an item, you can recover by using the “search results history” drop-down box to return 
to the full search list.  However, this will reset and roll back all changes since the search was run / loaded.

Add File(s) to Project Search Exclusion List

Add a Single File to the Project Exclusion List

Note: This option is available only for results sourced from Local or Network Folders.

Purpose: If one or more files come up in the SearchResults  tab list, and (for example) the file  can't be opened, or is on the Results 
list and you know you don't want to include this particular file in future search passes for this project, you can use this option to add it to 
the project file exclusion list quickly and easily, as follows:

 1. In the Results list, locate the file that you want to add to the current project's search exclusion list.

 2. Right-click on the file. A context menu will appear.

 3. From the menu, select Add file to project exclusion list. The selected file will be added to 
the Exclude File(s) / Folder(s) list in Project Settings Mask Filters tab for Local or Network Folders.

 4. A view request notification will appear, as below:
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 5. To view the current exclusion list, click on the  Yes  button. To cancel, click on the  No  button. See example below:

Add Multiple Files to Project Exclusion List
 1. In the Results list, locate the files that you want to add to the current project's search exclusion list.

 2. In the check-box column, click to select (check) the desired results.

 3. In the header of the check-box column, click on the down arrow button. A context menu will appear.
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 4. From the menu, select  Add selected files to project exclusion list . The 
selected files will be added to the Exclude File(s) / Folder(s) list in Project Settings Mask Filters tab for Local 
or Network Folders.

 5. A view request notification will appear, as below:

 6. To view the current exclusion list, click on the  Yes  button (see example below). To cancel, click on the  No  button.
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See Also:
 • "Add an Errant File to the Project Exclusion List" on page 202

 • "Save Search Results" on page 35

 • "Export Search Results" on page 37

 •  
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Example Workflow Scenarios
This section provides a number of example scenarios, procedures, and resulting screen shots for searching and reporting in source 
file locations, databases, and accessing reporting tools.

Source File Locations
Examples provided in this section include searching local or network folders, searching a GitHub repository, and searching a Team 
Foundation Server (TFS) repository.

Search Local or Network Folders
 1. From the Source frame on the left, locate the File Locations category.

 2. Click to check the Local or Network Folders source. The Project Settings dialog will appear.

 3. Configure settings.

 4. From the Source frame on the left, click to check one or more supported file type(s). For example, select a file type from the 
Documents category.
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 5. Configure settings. See example below:

 6. From the Options frame on the right,  select the desired Content Filters.

Note: Default search Options are: Search Type = Boolean with Wildcards Expressions,  Content Filters = None. 
Search options can be set 'on program start-up' or changed during 'new project or wizard task' creation  to either use the 
program defaults or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents in Content Filters. This will use the 
last indexed document content and therefore will not refresh content with latest updates.   Use this filter if it is known that 
the source documents are changed infrequently or have not changed since the last Find it EZ project indexing.

 7. On the search bar (see image below), enter the desired search text into the Find text box.
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 8. Click on the  Search  button to initiate the search. A Searching dialog box will appear, showing the status of the search.

 9. Once complete, the Search Complete dialog box will appear.
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 10. Click on the  Show Results  button. A list of results matching your search criteria will appear in the Results frame.

Note: After performing a search, settings can be saved to a Project for later use again.
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 11. To view details for a result, click on a row in the Results window. Details will appear in the Details window.

 12. To view the source file, right-click on a detail line and select  Open  from the context menu. See example below:

Search a Git / GitHub Repository
 1. From the Source frame on the left, locate the File Locations category.

 2. Click to check the Git / GitHub source. The Project Settings dialog will appear (example to follow).

 3. Configure settings. See example below:
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 4. From the Source frame on the left, click to check one or more supported file type(s). In the example below, C Style 
(C,C++,C#) has been selected from the Programs category.

 5. Configure settings. See example below:

 6. From the Options frame on the right, select the desired Content Filters.

Note: Default search Options are: Search Type = Boolean with Wildcards Expressions,  Content Filters = None. 
Search options can be set 'on program start-up' or changed during 'new project or wizard task' creation  to either use the 
program defaults or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents in Content Filters. This will use the 
last indexed document content and therefore will not refresh content with latest updates.   Use this filter if it is known that 
the source documents are changed infrequently or have not changed since the last Find it EZ project indexing.

 7. On the search bar (see image below), enter the desired search text into the Find text box.
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 8. Click on the  Search  button to initiate the search. A Searching dialog box will appear, showing the status of the search. See 
example below:

 9. Once complete, the Search Complete dialog box will appear.
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 10. Click on the  Show Results  button. A list of results matching your search criteria will appear in the Results frame. See 
example below:

Note: After performing a search, settings can be saved to a Project for later use again.

 11. To view details for a result, click on a row in the Results window. Details will appear in the Details window (as above).

 12. To view the source file, right-click on a detail line and select  Open  from the context menu. See example below:
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Search a Team Foundation Server (TFS) Repository
 1. From the Source frame on the left, locate the File Locations category.

 2. Click to check the Team Foundation Server source. The Project Settings dialog will appear.

 3. Configure settings.  See example below:

 4. From the Source frame on the left, click to check one or more supported file type(s). In the example below, C Style 
(C,C++,C#) has been selected from the Programs category.
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 5. Configure settings. See example below:

 6. From the Options frame on the right, select the desired Content Filters.

Note: Default search Options are: Search Type = Boolean with Wildcards Expressions,  Content Filters = None. 
Search options can be set 'on program start-up' or changed during 'new project or wizard task' creation  to either use the 
program defaults or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents in Content Filters. This will use the 
last indexed document content and therefore will not refresh content with latest updates.   Use this filter if it is known that 
the source documents are changed infrequently or have not changed since the last Find it EZ project indexing.

 7. On the search bar (see image below), enter the desired search text into the Find text box.
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 8. Click on the  Search  button to initiate the search. A Searching dialog box will appear, showing the status of the search. See 
example below:

 9. Once complete, the Search Complete dialog box will appear.
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 10. Click on the  Show Results  button. A list of results matching your search criteria will appear in the Results frame. See 
example below:

Note: After performing a search, settings can be saved to a Project for later use again.

 11. To view details for a result, click on a row in the Results window. Details will appear in the Details window (as above).

 12. To view the source file, right-click on a detail line and select  Open  from the context menu. See example below:
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See Also:
 • "Search Wizard" on page 122

 • "Local or Network Folders" on page 76

 • "Configure Source Location(s)" on page 175

 • "Local or Network Folders" on page 76

 • "Repositories" on page 87

 • "File Type" on page 105

Database Examples

Search an Oracle Database
 1. From the Source frame on the left, click to check  Oracle  in the Databases category.

 2. Configure settings. See example below:
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 3. Click the Options  button on the search bar, choose the desired Optimization and Content Filters.

Note: Default search Options are: Optimization = DO NOT use pre-indexed documents (unchecked), Content Fil-
ters = None. Search options can be set 'on program start-up' or changed during 'new project' or 'new wizard task' con-
figuration  to use this default or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents. This will use the last indexed doc-
ument content and therefore will not refresh content with latest updates.   Use this filter if it is known that the source doc-
uments are changed infrequently or have not changed since the last Find it EZ project indexing.

 4. On the search bar (see image below), enter the desired search text into the Find text box.
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 5. Click on the  Search  button to initiate the search. A Searching dialog box will appear, showing the status of the search. See 
example below:

 6. Once complete, the Search Complete dialog box will appear.
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 7. Click on the  Show Results  button. A list of results matching your search criteria will appear in the Results frame. See 
example below:

Note: After performing a search, settings can be saved to a Project for later use again.

 8. To view details for a result, click on a row in the Results window. Details will appear in the Details window. See example 
above.

 9. To view the source file, right-click on a detail line and select  Open  from the context menu. See example below:
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Search a SQL Server Database
 1. From the Source frame on the left, click to check  SQL Server  in the Databases category.

 2. Configure settings. See example below:

 3. Click the Options  button on the search bar, choose the desired Optimization and Content Filters.
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Note: Default search Options are: Optimization = DO NOT use pre-indexed documents (unchecked), Content Fil-
ters = None. Search options can be set 'on program start-up' or changed during 'new project' or 'new wizard task' con-
figuration  to use this default or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents. This will use the last indexed doc-
ument content and therefore will not refresh content with latest updates.   Use this filter if it is known that the source doc-
uments are changed infrequently or have not changed since the last Find it EZ project indexing.

 4. On the search bar (see image below), enter the desired search text into the Find text box.

 5. Click on the  Search  button to initiate the search. A Searching dialog box will appear, showing the status of the search. See 
example below:
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 6. Once complete, the Search Complete dialog box will appear.

 7. Click on the  Show Results  button. A list of results matching your search criteria will appear in the Results frame. See 
example below:
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Note: After performing a search, settings can be saved to a Project for later use again.

 8. To view details for a result, click on a row in the Results window. Details will appear in the Details window. See example 
above.

 9. To view the source file, right-click on a detail line and select  Open  from the context menu. See example below:

See Also:
 • "Databases" on page 94

 • "Apply Database Item Filters" on page 100

 • "Test Database Connection" on page 97
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Reporting Tools
Examples in this section include creating a SQL statements detail extract and creating a database cross-reference list.

Create a Database Cross-Reference List
 1. Launch the Export Wizard for a Database Cross-Reference Extract:

 a. Using the main Wizard:

 i. At the top, left of the main window, in the search bar, click on the   Wizards  button. The Wizards dialog will 
appear.

 ii. Click to choose the Extract database objects (tables, stored pro-
cedures, views, etc.) used in my reports option. 

 b. Using the menu:

 i. From the Find it EZ menu, select  Document -> Business Intelligence -> Database Cross-Reference . 

The Database Cross-Reference Document Wizard will appear. See below:
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 2. Click on the  Next >>  button to continue.



Create a Database Cross-Reference List

© 2010 - 2019 Find it EZ Software Corp. 253

 3. Click to select the report file locations and optionally select the underlying source databases if you would like to include the 
SQL Select code from procedures, views or functions used by your reports.

 4. Click on the  Next >>  button to continue. Each of the selected source report location and underlying database configuration 
panels will appear as in the examples below.                 
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 5. Enter or confirm the pre-configured the file location and underlying database(s) connection information, click the check-
boxes to include desired report types and known database objects used by your reports.

 6. Click on the  Next >>  button to continue after each configuration panel is completed. Use the Test Connection button to con-
firm valid settings where applicable. After the last location is configured, the Export Confirmation dialog will appear.
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 7. Choose what columns you would like to export. The default is to include all columns available.

 8. Click on the  Export  button. Find it EZ will begin gathering the required data.

 9. Once complete, a Save As dialog will appear. See example below:
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 10. Save the report:

 a. Modify the File name as desired.

 b. Navigate to the desired folder location.

 c. Click on the  Save  button.

A Save Complete notification will appear, as below:

 11. To view the saved report, click on the  View Now  button. The file will open in the specified viewer / editor. See example 
below:

Report data will include the following:
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 • Location

 • Type

 • Host

 • File Path

 • Filename

 • Report Section

 • Data Source Type

 • Data Source Name

 • Database

 • Owner

 • Report Table

 • Call Statement

 • Table Links

 • SQL Command

 • SQL Expressions

 • Underlying Database Code - SQL SELECT statement content based on procedures, views or functions referenced 
when source database configuration included

Extract all embedded SQL queries from within my reports
 1. Launch the Export Wizard for an embedded report SQL Queries extract:

 a. Using the main Wizard:

 i. At the top, left of the main window, in the search bar, click on the  Wizards  button. The Wizards dialog will 
appear.
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 ii. Click to choose the Extract all SQL code used in my reports option.

 b. Using the menu:

 i. From the Find it EZ menu, select  Document -> Business Intelligence -> Show SQL Queries .
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The Show SQL Queries Document Wizard dialog will appear.

 2. Click on the  Next >>  button to continue.
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 3. Click to select all of the report file locations to include.

 4. Click on the  Next >>  button to continue. Each of the selected source report location configuration panels will appear as in 
the examples below.                 
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 5. Enter or confirm the pre-configured the file location and other connection information, click the check-boxes to include 
the desired  report types to extract embedded SQL queries from.

 6. Click on the  Next >>  button to continue after each configuration panel is completed. Use the Test Connection button to con-
firm valid settings where applicable. After the last location is configured, the Export Confirmation dialog will appear.
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 7. Enter the export options:    

 a. Select exported content file type.

 b. All data exported to a single file, or individual files created for each report?

 c. Optionally add a prefix to the file(s) created.  Can be useful for separating data from each wizard run stored in the 
same destination output folder.

 8. Click on the  Export  button. Find it EZ will begin gathering the required data.



Extract all embedded SQL queries from within my reports

266 © 1998 - 2019 Find it EZ Software Corp.

 9. Once complete, a Save As dialog will appear when the "single file" option was checked in step 7(b). See example below:

 10. Save the report:

 a. Modify the File name as desired.

 b. Navigate to the desired folder location.

 c. Click on the  Save  button.

A Save Complete notification will appear, as below:
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 11. Or once complete, if individual files are to be created, a Select Folder dialog will appear as below:

 12. Save the report:

 a. Navigate to the desired folder location.

 b. Click on the  Select Folder  button.

The file creation process will begin.

Note: Each generated file will use the same filename as the source document, along with the target selected file type 
extension. Sub-folders will be created based on the source file location. A Replace File confirmation alert dialog may 
appear if a duplicate filename in the target output path already exists, as below:

Chose the desired action to continue processing.
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 13. Upon completion, the target output folder will appear, displaying all generated files as below:    

See Also:
 • "Create or Select a Project" on page 124

 • "Search Wizard" on page 122

 • "Select File Location(s)" on page 124

 • "Add or Edit Search Path(s)" on page 78

 • "Local or Network Folders" on page 76

 • "Include Archive Files" on page 81

 • "Connection Information - Databases" on page 97

 • "Connection Information - Repositories" on page 89

 • "Choose Report Options and Export Report" on page 151

Migrating BOE Crystal Reports Example
The following example demonstrates how to upgrade a set of Crystal Reports between SAP BOE Server versions. The oldest Crys-
tal Server supported by the vendor supplied XI 3.1 connector is CRS 2008.  Adding support for versions earlier then that requires 
older SDKs no longer supported or available from SAP.

There is a simplified procedure.  Provided you do not need to convert and continue to use the reports within your existing Crystal XI 
(11) server, here is what you can do:
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 1. Start Find it EZ Dev Surge 365.  Change the "repository" within Find it EZ: 

 a. From the menu, select  Tools -> Customize -> Source .

 b. From the Software Platforms Used tab, enable the check-box for "Sap Business Objects 
& Crystal Server". See below:

 c. In the Business Objects Server Version drop down box that will appear in the right panel, select your older version of 
BOE XI or Crystal Server source edition. See below:

 d. Click on the  Apply button. This may force a program restart, this is normal.
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 2. If required, install a compatible SAP SDK runtime connector. The Find it EZ application will auto-detect whether or not a 

required connector is installed. If not, a yellow alert will appear in the Source panel to the left of the BI Platform selected 
above. See below for example:

 a. Right -click on the Business Intelligence source item to configure settings. A Project Settings dialog will appear as 
below:

 b. Click on the alert hyperlink in the upper right corner of the configuration window.

 c. - OR - from the main menu, select  Tools -> Connector Manager .
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 d. The Connector Manager dialog will appear as below:

 e. Select ( highlight ) the SAP BI Platform connector listed, then click on the  Help me decide button or hyperlink text. A 
web page will load in your default browser. Follow instructions to select the compatible version for your environment, 
then download and install the required connector. See "Download Connectors" on page 301 for more information.

 3. Use the backup wizard from the main navigation menu Backup -> SAP BOE / Crystal Reports Server to download the RPT 
files from your CR XI server, saving the files locally.  Select all Crystal Reports to be included in the upgrade during the 
backup process.

 4. Repeat steps 1(c) through 2(e) above if necessary to switch to and install your new target SAP BI platform server connector.

 5. Use the change datasource wizard to automatically change the datasource and upgrade the RPT files to Crystal Reports  
format based on the target SDK runtime you switched to use in step 4 above (by default, converted files are automatically 
upgraded to CR 2013 or newer format).  No need to open  and save each RPT file individually using Crystal Reports 
Designer.
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 a. From the menu, select  Replace -> Crystal Reports -> Data source connections or qualified table names .

 6. Use the normal SAP BI Report Upload Wizard to place all the converted RPT files into the new target BI Platform.
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 7. If necessary after upload, you can also use Find it EZ to set / reset login authentication on all uploaded RPT files within the 
new BI Platform repository.

 a. From the menu, select  Replace -> Crystal Reports -> BOE BI Database logon information .

See Also:
 • "Download Connectors" on page 301

 • "Configuration Wizard" on page 60

 • "Replace Wizards" on page 165

 • "Repositories" on page 87
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Troubleshooting and Tips
This section will provide solutions to some workstation, custom network, or programming environment issues.  Also included are 
some suggestions for frequently asked questions and common product use hints and tips.

Reduce False Positive Matches
Problem:

When dealing with a small number of documents, it is possible for a full-text-search engine to directly scan the contents of the doc-
uments with each query, a strategy called  'serial scanning.'  This is what some tools, such as grep, do when searching.

However, when the number of documents to search is potentially large, or the quantity of search queries to perform is substantial, 
the problem of full-text search is often divided into two tasks: indexing and searching.  All Find it EZ editions use this enhanced per-
formance and more scalable approach.

The indexing stage will scan the text of all the documents and build a list of search terms (often called an index, but more correctly 
named a concordance).  A concordance is an alphabetical list of the principal words used in a book or electronic document, listing 
every instance of each word with its context, including token type (e.g. comment, language keyword, etc.) and programming lan-
guage specific scope (e.g. report page section, etc.). In the search stage, when performing a specific query, only the index is ref-
erenced, rather than the text of the original documents.

The indexer will make an entry in the index for each term or word found in a document, and note its relative position within the doc-
ument.

Free text searching is likely to retrieve many documents that are not relevant to the intended search question. Such documents are 
called false positives.

Solution:

Within Find it EZ, false positive matches can be significantly reduced using the following methods:

Local or Network Folders:

 • "Add or Edit Search Path(s)" on page 78

Note: You can exclude sub-folders and / search specific individual or multiple paths.

 • "Include Archive Files" on page 81

Note:  Archive files are excluded by default; including them will extract and search the contents of all files within the 
archive (e.g. “zip”) file.

 • "Exclude Files or Folders" on page 81

 • "Local or Network Folders" on page 76

Repositories (Version Control Systems or Report Distribution Schedulers):

 • "Select Repository Folders" on page 91

Note:  You can limit the number and specific folder contents included.

 • "Apply Report Filter" on page 91

Databases:
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 • "Connection Information - Databases" on page 97

Note:  You can search a subset of database objects.

 • "Apply Database Item Filters" on page 100

Note:  You can include a filtered set of database items, selected by name (tables, views, stored procedures, triggers, 
etc.).

 • "Reset Search Defaults" on page 98

Reporting Utilities:

 • "BI Reports" on page 105

Note:  You can include specific report “(page) sections,” “(search in) areas,” and “search (elements)” unique to each 
report type. 

 • You can Use default settings (see link above) to reset the type of data searched to the most common code areas only by 
report type.

Documents:

 • "Microsoft Excel Search Options" on page 114

Programs:

 • "Add or Remove File Extensions Searched" on page 110

Note:  You can add or remove custom file extensions to be searched for text-based files.

See Also:

See Also:
 • "Search Within Result Documents" on page 200

 • "Set User Options" on page 51; note setting for “Limit the number of matches per object to” can be reduced from 
the  default of 1000.

 • "Perform a Regular Search" on page 174; note the settings available in the Options section - Content Filters cat-
egory.

 • "Use the Expression Builder" on page 180; for assistance building complex Boolean queries.

 

Identify reports using a specified connection
Problem:

You need to determine if there are Crystal Reports using a specific ODBC connection to an underlying data source.

Solution:

There are a couple of ways you can do this using Find it EZ.

Ensure that searching connection information is enabled in the Crystal Report settings:

 • In the Source Panel in one of the  Folders & Version Control or Business Intel-
ligence Platforms click to Include:  Crystal Reports source, as below:
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 • Open the Crystal Reports project settings: right-click on Crystal Reports in the Advanced Search 
Filters section of the Source panel on the left

 - OR - from the menu, select  Projects -> Settings -> Crystal Reports 
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 • In the Search section, click to check the Data Source and Connections option

Then,

 1. Good - Run a Boolean search for {ODBC} AND {DSN}; where DSN is your DSN. That should find all of the reports with that 
connection.

OR

 2. Best - Generate the "SQL Code Extract" Report which will list all of the connections used in your reports. You can then filter 
and sort the spreadsheet to those using ODBC and a certain connection.

Note: We cannot "follow the link" so to speak. Where a report is using an ODBC connection called PRODUCTION and that is 
pointing to dblive01, we will not be able to show you dblive01.

See Also:
 • "Perform a Regular Search" on page 174

 • "Reporting Tools" on page 251

Program freezes when attempting to index Crystal 
Reports on a local or network file system
Problem:

When attempting to index a number of Crystal Reports files, the search panel animated gears appear to freeze and the index 
counter stops incrementing after a long period of time has elapsed.

Solution:
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 1. From the menu, select  Tools -> Customize -> User Options .

 2. In the Performance section, click to check the Enable Crystal Report locked file pre-checks (Local or network 
folders only) option.

This allows the Crystal Reports scanner to detect locked files during indexing and, if a file is currently open or locked, to make a tem-
porary copy of the file before allowing Crystal Reports to open it. Note that this feature is disabled by default as it can affect per-
formance.

Note:  This feature is disabled by default as it can affect performance.  It is recommended that you disable this performance 
troubleshooting option once the documents are successfully indexed.

Use of 7-Zip has been denied by your Administrator
Problem:

While indexing a project, you receive  a Windows 10 message, which reads: Use of "7-Zip" has been denied by your Administrator...

Note: This message would be generated by security software and would appear in the lower right corner of the monitor, similar to 
other windows alerts.

This is a dependency / prerequisite built-in open source program that our application bundles and uses for processing the following 
document / source file types:
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 • Excel (xslx)

 • MS Word (docx)

 • SAP Dashboards ( aka Xcelsius )

As well as if you have "Include Archives" checked off under the Local File System location and you have one or more archives in your 
search folders.

Solution:

If a system administrator enforces a rule disallowing use of the 7-zip program, then either this restriction has to be removed by the sys 
admin OR the end-user unfortunately cannot search the above particular document types with Find it EZ.  

Note: You may even get this message when attempting to install Find it EZ while logged onto a computer without Administrative 
rights. You will still be able to install the program, but use of the features requiring 7-zip will record an error and may cause the pro-
gram to crash.

Find text in a text box in a Crystal Report
Searching of text field content is not enabled by default but can be enabled by doing the following:

 1. On the Source panel (on the left), right-click on "Crystal Reports" under the Advanced Search 
Filters section. This will bring up the Project Settings configuration dialog for Crystal Reports.
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Alternatively, you can get to this window from the menu as follows:  Projects -> Settings , then click on "Crystal 
Reports."

 2. Click to check the Text Field Content option.

 3. Click on the  Close  button.

 4. The next time a Crystal Reports document search is done it will include content within text boxes.
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List of VSS folders slow to load
Problem:

When configuring a Visual Source Safe in particular, retrieving a list of folders to search within a selected branch can take a long time 
to load.  This can also be the case with other source code version control systems.

Solution:

Rather then using a native connection to the version control system within Find it EZ project source settings, alternatively, you can 
recursively pull a copy of a branch using the native version control system client to save a temporary copy of all folders and files to your 
local workstation.  Then, configure searching the local copy of the documents using the "Local or Network Folders" path rather than a 
connection to the version control system source within your Find it EZ project.

This will eliminate the overhead and latency with use of the vendor connector API as well as any possible network bottlenecks when 
retrieving remote folders and documents.

Note:  The downside to this alternative is that you would have to ensure you refresh your local copy of files as needed. However, 
Find it EZ indexing / index refresh will be dramatically improved using this two step approach.
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Find it EZ Support
This section describes the many support options available with Find it EZ, how to  report a bug, or a request a feature to Find it EZ 
Software Corp.., and how to view or send your session log.

Support Options
Support Option Navigation

Contact Find it EZ Software Corp. https://www.finditez.com/support/#contact

Frequently Asked Questions https://www.finditez.com/support/#faq

Search Knowledge Base https://www.finditez.com/support/#kb

Syntax and Examples https://www.finditez.com/support/#syntax

Request a Demo https://www.finditez.com/support/#demo

Watch Instructional Videos https://www.finditez.com/resources/#by_video

View Session Log From the program menu, select  Tools -> View Session Log . The session log will 
open in Notepad. Each event line will start with the event date and time, followed 
by details.

Send Logs to Support From the program menu, select  Help -> Send Logs to Support 

Check for Updates From the program menu, select  Help -> Check for Updates .

https://www.finditez.com/support/#contact
https://www.finditez.com/support/#faq
https://www.finditez.com/support/#kb
https://www.finditez.com/support/#syntax
https://www.finditez.com/support/#demo
https://www.finditez.com/resources/#by_video
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My Find it EZ Account
This section describes how to register for and manage your Find it EZ account, access software downloads, managing serial num-
bers, quotes, orders, and creating or reviewing support tickets status.

My Account
The My Account tab on the member website allows you to manage your contact information, update alerts, subscriptions, and 
change your password. This section will describe how to register for and log in to manage your Find it EZ account.

Once registered, you can log in to the secure member area of Find it EZ, where you can change your password, download product 
updates, update your email subscriptions, retrieve product activation keys, view order history, process payments, check on the status 
of or submit new support tickets.

Register for a free Find it EZ member account:
Note:  You must use a valid corporate e-mail domain address. Free or blacklisted email domains (e.g. gmail, hotmail, etc.) are not 
accepted.  This includes your primary e-mail address associated with a social account ( LinkedIn, Twitter, Google Plus, or Face-
book.

There are three ways to register for a Find it EZ member account.

Option 1:

 1. Visit https://www.finditez.com/register.

 2. Fill in the New User Registration form.

https://www.finditez.com/register.aspx?Src=
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Note: Items with dots are required. The Are you Human? option must also be checked.

 3. Click on the  Register  button. A verification email will be sent to the provided email address.

 4. To complete your registration, click on the link in the email . The website will open and you will be logged in automatically.

Option 2:

 1. Register for a free trial following these steps:

 2. Visit https://www.finditez.com and click on any one of the trial download links or buttons.

https://www.finditez.com/


Register for a free Find it EZ member account:

© 2010 - 2019 Find it EZ Software Corp. 285

 3. Fill in the Start your tree trial form.

 4. Click on the  Download Trial Now  button. A separate welcome and trial key emails will be sent to the provided email address.

Option 3:  

Use one of your social media accounts to sign-in following these steps:

 1. Visit https://www.finditez.com/login.

 2. Click on any one of the available social account sign-in buttons located on the right. See below:

https://www.finditez.com/login.aspx
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 3. When prompted, accept the social account access. The secure member site will open with the My Account tab selected 
and a welcome email will be sent to your associated email address with a random password assigned.

Alert: We highly recommend that you change the temporary password as soon as possible.

Note:  New login accounts are automatically associated with and linked to a pre-existing company account based on matching cor-
porate email domain.  This provides instant shared access to internal support tickets and serial numbers for a given entity.

Log In to Your Find it EZ Member Account
There are two ways to log into the secure member area:

Option 1:

To log in to your Find it EZ member e-mail account, follow these steps:

 1. Visit  https://www.finditez.com/login.

 2. Enter your account Email Address and Password.

 3. Click on the  Log In  button. The secure member site will open with the My Account tab selected.

Option 2:

To sign-in with one of your social accounts linked to your email address, follow these steps:

 1. Visit https://www.finditez.com/login.

 2. Click on any one of the available social account sign-in buttons. See below:

 3. If prompted, accept the social account access. The secure member site will open with the My Account tab selected.

Update Account Details and Preferences
 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, make changes as desired.

https://www.finditez.com/login.aspx
https://www.finditez.com/login.aspx
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 3. Click on the  Update  button to save.

Change Account Password
 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, click on the  Change Password  button. A Change Password dialog box will appear.
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 3. In the Password and Confirm Password fields, enter and confirm the new password.

 4. Click on the  Update  button to save your changes.

 5. Click on the  X  button to close the Change Password dialog box.

Manage Linked User Accounts

Add New Account Contacts
To add additional end-users associated with your company, so that they may have direct access to download software updates, self-
serve license key management and support, simply follow the steps below:

Note:  Only the primary company account contact can make these changes.

 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, scroll down to locate the Linked User Administration section.

 3. In the User column, click on the Add more link. The Add New Contact dialog box will appear.
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 4. Enter information for the new contact.

Note: You must use a valid corporate email domain address. Free or blacklisted email domains (e.g. gmail, hotmail, etc.) 
are not accepted.

Note: Accounts payable contacts have access to view and remit secure online payment for orders and/or quotes, regard-
less of which company contact created the order.

 5. Click on the  Add  button to save. If a password was not entered, a temporary one will be sent to the new contact.

Alert: We highly recommend that the new contact logs in and changes his / her temporary password as soon as pos-
sible.

 6. To add another contact, click on the  Add Another  button and repeat steps 4 and 5 above. Or, click on the Cancel or  X  but-
ton to exit.

Change Prime Account Contact
Note:  Only the primary company account contact can make this change.  Once changed, all notifications, renewal alerts, etc. are 
sent to the new contact automatically.

 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, scroll down to locate the Linked User Administration section.
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 3. In the Prime Contact column, click to choose the new prime/admin contact.

 4. Click on the  Change Prime Contact  button to save your change. See example below:

Remove an Account Contact
If a staff member is no longer with your organization or department, you can remove access to your Find it EZ company licenses and 
product order information (applicable to accounts payable contacts only) as follows:

Note:  Only the primary company account contact can make these changes.

 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, scroll down to locate the Linked User Administration section.

 3. Locate the name of the contact you want to remove from your account.

 4. In the far right column, click on the corresponding Remove link. A confirmation message will appear.

 5. To remove the selected contact, click on the  Yes  button. The contact will be removed from the list.

 6. To cancel, click on the  No  button.
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Manage Company Address Records
Your company address records are automatically added and/or updated during the order check-out process.

In addition to being able to select, add, or update address records using our secure cart check-out process, any active contact may 
also add, update, or remove address records that are linked to the company profile. These changes are immediately reflected and 
available for subsequent online orders placed.

Add Company Address
 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, scroll down to locate the Address List section.

 3. In the Company Address column, click on the Add more link. The Address Information dialog box will appear, as 
below:



Add Company Address

292 © 1998 - 2019 Find it EZ Software Corp.

 4. Enter or select company location information.

Note: Items with a dot are required.

 5. Click on the  Save  button. The new address will be added to the list.
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Update Company Address
 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, scroll down to locate the Address List section.

 3. Locate the address you want to edit.

 4. In the far right column, click on the corresponding edit icon. The Address Information dialog box will appear.
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 5. Change company location information as desired.

Note: Items with a dot are required.

 6. Click on the  Save  button.

Remove Company Address
 1. Log in to your Find it EZ Member Account.

 2. On the My Account tab, scroll down to locate the Address List section.

 3. Locate the address you want to delete.

 4. In the far right column, click on the corresponding delete icon. A confirmation message will appear.

 5. To delete the selected company address, click on the  Yes  button. The address will be removed from the list. See below:

 6. To cancel, click on the  No  button.

Software Downloads
The Software Downloads tab on the member website allows you to download new releases and connectors and to view release 
notes and system requirements.

Download Release Version
From the Program:

 1. See "From the Find it EZ menu, select  Help -> Check for Updates ." on page 27

From the Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Software Downloads tab. A list of product releases and optional connectors will appear.
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 3. Locate the product and release version that you want to download.

 4. Download the product as follows:

 a. In the Version column, click on the product release number for the corresponding product row. The release setup file 
will begin to download.

OR

 b. In the Specs column, click on the download icon for the corresponding product row. The system requirements will be 
provided.  Click on the  Download Now  button and the corresponding release setup file will begin to download. See 
example below:

 5. Locate and launch the downloaded *.exe setup file from your target system. A Find it EZ InstallShield Wizard dialog box 
will appear.
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 6. Click on the  Next  button.

 7. Read and follow the installation instructions.

 8. When complete, click on the  Finish  button.

Note: The same product setup files are used for both trials as well as full release or upgrade installs.

See Also:
 • "Download Connectors" on page 301

 • "View Release Notes" below

 • "View System Requirements" on page 299

 • "Installation, Activation, and Updates" on page 3

View Release Notes
From the Program:
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 1. From the Find it EZ menu, select  Help -> View Release Notes . Release Notes will open in a new browser window showing 
the most recent information first.

 

 2. Scroll down to view historical notes.

 3. To close Release Notes, close the browser tab or window.

On the Public Website:
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 1. Visit https://www.finditez.com/products/#release.

 2. Click the +  (expand) button to view details for the desired product edition.

 3. View a summary of the latest release highlights, and click on the Full Release Notes link for more detail.

On the Member Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Software Downloads tab. A list of product releases and optional connectors will appear.

https://www.finditez.com/products/#release
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 3. Locate the product release for which you want to view release notes.

 4. In the Notes column, click on the corresponding note icon. A Release Notes dialog box will appear showing the most 
recent information first.

 5. Scroll down to view historical notes.

 6. To close the Release Notes dialog box, click on the  X  button.

View System Requirements
All editions of Find it EZ programs require a Microsoft Windows operating system that can run .net 4.5 or newer.   For detailed tech-
nical specifications, see https://msdn.microsoft.com/en-CA/library/8z6watww .  For individual edition requirements, see below.

On the Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Software Downloads tab. A list of product releases and optional connectors will appear.

https://msdn.microsoft.com/en-CA/library/8z6watww


Download .NET Framework

300 © 1998 - 2019 Find it EZ Software Corp.

 3. Locate the product release for which you want to view system requirements.

 4. In the Specs column, click on the corresponding download icon. A System Requirements dialog box will appear.

 5. To download the selected product release, click on the  Download Now  button.

 6. To close the System Requirements dialog box, click on the  X  button.

Download .NET Framework
Alert: The .NET framework connector is required. If you  do not have the required .NET 4.7.2 pre-installed, you will be prompted 
to download this prerequisite from Microsoft.  We provide an alert and link to the appropriate download page depending on the 
Windows operating system you are running.   The program will not launch until .NET 4.7.2 is installed.

On the Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Software Downloads tab. A list of product releases and optional connectors will appear.



Download Connectors

© 2010 - 2019 Find it EZ Software Corp. 301

 3. Locate the product release for which you want to download the .NET framework.

 4. In the .net column, click on the corresponding .NET version number. A Microsoft.NET Framework dialog box will appear.

 5. To download the selected version from the Find it EZ server, click on the  Download Now  button. OR

 6. To download the selected version directly from Microsoft, click on the directly from Microsoft link.

 7. To close the Microsoft.NET Framework dialog box, click on the Close or  X  button.

Download Connectors
Source items that require a connector will appear with a small warning icon preceding the name. See example below:

Note: Some connectors are required (e.g. '.net') but others are optional (depending on whether or not you want to search a par-
ticular document type that then needs a corresponding vendor supplied connector). After product install on first run configuration 
wizard for setting up your environment, if you select one or more source items that require connectors, the wizard will prompt you 
to auto-download and install them. If you do not do so, or later add a source item, you will note that it has a yellow alert triangle icon 
next to it in the left (Source) panel.  If you attempt to include such a source item in a project, you will be prompted to auto download 
and install the required connector. 
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Click on the source item / warning to download the associated connector.

If you try to initiate a search that includes a selected source lacking a required connector, an error message will be generated. See 
example below:

From the Program:

Note: Downloading and installing a connector will require local administrative rights on your system.

 1. From the Find it EZ menu, select  Tools -> Connector Manager  .

 

A Connector Manager dialog will appear.
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 2. Optionally select one of the Show drop down options to filter the list. For example, selecting the option Missing will dis-
play a list of required connectors that have not yet been installed based on the source items you have configured using the 
Configuration Wizard.    

Note: Items with a check-mark icon next to them indicate you have the minimum or newer connector version detec-
ted as already installed on your system.

 3. Click on any one of the items with an install icon  then click the  Install / Update  button. The connector will begin down-
loading.

 a. Once downloaded, a Find it EZInstallShield Wizard will appear.

 b. Click on the  Next  button.

 c. Read and follow the instructions provided.

 d. When complete, click on the  Finish  button.

 4. OR, click on any one of the items with a download compatible version icon , then click the  Help me decide  button or 
hyperlink for that item. This will launch your browser and open a page on the Find it EZ Software Corp. website to help you 
select the correct version of the connector based on other related software installed on your workstation. For example, click-
ing on the "IBM Data Server Driver Package" for the required DB2 connector will take you to this page, see below:    
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 5. Follow the instructions on the website page to select, then download and chose to either save or run the corresponding 
setup package depending on your browser and network security permissions. 

Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.

Tip: The Open Downloads Folder button will contain all downloaded Find it EZ setup packages within this default path: 
C:\ProgramData\Bits n Bytes Software Inc\Installers . To keep all related downloads organized for re-use, it is recom-
mended that you save these "version compatible" connector setup packages to this specific folder location as well.

On the Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Software Downloads tab. A list of product releases and optional connectors will appear.

 3. Locate the product release for which you want to download a connector.

 4. In the Optional Connectors section of the table, click on the corresponding hyperlink in the desired connector column. For 
all hyperlinks that do not contain the text Help me decide, a Connector Details dialog box will appear. See 
example below:
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 5. To download the selected version from the Find it EZ server, click on the  Download Now  button. OR,

 6. Where applicable, to download the selected version directly from Microsoft (i.e. Access) or directly from SAP (i.e. Crystal 
Reports), click on the directly from Microsoft or directly from SAP link, respectively. See example above.

 7. The connector will begin downloading.

 a. Once downloaded, a Find it EZ InstallShield Wizard will appear.

 b. Click on the  Next  button.

 c. Read and follow the instructions provided.

 d. When complete, click on the  Finish  button.

 8. To close the Connector Details dialog box, click on the Close or  X  button.

 9. OR, in the Optional Connectors section of the table, if you chose any connector with the hyperlink text Help me 
decide, a website page will display with instructions to guide you through selecting a compatible version depending on 
related software that may be installed on your workstation or network environment. See example below:    

 10. Follow the instructions on the web page to filter the recommended compatible version of the connector to be installed.
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 11. Once the recommended connector download link is displayed, click to download and chose to either save or run the cor-
responding setup package depending on your browser and network security permissions. 

Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.

See Also: 
 • "Check for Updates" on page 26

 • "Download Release Version" on page 294

 • "Download .NET Framework" on page 300

Serial Numbers
The Serial Numbers tab on the member website allows you to manage or transfer your current Find it EZ product license, obtain a 
new trial license, activate or manually activate a product, review software assurance plans and license type options.

Follow the steps below to view your current Find it EZ product serial numbers.

View or Transfer Current License
Alert:  You must have an active maintenance plan in order to request a license transfer.   License transfers require review and 
approval.  Reviews are completed within one business day, upon which you will receive a confirmation email either approving or 
declining the request.  Once transferred, the Find it EZ program must be uninstalled from the old workstation.

From the Program:
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 1. From the Find it EZ menu, select  Tools -> License Management -> Transfer to a new machine . A confirmation message will 
appear, as below:

 2. Click on the  OK  button to shut down Find it EZ on the current machine.  A request will be automatically sent to Find it EZ 
product support, and you will receive a confirmation email once the transfer request has been reviewed and processed 
within one business day.

 3. Open your e-mail and follow the instructions to transfer the license to a new machine.

On the Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Serial Numbers tab.  Locate the product for which you want to view or transfer a license.

 3. Locate your active license in the list and click on the corresponding Details link.  A View / Transfer License dialog box will 
appear.
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 4. To download the most recent upgrade available for the selected license, click on the Max Upgrade Version: [Version #] 
Download link.  The corresponding setup file will begin to download. See example below:

 5. To transfer the license to a new machine, click on the Transfer to new Machine link. A confirmation message will appear, 
as below:

To close this message, click on the  OK  button.

 6. To close the View / Transfer License dialog box, click on the  X  button.   You will receive a confirmation email once the trans-
fer request has been reviewed and processed within one business day.

Enter New Serial Number
From the Program:
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 1. From the Find it EZ menu, select  Tools -> License Management -> Enter serial number . The Activate dialog box will 
appear.

 2. Fill in the required information.

Note: If access to the Internet is protected by a proxy firewall within your network, click on the  Proxy Settings button and 
enter the required credentials before clicking the Activate button. For more information, see "View or Edit Proxy Settings" 
on page 8

Note: Input fields with an "*" are required.

 3. Click on the  Activate  button.

See Also:
 • "Activate License" on page 19

Get a New Trial License
On the Public Website:

Visit https://www.finditez.com/ and click on any of the "download trial" links:

https://www.finditez.com/
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The following trial download form is available in the footer area of all web pages:

The following slide-out menu is available on the right-hand side of all but the home page:

OR

Visit https://www.finditez.com/freetrial for direct access to the Start your free trial download form.

https://www.finditez.com/freetrial
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 1. Complete the form and click to select the desired product edition.

 2. Click on the  Download Trial Now!  button. If eligible, your trial setup file will begin to download and a confirmation email with 
your trial key will be sent to the email address provided.

On the Member Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Serial Numbers tab.

 3. Click on the  Get a New Trial License  button. A Request License dialog box will appear.

 4. From the drop-down list, select the product for which you want to request a trial.

 5. Click on the  Request License  button. The trial license information will be sent to your account e-mail address.

 6. Open your e-mail. Note the trial license serial number and click on the  Download Now  button.
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See Also: 
 • "Activate License" on page 19

 • "Activate License Manually" on page 21

Purchase Licenses
On the Public Website:

See "Create a New Order" on page 329

On the Member Website:

 1. Log in to your Find it EZ Member Account.

 2. Click to select the Serial Numbers tab.

 3. In the License Type column on the left, locate the product edition for which you want to purchase additional licenses.

 4. In the Buy More column, click on the corresponding shopping cart icon. The Select Enterprise options form will appear. 
See example below:
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 5. Enter the desired Quantity.

 6. In the Select Installation Package section, click to choose the desired package / software assurance option.

 7. Click on the  Add to Cart  button. You will be directed to the Shopping Cart Summary page. See example below:

 8. To add more items, click on the  + Add more items  button.

 9. To edit or delete an item, click on the corresponding icon located to the right of each item. The Installation Package (drop-
down) and Quantity (text box) will become editable. See example below:
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Make changes, as desired, and click on the Update link to save.

 10. Where applicable, enter a discount code and click on the  Apply coupon  button.

 11. To save the item(s) as a quote, click on the  Save as quote  button.

 12. To buy the selected product(s) now, click on the  Checkout  button.

Software Assurance Plans
There are two types of licenses and corresponding maintenance (software assurance) plans:

Code Search Pro (Desktop and Server)

 • Perpetual licenses. First year software assurance included.

 • After year 1, software assurance is optional.  However, if you do not renew and want access to an upgrade (newer release 
than the last one available when your software assurance lapsed), you must buy a new license.   Upgrade discounts may be 
considered at our discretion on a case by case basis.

Dev Surge 365

 • SaaS licenses. Software assurance included.

 • Renewal is mandatory for use of the software.  Otherwise, once your subscription expires, the software stops working.

What Software Assurance includes:

 • Unlimited support incidents.  Direct access to our support (development) team via phone, WebEx, remote desktop, email, 
etc.

 • Ability to request a license transfer (approval only possible if on an active software assurance plan).   This can be required if 
on change of employee or reconfiguration / major upgrade of the workstation (e.g. newer operating system, change of work-
station name on the company domain, major hardware upgrade such as hard drive, etc.).

 • Access to new software release upgrades.

Software assurance is typically quoted / invoiced for a one year period. During payment remittance, you can choose to take advant-
age of extending your software assurance period to:

 • Save 5% for 2 year; 10% for 3 year plans.

 • Enjoy the convenience of only have to renew every 2 or 3 years instead of annually. 
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 • Coordinate with a PO process to reduce overhead and approval requirements.

 • Take advantage of available surplus budget when possible.

For more information about our software assurance plans:

 • Visit https://www.finditez.com/cart/ and  click on the Support and Upgrades or the License Information links at the 
top of the Product Catalog page for more detail and definitions.

 • Click on any  Select Options  button for a product line item.  Note that you can get a discount on extending your pre-paid sup-
port plan. Click to expand the  Software Assurance tab.

Annual Renewals
Annual renewal notices are sent as follows for existing customers:

If, on the final payments remittance page, you chose to "auto-renew," then you will be invoiced and will receive this invoice 45 days 
prior to your software assurance plan expiry date.   If payment is not remitted, reminders are auto-sent 3 weeks ( 21 days ) and again 
3 days prior to support expiry.  If payment is still not received, an overdue notice is sent 5 days after support expiry and collection 
action may commence.

If you do not check the "auto-renew" setting, then you will simply receive a renewal quote 3 months ( 90 days ) prior to your software 
assurance plan expiry date.  Reminders are sent 21 days and 3 days prior to support expiry.

If payment is not received after your software assurance plan expiry date, this lapse effect does the following:

 • Code Search Pro:   Keeps working, but no support responses and can no longer transfer the licenses.   The member down-
loads panel changes to add a section for "older versions" so that you have access to download the max version you are eli-
gible to use.

 • Dev Surge 365:   Stops working.

License Type Options
For further information about licensing, please contact support@finditez.com.

License types for Find it EZ products

Find it EZ products are either sold or leased under two distinct license plans:

 • Perpetual - Permanent right to use license is purchased. First year software assurance is included with access to all minor 
and major upgrades for free. Optional software assurance.

 • Software As A Service (SaaS) - Annual renewable contract lease plan. If your contract is not renewed, the product can 
no longer be used and all licenses are automatically disabled upon expiry of the contract term.

Under either plan, there are also two available end-user license types to chose from:

 • Name User Licenses (NULs) - Each license is associated with a single, unique windows user login and host machine com-
bination. NULs are transferable between machines and/or users but must go through an automated transfer request, 
vendor review and approval process at the sole discretion of Find it EZ.

 • Concurrent Access Licenses (CALs) - Each license is associated with a Windows host machine, but floating amongst all 
domain users. Also commonly known as floating licenses. Only limited in use to the maximum number of concurrent con-
nection (licenses) purchased.

Alert: For further information about licensing, please contact support@finditez.com.

Note: Dev Surge 365 Enterprise is only available in on-premise Software As A Service - Named User Licenses.

https://www.finditez.com/cart/
mailto:support@finditez.com?subject=Licensing Inquiry
mailto:support@finditez.com
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See Also:
 • "License Agreements and Statements" on page 342

Quotes
A quote is a 15 day price guarantee with no obligation to pay by the customer. The Quotes tab on the member website allows you to 
compare products, create and view quotes, and pay for a quote.

Create a New Quote
 1. Visit https://www.finditez.com/.

 2. From the menu at the top of the page, select  Quotes -> New Quote . The Products Catalog will appear.

 3. Using the vertical scroll bar, locate the product that you want to add to a quote.

 4. Click on the corresponding green  Add to Quote  button. A Quote Summary page will appear.

https://www.finditez.com/
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 5. To add more items, click on the green  + Add More Items  button. The Products Catalog will appear (see above).

 6. To edit or delete an item, click on the corresponding blue edit or delete icon located to the right of each item. See example 
below:

 a. Change the Quantity or Software Assurance selection, as desired.

 b. Click on the Update link to save your changes.

 7. Where applicable, enter a Discount Code and click on the  Apply Coupon  button.

 8. To send the quote to Find it EZ Software Corp., click on the  Send Quote  button.

 9. If you are not already logged into the Find it EZ website, you will be prompted to login in order to save a copy of the quote. 
See below:
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 10. A confirmation screen will appear with your quote information along with product trial download links. See example below:

Help Convince My Boss
One or more quotes can be created and forwarded directly to the manager or department head responsible for budget approval.  
This wizard walks through a few questions to create a template email with one or more saved quotes automatically attached to it.  This 
can simplify the budget approval process by comparing your industry and adjacent technologies to our existing client base, providing 
a list of benefits along with examples of competitors or similar companies that use Find it EZ.
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 1. Visit https://www.finditez.com/.

 2. From the menu at the top of the page, select  Quotes -> Help convince my boss . The following wizard step 1 will appear:

 3. Click to chose “Create a new Quote” or “Select one or more existing quotes”.

 Note: If you have previously saved quotes, you are not logged in, and you select the latter option, you will be prompted to 
login, as below:

 4. Once you have created a new quote or logged in to your Find it EZ account, you will be prompted to select one or more 
quotes to attach to the e-mail. See example below:

https://www.finditez.com/
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Select the desired quote(s) and then click on the  Next  button. A Budget Approval Request form will appear, as below:

 5. Fill in the Budget Approval Request form.  Items with a dot are mandatory.  You will have an opportunity to review and 
change the contents of the generated email prior to sending.  The more data provided in the form, the more complete the 
generated email template will be.  Once complete, click on the  Preview Now  button.
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 6. To make changes to the email body produced, click on the  Back  button and repeat step 5.   If the contents are approved, 
click the  Send  button.  To abort, click the  Cancel  button.

Note:  If you cancel the process, but had created a new quote in step 3, the quote will still be saved to your Find it EZ 
account.

View or Change Saved Quotes
You may change the contents of a pending, open quote, including adding or removing items, increasing or decreasing item quantity, 
or changing the support length for individual items in the quote.
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 1. Visit https://finditez.com/. From the menu at the top of the page, select  Quotes -> My Saved Quotes . If you are not logged 
in, you will be prompted to do so for access to your saved quotes.

 2. Log in to your Find it EZ member account. A table will appear showing the quote Quote #, Expiry Date, Amount, and 
Status.

 3. To edit the quote, click on the corresponding Edit icon.

Note:  Only pending, unexpired quotes can be modified.  If a quote  is in a status that does not allow updating, you may cre-
ate a new  quote or contact Find it EZ sales support for assistance.

https://finditez.com/
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 a. Make changes as desired.

 b. Click on the  Update Quote  button to save and re-send the revised quote.

 4. To download the quote in PDF file format, click on the corresponding PDF icon.

 a. The quote will open as a PDF in a new browser window.

 b. Download or Print the document as desired.

Pay for a Quote

 1. Visit https://www.finditez.com/. From the menu at the top of the page, select  Quotes -> Pay for a Quote .   If you are not 
logged in, you will be prompted to do so for access to your saved quotes.

https://www.finditez.com/
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 2. Log in to your Find it EZ member account. A table will appear showing the quote Quote #, Expiry Date, Amount, and 
Status.

 3. In the Pay Now column, click on the corresponding shopping cart icon. The Checkout dialog box will appear.

 4. Select the Billing and Shipping Address, then click on the  Save and Continue  button.
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 5. Review and confirm the order, then click on the  Save and Continue  button.
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 6. Select and enter the method of payment.

Note:  Payment by secure Credit Card or Paypal will immediately release full activation keys.   Selecting payment by 
Check, Invoice Me, Wire Transfer, or Purchase Order will issue a net 30 day terms invoice.

Note:  When paying by Purchase Order, you may upload an electronic copy of the purchase order document or email a 
copy to billing@finditez.com referencing your order # in the email subject or body.

 7. Click on the  Process Payment  button.

Orders
An order generates a net 30 day invoice. Or, if the customer proceeds through secure check-out and remits payment online (via pur-
chase order, credit card, or Paypal account), a receipt is issued along with immediately releasing activation keys. The Orders tab on 
the member website allows you to create and view orders.

View or Change My Orders
You may change the contents of an order; including adding or removing cart items, increasing or decreasing item quantity, or chan-
ging the support length for individual items in the cart.

 1. Log in to your Find it EZ Member Account.

 2. Click on the Orders tab. All current orders on file will be listed.

mailto:billing@finditez.com?subject=Order #
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 3. To edit the order, click on the corresponding Edit icon.

Note:  Only pending, active, unpaid orders can be modified.  If an order is in a status that does  not allow updating, you 
may create a new order or contact Find it EZ sales support for assistance.

 a. Make changes, as desired.

 b. Click on the  Update order  button to save your changes.

 4. To download the order in PDF format, click on the PDF icon.

 a. The order will open as a PDF in a new browser window.

 b. Download or print the document as desired.

 5. To upload an electronic copy for an order where the payment method selected was by Purchase Order, click on the  Add  
button under the PO column.
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 a. Use the  Choose file  button to select the Purchase Order document from your system.

 b. Click on the  Upload  button to save a copy of the file.

Create a New Order

 1. Visit https://www.finditez.com/. From the menu at the top, select Shop.

OR

 2. Log in to your Find it EZ Member Account.

 a. Select the Orders tab.

https://www.finditez.com/
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 b. Click on the  Create New Order  button. The Products Catalog will appear.

 3. Locate the product(s) you want to add to your order.

 4. To select a product, click on the corresponding  Add to Cart  button. Go to step 6.

OR
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 5. To select product options, click on the corresponding  Select Options  button.

 a. Review product information (bottom left) by clicking on the desired "+" to expand.

 b. Enter the desired Quantity.

 c. Choose the desired Software Assurance plan.

 d. Click on the  Add to Cart  button.

 6. To add more items, click on the  + Add More Items  button. The Products Catalog will appear (see above).

 7. To edit or delete an item, click on the corresponding icon located to the right of each item.



Pay for an Order

332 © 1998 - 2019 Find it EZ Software Corp.

 a. Make changes to the Quantity or Software Assurance selection, as desired.

 b. To save your changes, click on the blue Update link.

 8. Where applicable, enter a Discount Code and click on the  Apply Coupon  button.

 9. To save the order as a quote, click on the  Save as quote  button.

 10. To pay for the order, click on the  Checkout  button.

Pay for an Order
 1. Log in to your Find it EZ Member Account.

 2. Click on the Orders tab.   A table will appear showing the Order #, Expiry Date, Amount, and Status.  Locate the order for 
which you want to pay.
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 3. In the Pay Now column, click on the corresponding shopping cart icon. The Checkout dialog box will appear.

 4. Select the Billing Address and Shipping Address, then click on the  Save and Continue  button.



Pay for an Order

334 © 1998 - 2019 Find it EZ Software Corp.

 5. Review and confirm the order, then click on the  Save and Continue  button.
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 6. Select and enter the method of payment.

Note:  Payment by secure credit card or Paypal will immediately release full activation keys.   Selecting payment by Check, 
Invoice Me, Wire Transfer or Purchase Order will issue a net 30 day terms invoice.

Note:  When paying by Purchase Order, you may upload an electronic copy of the purchase order document or email a 
copy to billing@finditez.com referencing your order # in the email subject or body.

 7. Click on the  Process Payment  button.

 

My Support Tickets
The My Support Tickets tab on the member website allows you to create, attach a file to, send, and view your support tickets.

Create a Support Ticket
A support ticket is used to report a program bug or to request a new product feature.  Submitted crash reports or on-start-up of the 
program after a crash also create support tickets automatically.  Support tickets status along with fix notes are visible to all linked 
accounts that are registered with the same e-mail domain.

From the program:

mailto:billing@finditez.com?subject=Order #
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 1. From the Find it EZ menu, select  Help -> Report a Bug .

The Report a Bug dialog will appear. See example below:

Note: The Name and Email Address fields will be filled out for you according to the current user. These can be 
changed, as desired.

 2. Fill in the form:

 a. In the Summary text box, enter a brief but descriptive summary of the issue.

 b. In the Description text box, enter a detailed description of the issue or request. For bugs, include detailed steps 
required to reproduce the issue.

Tip: To send logs to Find it EZ Support, See"Find it EZ Support" on page 340.

 3. Click on the  Submit Bug  button. Once submitted, the following notification will appear:
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On the website:

 1. Log in to your Find it EZ Member Account.

 2. Click on the My Support Tickets tab.
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 3. Click on the  Create a Support Ticket  button. A Ticket System dialog box will appear.
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 4. In the Product Information section:

 a. Select the affected product name from the Product drop-down list.

 b. Select the affected version from the Version Found drop-down list.

 5. In the Problem Description section:

 a. Select the appropriate issue severity from the Severity drop-down list. Refer to the image below:

 b. In the Summary text box, enter a brief and descriptive summary of the issue or problem.

 c. In the Description text box, enter a detailed description of the issue or problem.

 d. In the Steps to Reproduce text box, thoroughly describe the steps required to reproduce the issue or problem. 
Include as much detail as possible.

Note: This (d. above) is optional, but very useful information for expediting problem resolution.

 6. To attach a file to the support ticket:

 a. Click on the  Choose File  button.

 b. Navigate to the file you want to attach.

 c. Click on the  Open  button. The file name will appear in the File Attachment section to the right of the  Choose File  
button.

 7. To send the support ticket to Find it EZ support, click on the  Send Report  button.

View My Support Tickets
 1. Log in to your Find it EZ Member Account.

 2. Click on the My Support Tickets tab. A list of your submitted support tickets will appear showing the Issue #, Reported 
datetime, Status, Last Updated datetime, and Summary.
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Note: It may take up to 24 hours for new issues to appear in this list.

 3. Click on a ticket number to view more details for an individual item. See example below:

Find it EZ Support
This section describes the many support options available with Find it EZ, how to  report a bug, or a request a feature to Find it EZ 
Software Corp.., and how to view or send your session log.
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Support Options
Support Option Navigation

Contact Find it EZ Software Corp. https://www.finditez.com/support/#contact

Frequently Asked Questions https://www.finditez.com/support/#faq

Search Knowledge Base https://www.finditez.com/support/#kb

Syntax and Examples https://www.finditez.com/support/#syntax

Request a Demo https://www.finditez.com/support/#demo

Watch Instructional Videos https://www.finditez.com/resources/#by_video

View Session Log From the program menu, select  Tools -> View Session Log . The session log will 
open in Notepad. Each event line will start with the event date and time, followed 
by details.

Send Logs to Support From the program menu, select  Help -> Send Logs to Support 

Check for Updates From the program menu, select  Help -> Check for Updates .

https://www.finditez.com/support/#contact
https://www.finditez.com/support/#faq
https://www.finditez.com/support/#kb
https://www.finditez.com/support/#syntax
https://www.finditez.com/support/#demo
https://www.finditez.com/resources/#by_video
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License Agreements and Statements
Visit https://www.finditez.com/support/documents/eula.pdf to view the Find it EZ Software Corp. Software License Agree-
ment.

https://www.finditez.com/support/documents/eula.pdf
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